cintosh
erS Guide

for desktop Macintosh computers



Macintosh User’s Guide for desktop Macintosh computers



Limited Warranty on Media and Replacement

If you discover physical defects in the manuals distributed with an Apple product or in
the media on which a software product is distributed, Apple will replace the media or
manuals at no charge to you, provided you return the item to be replaced with proof of
purchase to Apple or an authorized Apple dealer during the 12-month period after you
purchased the software. In addition, Apple will replace damaged software media and
manuals for as long as the software product is included in Apple’s Media Exchange
Program. While not an upgrade or update method, this program offers additional
protection for two years or more from the date of your original purchase. See your
authorized Apple dealer for program coverage and details. In some countries the
replacement period may be different; check with your authorized Apple dealer.

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE LIMITED IN DURATION TO TWELVE (12) MONTHS FROM THE DATE OF THE
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentation, APPLE
MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED,
WITH RESPECT TO SOFTWARE, ITS QUALITY, PERFORMANCE,
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS
SOFTWARE IS SOLD “AS IS,” AND YOU, THE PURCHASER, ARE ASSUMING THE
ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN
THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such
damages. In particular, Apple shall have no liability for any programs or data stored in or
used with Apple products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU
OF ALL OTHERS, ORAL OR WRITTEN, EXPRESSED OR IMPLIED. No Apple dealer,
agent, or employee is authorized to make any modification, extension, or addition to
this warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for

incidental or consequential damages, so the above limitation or exclusion may not apply

to you. This warranty gives you specific legal rights, and you may also have other rights
which vary from state to state.

Important

This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules. See instructions if
interference to radio or television reception is suspected.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits
for radio noise emissions from digital apparatus set out in the radio interference
regulations of the Canadian Department of Communications.

Observation des normes—Classe B Lc¢ présent appareil numérique n'émet pas de
bruits radioélectriques dépassant les limites applicables aux appareils numériques de la
Classe B prescrites dans les reglements sur le brouillage radioélectrique édictés par le
Ministere des Communications du Canada.
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& Apple Computer, Inc.

This manual and the software described in it are copyrighted, with all rights
reserved. Under the copyright laws, this manual or the software may not be
copied, in whole or part, without written consent of Apple, except in the
normal use of the software or to make a backup copy of the software. The
same proprietary and copyright notices must be affixed to any permitted
copies as were affixed to the original. This exception does not allow copies to
be made for others, whether or not sold, but all of the material purchased
(with all backup copies) may be sold, given, or loaned to another person.
Under the law, copying includes translating into another language or format.

You may use the software on any computer owned by you, but extra copies
cannot be made for this purpose.

The Apple logo is a trademark of Apple Computer, Inc., registered in the U.S.
and other countries. Use of the “keyboard” Apple logo (Option-Shift-K) for
commercial purposes without the prior written consent of Apple may
constitute trademark infringement and unfair competition in violation of
federal and state laws.

© Apple Computer, Inc., 1991
20525 Mariani Avenue
Cupertino, CA 95014-6299
(408) 996-1010

Apple, the Apple logo, APDA, AppleLink, AppleShare, AppleTalk, A/UX,
EtherTalk, ImageWriter, LaserWriter, LocalTalk, Macintosh, ProDOS, and
TokenTalk are trademarks of Apple Computer, Inc., registered in the U.S. and
other countries.

Classic is a trademark licensed to Apple Computer, Inc., registered in the U.S.
and other countries.

Apple Desktop Bus, Balloon Help, Disk First Aid, Finder, SuperDrive, and
TrueType are trademarks of Apple Computer, Inc.

AppleCare is a service mark of Apple Computer, Inc., registered in the U.S. and
other countries.

Adobe, Adobe Illustrator, and PostScript are registered trademarks, and
lllustrator 88 is a trademark of Adobe Systems, Incorporated.

Exposure is a registered trademark of Preferred Publishers, Inc.
Helvetica, Linotronic, and Times are registered trademarks of Linotype Co.

ITC Zapf Dingbats is a registered trademark of International Typeface
Corporation.

MacWrite is a registered trademark of Claris Corporation.

Microsoft and MS-DOS are registered trademarks of Microsoft Corporation.
NuBus is a trademark of Texas Instruments.

QuarkXPress is a registered trademark of Quark, Inc.

SuperPaint is produced by Silicon Beach Software.

Mention of third-party products is for informational purposes only and
constitutes neither an endorsement nor a recommendation. Apple assumes no
responsibility with regard to the performance or use of these products.
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Radio and television interference

The equipment described in this manual generates, uses, and can radiate
radio-frequency energy. If it is not installed and used properly—that is, in strict
accordance with Apple’s instructions—it may cause interference with radio and
television reception.

This equipment has been tested and found to comply with the limits for a
Class B digital device in accordance with the specifications in Part 15 of FCC
rules. These specifications are designed to provide reasonable protection
against such interference in a residential installation. However, there is no
guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by
turning it off. If the interference stops, it was probably caused by the computer
or one of the peripheral devices.

If your computer system does cause interference to radio or television
reception, try to correct the interference by using one or more of the following
measures:

m ‘Turn the television or radio antenna until the interference stops.
m  Move the computer to one side or the other of the television or radio.
m  Move the computer farther away from the television or radio.

m Plug the computer into an outlet that is on a different circuit from the
television or radio. (That is, make certain the computer and the television
or radio are on circuits controlled by different circuit breakers or fuses.)

If necessary, consult your authorized Apple dealer or an experienced
radio/television technician for additional suggestions. You may find helpful

the following booklet, prepared by the Federal Communications Commission:

Interference Handbook (stock number 004-000-00345-4). This booklet is
available from the U.S. Government Printing Office, Washington, DC 20402.

2\ Important: Changes or modifications to this product not authorized by
Apple Computer, Inc., could void the FCC Certification and negate your
authority to operate the product.

This product was tested for FCC compliance under conditions that includ
the use of shielded cables and connectors between system components. I
is important that you use shielded cables and connectors to reduce the
possibility of causing interference to radios, television sets, and other
electronic devices.

For Apple peripheral devices, you can obtain the proper shielded cables
from your authorized Apple dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.
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How to Use This Book

This book has two parts. Part I, Learning Macintosh, covers
everything you need to know to begin using your Macintosh
computer. Part I, Macintosh Reference, contains information
that you may want as you become more proficient in using
your Macintosh.

Go through Part I first if you are new to computers or new to the
Macintosh. Read the chapters in sequence, from Chapter 1 to
Chapter 7. When you're done with Part I, you can start learning
the programs that you intend to use with your Macintosh.

Use Part II as you would a dictionary or encyclopedia: turn to it
when you need specific information, and then read only those
parts that give you that information—so you can go on with your
work.

To find information in this book, use the index and the table of
contents. Also, use the glossary and the summary, “Working on
the Macintosh Desktop” (on the green pages after Chapter 16),
if you're looking for short definitions or brief summaries of
concepts and procedures.

If you need information on setting up your Macintosh or on
features specific to your particular model, go to the setup book
that came with your computer.

Use this book in combination with the setup book and the books
and disks that came with your application programs to find the
information you need. You can also find useful information
through Balloon Help, a feature of your Macintosh system that

is explained in Chapter 7.

Welcome to Macintosh.
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< : Go through Learning Macintosh if you are new to computers or
Learning Macintosh

new to the Macintosh computer. Read the chapters in sequence,

[from Chapter 1 to Chapter 7. Everything you need to know to

RSN St el anioRk Cimaridl G begin using the Macintosh productively is covered in this part of

Chapter 2 Understanding the Desktop the book.
Chapter 3 Setting Up Your Programs Before you use Learning Macintosh, you should have already
Chapter 4  Creating a Document and Saving Your Work = set up your Macintosh according to the instructions in the

setup book that came with your computer
Chapter 5 Changing a Document and Printing Your Work
= gone through the Macintosh Basics tour, supplied with

Chapter 6 Organizing Your Work your computer

Chapter 7 Learning More About Your Macintosh When you're done with this part of the book, you can start
learning the programs that you intend to use with your
Macintosh. (Turn to the materials that came with the
programs—all the skills you learn in Learning Macintosh

will prove useful in any Macintosh program.)

For information that you may need as you become more

proficient in using your Macintosh, go to Part II,

Macintosh Reference.



To find information in this book, use the index and the table of
contents. Also, use the glossary and the summary, “Working on
the Macintosh Desktop” (on the green pages after Chapter 16),
if you're looking for short definitions or brief summaries of

concepts and procedures.

If you need information on setting up your Macintosh or any
information on features specific to your particular model, go to

the setup book that came with your computer.

Use this book in combination with the setup book and the books
and disks that came with your application programs to find the
information you need. You can also find useful information
through Balloon Help, a feature of your Macintosh system that is
explained in Chapter 7.




Chapter 1

Turning the Macintosh
On and Off

In this chapter

You'll learn how to

= turn the Macintosh on and off
Also, you'll learn about

m the startup disk

= the Macintosh desktop

It will take about five minutes to go through this chapter.

Before you begin

You should have already

set up your Macintosh according to the instructions in the
setup book that came with your computer

gone through the Macintosh Basics tour, supplied with
your computer

read the introduction to this section of the book (page 1)

!
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Turn your computer on

How you turn on your Macintosh depends on which model it is.
For specific information, go to the setup book that came with
your computer.

2\ Important: Ifan external hard disk or other external devices
are connected to your Macintosh, turn on those external
devices before you turn on the Macintosh. A

= If your Macintosh is the Macintosh LC or it does not have a
separate monitor (like the Macintosh Classic), press the on/off
switch on the back of your computer.

On/off
switch

@ Ifthe Macintosh LC monitor doesn’t turn on, make sure
that the monitor’s on/off switch is on. (If you don’t know
where the switch is, go to the manual that came with your
monitor.) <

4 Chapter 1: Turning the Macintosh On and Off

m If your computer is one of the Macintosh II models (such as
the Ilci or the IIfx), press the Power On key on your keyboard.

Power On key @
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< If the monitor doesn’t turn on, make sure that its on/off
switch is on. (If you don’t know where the switch is, go to
the manual that came with your monitor.) <



When you turn on your computer

sz
1
>
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The Macintosh looks for a startup disk, which is a disk that | Menu bar

contains the information it needs to “start itself up.” In your € File Edit Uiew Label Special @

case, the startup disk is a hard disk that’s inside or connected
7| L0 your computer. When the Macintosh finds a startup

I: disk, it displays the icon shown at left and proceeds

to start itself up.

Startup
disk
icon

When your computer is done starting itself up, the screen
displays the Macintosh “desktop.” The desktop is a field of gray
(or another color) with

= amenu bar across the top (containing the names and icons
of menus)

= an icon near the upper-right corner representing the Wastebasket icon
startup disk
If the Macintosh doesn't find a startup disk, it displays this icon

= Wastebasketicon near the loweright comer instead. In this case, you may need to prepare a startup disk

Chapter 2, “Understanding the Desktop,” gives you more or connect one to your computer. Go to Chapter 8
information on these features. (in Part II of this book) or your setup book for
instructions.

Chapter 1: Turning the Macintosh On and Off 5



Turn your computer off

Before you can turn off your computer, you need to know how
to use the mouse to choose a command from a menu. The
Macintosh Basics tour lets you practice choosing commands. If
you need more practice, go through the next chapter (Chapter 2)
and then come back to this section to turn off your computer.

1. Point to the Special menu name in the menu bar.
2. Press and hold down the mouse button.

3. Drag through the items in the menu until the Shut
Down command is highlighted, then release the mouse
button.

Clean Up Desktop
Faply Hiasstehasket..,

Fipet ek BE
Erase Disk...

Restart

LETEBIE

6 Chapter 1: Turning the Macintosh On and Off

= If your Macintosh does not have a separate monitor (like the
Macintosh Classic), press the on/off switch on the back of the
computer when a message on screen indicates that it’s safe to
do so.

= Ifyour Macintosh is the Macintosh LC, press the on/off switch
on the back of the computer when a message on screen
indicates that it’s safe to do so, and switch off the monitor
as well.

= Ifyour computer is a Macintosh II or a portable model, the
computer and the monitor turn off by themselves.

2\ Important: Ifan external hard disk or other external device
is connected to your Macintosh, turn off those external
devices after you turn off the Macintosh. 2

Turn off your computer at the end of your work day or when you
know you won't be using it for several hours.

What next?

Go to Chapter 2, where you'll learn how to work on the
Macintosh desktop.



Chapter 2

Understanding the Desktop

In this chapter

You'll review how to

= use the mouse

= choose a command

= openanicon

= ook at the contents of a window
m close a window

(The Macintosh Basics tour introduced you to these skills.)
You'll learn how to

= move a window

Also, you'll learn about

= using the keyboard

It will take about 30 minutes to go through this chapter.

Before you begin
You should have already
= gone through Chapter 1

If you turned off the Macintosh at the end of Chapter 1, turn it
back on now.
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Use the mouse

You use the mouse to control the movements of a pointer on
screen. Usually, the pointer is an arrow that’s set at an angle.

o

Much of the work you do on the Macintosh uses four mouse
actions: pointing, clicking, pressing, dragging.

8 Chapter 2: Understanding the Desktop

Point

You point to an object on screen by moving the mouse so that the
pointer is positioned on that object. When the pointer is an arrow,
the very tip of the arrow must be exactly on the object.

¢ T omm mw e o Gl

x

Practice by pointing to different objects on the Macintosh
desktop, such as the startup hard disk icon near the upper-right
corner, the Wastebasket icon near the lower-right corner, and the
Help menu icon near the right corner of the menu bar.
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Click Press
You click an object on screen by pressing and quickly releasing the You press by holding down the mouse button without moving the
mouse button while the pointer is on that object. mouse. Don't bear down on the mouse itself.

e om mw mes [-] CL] e e . [AN:]
N
1 - | e
e
=
=l

Practice by clicking different objects on the Macintosh desktop, Practice by pressing the menu names and menu icons in the
such as the startup hard disk icon near the upper-right corner and menu bar (start with the Apple menu icon in the left corner,
the Wastebasket icon near the lower-right corner. through the menu names, and across to the Help and Application

menu icons in the right corner). Pressing a menu name or icon
“pulls down” the menu. Read the items in each menu you pull
down.

£Hbout This Macintosh...

@ Alarm Clock
Calculator

S Chooser
Control Panels

Key Caps

When you click an icon, it becomes highlighted (the icon is
darkened), which means that it is selected. A selected icon is the
object of whatever action you choose next.

Chapter 2: Understanding the Desktop 9



Drag

You drag an object on screen by pointing to that object and
holding down the mouse button while you move the mouse.

)

® 8 )

10 Chapter 2: Understanding the Desktop

=

How to hold the mouse

= You can use the mouse with either hand. Most people
prefer to use it with their dominant hand (the right if
they’re right-handed, the left if they re left-handed). If you
want to switch mouse positions, go to the setup book that
came with your computer.

= Keep the heel of your hand on your desk. (Your arm will
tire quickly if you hold your hand up in the air)

= Lightly rest your index and middle fingers on the mouse
button.

m  Make sure that the mouse cable is pointing away from you.



Practice by dragging the startup hard disk icon and the
Wiastebasket icon around the Macintosh desktop. Make sure you
return the icons close to their original positions.

When you drag an icon, an outline of the icon follows the pointer
on the screen. When you release the mouse button, the icon itself
moves.

When you move the mouse

= Glide the mouse over the surface of your desk. Don’t press
down on it.

= Ifyou run out of room on your desk as you're moving the
mouse, pick it up and put it down where there’s more
room. When you pick up the mouse, the pointer on screen
does not move, or does so only slightly.

T ma e mm [
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Choose a command

Choosing a command involves a combination of the mouse
actions you've reviewed.

1. Point to the Special menu name in the menu bar.
2. Press to pull down the Special menu.

3. Drag to the first item in the menu (the Clean Up
Desktop command) so that it is highlighted, then
release the mouse button.

Special
Clean Up Desktop
bmpliinstabasket..,

Lient Hisk =
frase sk,

Restart
Shut Down

When you choose the Clean Up Desktop command, the
startup hard disk icon and the Wastebasket icon return exactly
to the positions they occupied when you first turned on the
computer (as long as they're already close to their original
positions).

12 Chapter 2: Understanding the Desktop

When you talk to your Macintosh

Talking Macintosh always involves two steps:

1. selecting an object on the screen, and

2. choosing the action you want to perform on the object.

An icon or a window on the Macintosh desktop, text in a
word-processing program, a picture in a graphics program—
all of these are objects that you can select.

The actions you choose to perform on a selected object are
usually commands (like the Open command), but you can also
perform actions directly using the mouse (like dragging an
icon).

When you select an object, you're telling the Macintosh to act
upon that object.

Talking Macintosh is like using a very simple language with
only two kinds of words:

= nouns (the objects), and
= verbs (the actions)
and with only one rule to remember:

= First the noun, then the verb (to this object, do that
action).



Open an icon

|
<2l
>
=
2
2.
D

New Folder 3N
%0

e
b4

kit

Opening an icon is your first exercise in “talking Macintosh”:
telling your computer what you want it to do.

Prind
finge Hindam

1. Click the startup hard disk icon (unless it’s been
changed, it should be named “Macintosh HD”) near

; ) Get Info ®l
the upper-right corner of the screen to select it. Seentieatn sy

Make sure that the icon is highlighted (darkened), which . .
means that it’s selected. When you choose the Open command, the selected icon (in

this case, the Macintosh HD icon) opens into a window (the
Macintosh HD window). The icon itself becomes filled in with
a pattern of dots, indicating that it has been opened.

I

EDE===== Macintosh ) ==}

h ll h b 3 items 3.6 MB in disk 34.4 MB available
2. Point to the File menu name in the menu bar. | S &
& &

ReadMe System Folder TeachText

3. Press to pull down the File menu.

4. Drag to the Open command (the second item in the
File menu) so that it is highlighted, then release the
mouse button. - 1=

el

Chapter 2: Understanding the Desktop 13



Look at the contents of 2 window

Every window has several features that help you view the
window’s contents. You can

= make the window bigger or smaller
= move any hidden contents into view

Before you work with the contents of a window, you need to
make that window the active window.

Make a window the active window

You can have several windows on screen, but only one window at
a time can be the active window.

The Macintosh HD window should already be on your Macintosh
desktop. (The window appeared when you opened the
Macintosh HD icon.)

1. Click the Wastebasket icon near the lower-right corner
of the screen to select it.

Make sure that the icon is highlighted, which means that it’s
selected.

“Wastebasket

14 Chapter 2: Understanding the Desktop

2. Point to the File menu name in the menu bar.
3. Press to pull down the File menu.

4. Drag to the Open command (the second item in the
File menu) so that it is highlighted, then release the
mouse button.

New Folder 3N
%0
P
Hti

Pring
finge Hindaw

Get Info #1

$recention nd s INEFE Y

When you choose the Open command, the selected icon (in
this case, the Wastebasket icon) opens into a window (the
Wastebasket window). The icon itself becomes filled in with a
pattern of dots, indicating that it has been opened.



=
>
You should now have two windows on your Macintosh Make a window bigger or smaller )
desktop: the Macintosh HD window and the Wastebasket , . o =
window. The Wastebasket window is the active window You can change a window’s size by dragging its size box or by 2
because you opened the Wastebasket icon most recently. clicking its zoom box.
1. With the Macintosh HD window the active window,
Macintosh HD point to the size box in the lower-right corner of the
3 items 3.6 MB in disk 34.4 MB available .
e - window.
Read Me System Folder TeachText
=== Macintosh h |
3 ftems 3.6 MB in disk 34.4 MB available
E0) Wastebasket a2 == = o i
Bonms & R sysldor T(
I |— Active window
=
& Bl
@l ,¢§_ Size box

5. Click anywhere in the Macintosh HD window to make

Sl 2. Drag the size box in any direction, then release the

The active window is the one with solid lines across the top mouse button.
(the title bar), on either side of its title. When windows

L . ; An outline indicates the window’s new size. The outline
overlap, the active window is the one that’s on top.

follows the pointer as you drag. You can drag in any direction

to make the window bigger or smaller, wider or narrower.
E(jE======= Macintosh H) ===

3 items 3.6 M8 in disk » .
Active window = e
o [FO===== Macintosh) ===
E&E| 3 items ZeMBindisk |  34.4 MB available
Read Me  System Folder TeachText O
é:icm "_. @ |
e (0]
k Read Me  System Folder
I\
oy >
=
Kal o
1o}
el 30
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3. Click the zoom box near the right end of the title bar.

[[O====== Mocintosh 0 === Z00M box

3 items 3.6 MB in disk 24.4 MB available

g

ReadMe System Folder TeachText

el

al I

The window “zooms” to a size that shows all of its contents.
4. Click the zoom box again.

The window zooms back to its previous size (the size that you
changed it to in step 2).

Clicking the zoom box is a quick way to view as much of a
window’s contents as your screen size allows.

Move the hidden contents of a window into view

Without changing the size of the window, you can view any
contents that are currently out of sight by using the window’s
scroll bars and scroll arrows.

16 Chapter 2: Understanding the Desktop

1.

With the Macintosh HD window the active window,
click the System Folder to select it.

[iD@ Macintosh HD Eél

3 items 3.6 MB in disk 34.4 MB available

<

- ® (3

[tz

E=H 2]

ReaMe m TeachText

G15]

Make sure that the icon is highlighted, which means that it’s
selected.

Point to the File menu name in the menu bar.
Press to pull down the File menu.

Drag to the Open command (the second item in the
File menu) so that it is highlighted, then release the
mouse button.

When you choose the Open command, the selected icon
(in this case, the System Folder) opens into a window (the
System Folder window).

You should now have three windows on your Macintosh
desktop: the Macintosh HD window, the Wastebasket window,
and the System Folder window. The System Folder window is
the active window because you opened the System Folder
last.



5. Point to the size box in the lower-right corner of the
System Folder window.

6. Drag the size box diagonally to make the window
smaller (about half its current size), then release the
mouse button.

3.6 MB in disk 34.4 MB available
. ity
©) & G
Apple Menu Items Extensions System  Control Paheld
=
Finder Preferences  Scrapbook File
Py oy %
AU 43 ]
Startup Items PrintMonitor Documents 13
&l B
EDE System Folder Eil
10 items 3.6 MB in disk 34.4 MB available
Apple Menu Items Extensions System Control P.
Finder Preferences  Scrapbook File

The bars across the bottom (the horizontal scroll bar) and
along the right (the vertical scroll bar) of the System Folder
window should now be gray, indicating that the window has
contents that you cannot see at its current size.

7. Press the right scroll arrow at the right end of the
horizontal scroll bar.

EO===—===== system folder =13

10 items 3.6 MB in disk 34.4 MB available

Apple Menu Items Extensions System Control P.

=

Finder Preferences  Sorapbook File

The contents of the window scroll past, bringing into view the
icons that had been out of sight and to the right.

The scroll box moves to the right across the bar, showing what
part of the window’s contents you're looking at.

8. Press the left scroll arrow at the left end of the

horizontal scroll bar.

The contents of the window scroll past, bringing back into
view the icons that had been out of sight and to the left.

The scroll box moves to the left across the bar, showing what
part of the window’s contents you're looking at.

continues »
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What'’s on the desktop?

The Macintosh desktop is a field of gray (or another color) with
amenu bar across the top, an icon near the upper-right corner
representing the startup disk, and a Wastebasket icon near the
lower-right corner.

The desktop is your work space on the computer—as the top
of a wooden desk is a work space. It gives you a familiar way of
thinking about how to use the Macintosh.

Aside from the field of gray (the “surface” of your work space),
the Macintosh desktop has icons, windows, and menus.

= [cons represent containers.
= Windows let you view the contents of containers.

m  Menus offer you actions that you apply to selected
containers (or their contents).

Icons represent containers

You can think of icons as containers. Icons can contain other
icons, or they can contain information.

For example, the startup disk icon near the upper-right corner
of the desktop contains the System Folder icon. The System
Folder icon contains the programs and other files (more icons)
that contain the information the Macintosh needs to start
itself up.

18 Chapter 2: Understanding the Desktop

Several types of icons represent different types of containers.

Hard disks and floppy disks are like filing cabinets. You use disks
to store files—programs you use and documents you create.

&

Floppy Disk

[

Hard Disk

Shared disks are like filing cabinets containing office supplies or
records that you share with others in your work group. Your
Macintosh needs to be connected to a network before you can
use shared disks.

= =

MNetMart Cornmunity Communiqué

Shared Disk lduna Stacks



Folders are like folders in a file drawer. You use folders to
organize your files.

s P S

Systern Folder Manila Folder

P N P L

June Letters House Plans  Mailing Lists

Programs are files containing instructions to the computer that

let you do certain types of work.

BeanCounter

TeachText

Documents are files containing words, pictures, numbers,
sounds—whatever you create using programs.

L ” 2 Iy
T . S
L
Kitzhen plans Rough sketch Sandino
T b T
B S===s i
Inwitation Merno

The Wastebasket is a container for files that you no longer want
or need.

Ji

“Wastebasket

Windows let you view the contents of containers

Windows let you see what’s “inside” all of these containers.
When you open a disk icon, the window that appears shows you
what’s on the disk. When you open a document icon and the
document is a memo, for example, the window that appears lets
you see the memo.

Menus offer you choices

Like the menus in a restaurant, Macintosh menus let you
choose. You choose among different actions that the computer
can perform on containers (icons) or the contents of containers
(words in a memo) that you've selected.

Chapter 2: Understanding the Desktop 19

<3
=
>
=
2
2
(=p]




9. Drag the scroll box toward the middle of the
horizontal scroll bar, then release the mouse button.

FISSS=== system Folder E====8
10 items 3.6 MB in disk 34.4 MB available

(5]
le Menu Items Extensions System  Control Panel
(=] IS
Finder  Preferences  Sorapbook File

Now you see the icons near the middle of the window.

10. Press the down scroll arrow at the bottom end of the
vertical scroll bar.

EOE======= System Folder ===}
34.4 MB available

10 ftems 2.6 MB in disk

£ =

e Extensions  System  Control Panels
F Preferences Serapbook File

The contents of the window scroll past, bringing into view the
icons that had been out of sight and toward the bottom.

The scroll box moves down along the bar.

20 Chapter 2: Understanding the Desktop

11. Press the up scroll arrow at the top end of the vertical
scroll bar.

The contents of the window scroll past, bringing into view the
icons that had been out of sight and toward the top.

The scroll box moves up along the bar.

12. Drag the scroll box toward the middle of the vertical
scroll bar, then release the mouse button.

System Folder = ]E|
10 items. 3.6 M8 in disk 34.4 MB available
€ ) i
ple Menu Items Extensions System  Control Pane
:
Finder

Preferences  Scrapbook File

Now you see the icons near the middle of the window.

_\ Remember: Changing the size of a window or moving the
contents of a window does not change its contents. The

contents remain the same; only what you see of the contents
changes.



Close a window

When you no longer need to see the contents of a window, you
can close it by clicking the close box.

1. With the System Folder window the active window,
point to the close box near the left end of the title bar.

Close box — g 5y stom Forder %@gl

10 items 3.6 MB in disk 34,4 MB available
L] (2] o
le Menu Items Extensions System  Control Panel
Finder Preferences  Scrapbook File

2. Click the close box.

The window closes, and the System Folder icon is no longer
filled in with a pattern of dots, indicating that it is not open.

You should have two windows on the Macintosh desktop: the
Macintosh HD window, which is now the active window, and
the Wastebasket window.

Move a window

You can move a window anywhere on screen by dragging its
title bar. By changing the position and the size of windows, you
can arrange windows in any way that works best for you.

1. Point to the title bar of the Macintosh HD window
(anywhere on the title bar except the close box or the

zoom box).
EC)=———== Macintosh HD 0z }_ Title bar
3 items 3.6 MB in disk 34.3 MB available |
o 2" [Q

2. Drag the title bar in any direction, then release the
mouse button.

When you drag a window’s title bar, an outline of the window
follows the pointer on screen. When you release the mouse

button, the window itself moves to the position of the outline.

Macintosh HD
1 3 items 3.2 MB in disk

34.8 MB available |:
I}

<

stemn Folder | Read Me TeachText
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3. Click anywhere in the Wastebasket window to make it
the active window.

4. Point to the title bar of the Wastebasket window
(anywhere on the title bar except the close box or the
zoom box).

5. Drag the title bar in any direction, then release the
mouse button.

Notice that the Wastebasket window, because it is the active
window, stays on top of the Macintosh HD window if the two
windows overlap.

3.2 MB in disk 4.8 MB available

System Folder Read Me TeachText

X

Wastebasket =

6. Click anywhere in the Macintosh HD window to make
it the active window.

Do
Do

Chapter 2: Understanding the Desktop

7. Close the Macintosh HD window by clicking the close
box near the left end of the window’s title bar.

=l J====—-= Macintosh HD

3 items 3.2 MB in disk 34.8 MB available

f

Read Me  System Folder TeachText

The window closes, and the Macintosh HD icon is no longer
filled in with a pattern of dots, indicating that it is not open.

The Wastebasket window (the remaining window on the
Macintosh desktop) becomes the active window.

8. Close the Wastebasket window by choosing Close
Window from the File menu.

N Fpigey BN
Open 380
Frind i
Close Window

You choose Close Window by pointing to the File menu name,
pressing to pull down the menu, dragging to the Close
Window command, and, with the command highlighted,
releasing the mouse button.

Of course, you can also close the window by clicking its close box.



When to use the keyboard

You use the keyboard to type text and numbers, of course, as
you would on a typewriter. (For touch typists, Macintosh
keyboards have raised dots in the middle of the D key and the
K key to help position your fingers on the home row.)

Depending on the program you're using, you can use special
keys on the keyboard to give commands to the computer and to
replace or change the effect of certain mouse actions. Macintosh
keyboards have three types of special keys: modifier keys, arrow
keys, and function keys (Chapter 5 gives you examples of how to
use these special keys).

Modifier keys

All Macintosh keyboards have four modifier keys: Shift,
8 (Command), Option, and Control.

Pressed by itself, a modifier key does nothing. You need to press
it in combination with another key (or while using the mouse).
The modifier key “modifies” the other key or the mouse action,
giving a different result.

You type a capital letter, for example, by pressing the Shift key
with a letter key. Most programs let you give commands by
pressing the 88 key with certain letter keys.

Arrow keys

All Macintosh keyboards have four arrow keys: Up Arrow,
Down Arrow, Left Arrow, and Right Arrow.

Many programs let you use the arrow keys as well as the mouse
to control the movements of the pointer on screen.

Function keys

Extended Macintosh keyboards have a row of function keys
across the top of the keyboard.

Some programs let you give commands, or a sequence of
commands, by pressing certain function keys.

‘O =

Bl Modifier keys [ Function keys Bl Arrow keys
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What next?

Go to Chapter 3, where you'll learn how to set up your programs,
or take a break. Remember to turn off your Macintosh if you'll be
away for more than a few hours.

24 Chapter 2: Understanding the Desktop




Chapter 3 | | 5

Setting Up Your Programs

In this chapter
You'll learn how to
m insert a floppy disk
= initialize a disk

copy the contents of a disk

take a floppy disk out of its drive

safeguard the contents of a disk

= use the Wastebasket

You'll also learn about

= types of floppy disks

n the difference between hard disks and floppy disks
m  caring for floppy disks

And you'll learn more about

= the startup disk and the System Folder

It will take about 40 minutes to go through this chapter.

Before you begin

You should have already

= gone through Chapters 1 and 2
Also, you need

= anew floppy disk

If you turned off the Macintosh at the end of Chapter 2, turn it
back on.

Chapter 3: Setting Up Your Programs 25
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Insert a floppy disk

You should be able to get floppy disks from wherever you got
your Macintosh. The 3.5-inch (89-millimeter) floppy disks that fit
in your Macintosh computer’s SuperDrive come in two types:
high-density and double-sided. Your Macintosh uses either type.

disk symbol

Some older Macintosh models, however, do not have the
SuperDrive floppy disk drive and cannot properly use high-
density disks.

26 Chapter 3: Setting Up Your Programs

. Write “Practice” on a blank disk label.
. Affix the label onto your new floppy disk.

How the label goes onto the floppy disk is apparent from the
molding of the disk’s protective plastic case. Do not affix the
label over the metal shutter.

. Hold the disk between thumb and forefinger, with your

thumb on the label and the metal shutter pointing
away from you.

. Push the disk into the computer’s SuperDrive, label

side up and metal shutter first, until the SuperDrive
pulls the disk in the rest of the way.
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Why a floppy disk isn’t floppy

A floppy disk is made of thin, flexible material with a magnetic High-density disks can hold 1.4 megabytes (MB) of information
coating. To protect it and to make it easier to handle, the floppy (about 300 typewritten pages). Double-sided disks can hold
disk itself is enclosed in a rigid plastic case, which gives the 800 kilobytes (K) of information (about 200 typewritten pages).
floppy disk its “non-floppy” character. (One thousand twenty-four kilobytes make a megabyte.)

A metal shutter on the plastic case allows access to the floppy
disk, which carries information in the form of magnetic signals.
The shutter moves out of the way when you insert the floppy
disk in a disk drive.

10,000 pages

You can use either of two types of 3.5-inch (89-millimeter) 5,000 pages
floppy disks in your computer’s SuperDrive: high-density and
double-sided.

* If you use another Macintosh: Some older Macintosh 200 pages

’ ; : 1 page

computers may not have the SuperDrive floppy disk drive ‘

and therefore cannot use high-density disks. Use only =
4K 800K 14MB 20 MB

Eloppy disks Hard disks

double-sided disks on these older Macintosh computers.

Floppy disks are also called diskettes.

Chapter 3: Setting Up Your Programs = 27



Initialize a disk 2. Depending on which dialog box appears, click
Initialize or Two-Sided.

Before you can use a new floppy disk, you need to prepare it so
that the computer knows where to store and retrieve information
on the disk. Preparing a disk is called initializing. Initializing a
disk is like drawing the lines on a newly paved parking lot: you

Another dialog box appears:

) This process will erase all
don’t know what fits where until you figure out how much room & information on this disk.
you have.
1. After you insert your practice disk into the SuperDrive, |
read the dialog box that appears on screen. i
If you inserted a high-density disk, this dialog box appears: This dialog box gives you one last chance to cancel. It alerts

you that you're about to erase—and therefore lose—any
information that may be on the floppy disk. In this case,

This disk is unreadable: because the floppy disk is new, you have no information to
Do you want to initialize it? lose

3. Click Erase.

A third dialog box appears:

If you inserted a double-sided disk, this dialog box appears:

Please name this disk:
This disk is unreadable:
Do you want to initialize it?

[ Eject )] [(one-sided] [Two-Sided)
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4. Type “Practice”.

If you make any typing errors, press the Delete key to
backspace over them.

When you name a disk, you can type up to 27 characters,
including spaces. You cannot use a colon (:) in the name.

. Click OK.

The computer takes about a minute to initialize the disk. A
series of messages appears on the screen to let you know how
the process is going.

When the computer is done initializing the floppy disk, the
disk’s icon appears on the Macintosh desktop directly below
the Macintosh HD icon (the startup hard disk icon) near the
upper-right corner.

& File Edit Uiews Label Special @ g

Copy the contents of a disk

Most programs you get are supplied on one or more floppy disks.
You can more efficiently use a program if you first install it on
your hard disk (copy it from its floppy disk to your hard disk).

(=
i
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Z
—
2
(3]

To practice copying the contents of a floppy disk to your startup
disk, use your practice disk (even if there’s nothing on it).

1. Make sure that the Practice floppy disk icon is
selected. If it isn’t, click the icon (not its name).

continues »
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Floppy disks, bard disks, and startup disks

Both floppy disks and hard disks function like filing cabinets:
you store files in them. The differences between floppy disks
and hard disks are in how much information they can store, how
quickly you can retrieve information from them, and how easily
you can carry them around.

You can store much more information on a hard disk and
retrieve it much faster than you can on a floppy disk.

And while you can carry a floppy disk in your shirt pocket, a
hard disk is sealed in a hard disk drive, which is installed inside
the computer or enclosed in a plastic box that’s connected to
the computer.

=
Internal External Floppy
hard disk hard disk disk
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You can tell whether a disk is a floppy disk or a hard disk by
looking at its icon on the desktop.

)

Hard sk

=

Floppy Disk

The disk whose icon appears near the upper-right corner is the
startup disk, which contains the information that the Macintosh
uses to start itself up.

That “startup” information is contained in programs and other
files that are in the System Folder on the startup disk. The
startup disk must have only one System Folder. If it has more
than one, the computer becomes confused about where to get
the information it needs to start up and run, with unpredictable—
and undesirable—results.



2. Drag the Practice floppy disk icon to the Macintosh HD

icon until both icons are highlighted, then release the
mouse button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Macintosh HD icon as you drag the Practice
floppy disk icon.

(2

When you release the mouse button, the Macintosh copies
the contents of the Practice floppy disk onto Macintosh HD
(your startup hard disk). The copy is in a folder named
Practice, which is now on Macintosh HD.

3. Click the Macintosh HD icon to select it.

4. Choose Open from the File menu.

You choose Open by pointing to the File menu name,
pressing to pull down the menu, dragging to the Open
command so that it’s highlighted, and releasing the mouse
button.

The Macintosh HD window appears, showing you the
contents of the startup hard disk. The contents should
include a new folder called Practice, which the computer
created when it copied the contents of the Practice floppy
disk to Macintosh HD.

You may have to make the window bigger or use the scroll
bars to find the Practice folder.

. Click the Practice folder to select it.

. Choose Open from the File menu.

You choose Open by pointing to the File menu name,
pressing to pull down the menu, dragging to the Open
command so that it’s selected, and releasing the mouse
button.

The folder holds the contents of the floppy disk you've copied
(in this case, the folder contains nothing because there’s
nothing on the Practice disk).

. Close all the windows you have on the Macintosh

desktop.

You close a window (when it’s the active window) by either
clicking its close box or choosing Close Window from the File
menu.

Chapter 3: Setting Up Your Programs 31
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Take a floppy disk out of its drive 2. Eject the floppy disk by choosing Put Away from the
g File menu.

While there’s only one way to insert a floppy disk into the

SuperDrive, there’s more than one way to take it out. Here is the

best way:

New Folder 3EN

1. Make sure that the Practice floppy disk icon is Open #0
) s s Print Hed?
selected. If it’s not selected, click it. : . 5
{inse Hindop K
@ Get Info 1

fuplivata g3}
Make Hlias
Put Away

Find... F
Find Again #®06

Page Setup...
Print Desktop...

You choose Put Away by pointing to the File menu name,
pressing to pull down the menu, dragging to the Put Away
command so that it’s highlighted, and releasing the mouse
button.

Put Away puts the object you've selected back in its place (in
this case, it allows you to remove the floppy disk from the disk
drive and put it away).
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S’lfGUU’lfd [h@ contents (')f 1 1161( 3. Turn the disk over and lock the disk by sliding the tab
e AL on the back side of the disk so that the square hole is
You can lock a disk so that its contents cannot be changed in any open.

way. When a disk is locked, you cannot change the files that are
on it, delete any files, or store additional files.

!
]
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=
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Z,
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To practice locking and unlocking a floppy disk, use your practice
disk.

1. Hold the practice disk between thumb and forefinger,
with your thumb on the label and the metal shutter
pointing away from you (as if you were going to insert
the disk into a drive).

2. Find the square hole in the near-left corner of the
floppy disk.

Locked Unlocked
A moveable tab on the back side of the disk should be

blocking the hole, indicating that the disk is unlocked. Use your thumbnail or a push pin to move the tab.

- If you're using a high-density floppy disk: You'll notice an 4. Unlock the disk by sliding the tab back so that the
additional square hole, across the label from the first hole. square hole is blocked.

This second hole has no moveable tab and is always open. < _
Your practice disk should be unlocked so you can use it to

store files in the next chapter.
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Use the Wastebasket

When you no longer need or want a file or folder, you throw it
away by dragging its icon to the Wastebasket. (A file can be either
a document or a program.) Practice using the Wastebasket by

Taking care of floppy disks

Follow the instructions about care and maintenance that came
with your disks. At minimum, remember these three points:

= Keep the disks away from magnets. Information on the throwing away the Practice folder, which you created when you
disks is in the form of magnetic signals, so a magnetic field copied the contents of your Practice disk onto Macintosh HD.

can destroy that information. Televisions and monitors,
telephones, loudspeakers, and certain kinds of lighting
fixtures all have magnets. 2. Choose Open from the File menu.

1. Click the Macintosh HD icon to select it.

= Protect disks from extremes of temperature and humidity. You choose Open by pointing to the File menu name,
pressing to pull down the menu, dragging to the Open
command so that it’s highlighted, and releasing the mouse
button.

= Do not open the disk’s metal shutter. Touching the disk
inside the shutter could damage it.

The Macintosh HD window appears, showing you the
contents of the startup hard disk. The contents should
include the Practice folder.

You may have to make the window bigger or use the scroll
arrows to find the Practice folder.

3. Click the Practice folder icon to select it.
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4. Drag the Practice folder icon to the Wastebasket icon

until both icons are highlighted, then release the
mouse button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Wastebasket icon.

When you release the mouse button, the Practice folder
“disappears” into the Wastebasket. When you put a file or
folder in the Wastebasket, the Wastebasket icon bulges to
indicate that it is no longer empty.

5. Open the Wastebasket icon.

You open an icon by clicking it to select it and then choosing
Open from the File menu.

When you open the Wastebasket icon, the Wastebasket
window appears. The Practice folder you've just thrown away
is in the window. Anything you put in the Wastebasket stays
there until you empty the Wastebasket.

You can put anything that’s in the Wastebasket back where it
was by clicking it to select it and then choosing Put Away from
the File menu. (Or you can drag it back where it was.)

. Choose Empty Wastebasket from the Special menu.

A dialog box appears asking you to confirm that you want to
permanently remove the contents of the Wastebasket. If you
change your mind, you can click the Cancel button.

Clicking OK empties the Wastebasket, and you lose anything
that’s in it.

. Click the OK button.

Notice that the Wastebasket icon no longer bulges, indicating
that it is empty.

. Close the Wastebasket window by clicking its close

box.
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On your own: Install your programs

If you have any disks containing programs (such as word
processing or graphics) that you plan to use on your Macintosh,
install the programs now on your hard disk. If you do not have
any program disks yet, go to the next chapter.

_\ Important: Some programs need to be installed in a
specific way, so follow the instructions that came with each
program.

If a program didn’t come with specific installation instructions,
these general instructions tell you how to copy the contents of a
program disk to your startup disk:

1. Lock the program disk.

The program disk contains your master copy of the program.

Locking the disk protects its contents but doesn’t keep you
from copying the contents onto another disk.

2. Insert the program disk into the floppy disk drive.
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. Drag the program disk icon to the Macintosh HD icon

(your startup hard disk icon) until both icons are
highlighted, then release the mouse button.

Both icons are highlighted when the tip of the pointer arrow
reaches the Macintosh HD icon as you drag the program disk
icon.

When you release the mouse button, a series of messages
briefly appears on screen to let you know that the computer
is copying the contents of the program floppy disk onto
Macintosh HD. The copy is in a folder on Macintosh HD with
the same name as the program disk.

. Eject the program disk by making sure it’s selected

and then choosing Put Away from the File menu.

. If the Macintosh HD window is not on the desktop,

open the Macintosh HD icon.

When you open the Macintosh HD icon, the Macintosh HD
window appears, showing you the contents of your startup
hard disk. Among its contents is the program folder holding
the contents of the disk you've copied.

. Click the program folder to select it.



7. Choose Open from the File menu.

The folder window appears, showing the contents of the
program folder. The folder has the same contents as the
program disk.

8. Look for a System Folder in the program folder.

Some program disks have a System Folder (so they can be
used as startup disks). If the program disk you've copied
has a System Folder, you now have two System Folders on
Macintosh HD.

Throw away extra System Folders

Your startup disk must have only one System Folder. Whenever
you copy the contents of a program disk to your startup hard disk,
check to see that you have not copied an extra System Folder. If
you have, throw away the extra System Folder.

1. Drag the extra System Folder to the Wastebasket in the
lower-right corner of the screen until both icons are
highlighted, then release the mouse button.

2. Choose Empty Wastebasket from the Special menu.
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A dialog box alerts you that you're about to throw away—
permanently—the contents of the Wastebasket (in this case,
the extra System Folder).

3. Click OK to confirm that you want to throw away the
contents of the Wastebasket.

4. Close the program folder window by clicking its
close box.

What next?

Go to Chapter 4, where you'll learn how to create a document.
Or take a break. Remember to turn off your Macintosh if you'll
be away for more than a few hours.
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Chapter 4

Cr eating 1 Document and Before you begin

You should have already

SaVing Your Wor k = gone through Chapters 1 through 3

If you turned off the Macintosh at the end of Chapter 3, turn it
In this chapter back on.

You'll review how to

= Open a program

= create a document in a program

m  save your work

= switch programs

m  close a document

(The Macintosh Basics tour introduced you to these skills.)
You'll also learn about

= what happens when you open a program icon

= whyit’s important to save your work

= the difference between application programs and system
software

It will take about 30 minutes to go through this chapter.
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Op@ﬂ a program When you open the TeachText program,
O

i i an untitled window appears
To practice using a program to create a document and save your = untitlec pp

work, you can use TeachText, a simple word-processing program m the menu bar shows TeachText menu names

that comes with your computer. . . .
' P = the Application menu icon in the right corner of the menu bar

1. If you closed the Macintosh HD window at the end of becomes the TeachText icon
Chapter 3, open the Macintosh HD icon.

: ;5 5 Application menu
To open the icon, click it to select it and then choose Open TeachText menus (TeachText icon)

from the File menu.

& File Edit @ 78

Untitled e

The Macintosh HD window appears, showing you the
contents of your startup disk. The contents include a program
called TeachText.

|

2. Open the TeachText icon.

TeachText

To open the icon, click it to select it and then choose Open
from the File menu.

Untitled TeachText window

The untitled window contains nothing because you haven’t
written anything in it. It remains untitled until you save
whatever you've written and give it a name. The file that you
create and name is called a document.
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Create a document

The untitled window is like a blank sheet of paper, a document
waiting to be created. In the upper-left corner of the empty
document is a blinking vertical line. The line is called the
insertion point, because it marks the place where the text you
type will be inserted.

As you type, you use the Macintosh keyboard as you would a
typewriter keyboard, except:

m  Ifyou make a mistake, press the Delete key to backspace
over it.

= Don't press the Return key when you get to the end of a line.

Keep typing. The text will continue on the next line
automatically.

Type the following text:

Sailing across an unknown sea, we saw the
lights of a city in the distant horizon. Was
it another strange land, with strange and
cruel people speaking different languages,
eating different food, wearing different
clothes? We wished it were home.

You will be changing this text in the next chapter.

Save your work

Until you save your work, it exists only in the computer’s
memory—like thoughts that are lost unless you write them down.

1. Choose Save from the File menu.

N
Baen...

Close W
. #BS

Save As...

Page Setup...
Print... *EP

Quit 380

The dialog box that appears lets you name the document and
decide where you want the computer to store it.

continues »
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2. Type “Opening Lines”.

= Macintosh HD¥ > Macintosh HD

0 Read Me
0O System Folder

& Teachient Desktop

=
o]
&
3

Save this document as: N
Opening Lines| | @ o

Because the word “Untitled” is selected (it’s highlighted)
when the dialog box appears, all you have to do is start typing.
Whatever you type replaces the selected text. You'll learn
more about selecting text later.

3. Click Save.

Sailing across an unknown sea, we saw the ligh ci

distant horizon. Was it another strange land, with strange and
cruel people speaking different languages, eating different food,
wearing different clothes? We wished it were home|

The window is now titled “Opening Lines” and the document
has been stored on Macintosh HD.
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Save it or say so long

You need to save your document before you turn off the
computer.

Using a Macintosh may seem like using a typewriter, pencil and
ledger, paintbrush and canvas, or pen and drafting paper—

but a computer is unlike those other tools in one important
aspect: anything you create on a computer exists only
temporarily in the computer’s memory until you save your
work.

That is, until you tell the computer to record your creation
on a disk, your finest work is no better than a mental note—
forgotten faster than you can turn off a switch.



Switch programs

The Opening Lines window is the active window and TeachText is
the active program, but TeachText is not the only program that’s
open.

The Finder—the program that displays the Macintosh desktop—
is also open, but right now it is not active. (The Finder is always
open when your Macintosh is on.)

You can have several programs open at one time (how many
programs depends on how much memory your computer has),
but only one program at a time can be the active program. The
active program is the one that’s “on top” of other open
programs—just as the active window is on top of other windows.

1. Make the Opening Lines window smaller by dragging
its size box and releasing the mouse button.

After you resize the window, you should be able to see the
Macintosh HD icon in the upper-right corner of the Macintosh
desktop.

2. Make the Finder the active program by clicking the
Macintosh HD icon or anywhere on the desktop.

The Finder becomes the active program. Notice that

= the Macintosh HD window appears on top of the Opening
Lines window

s the menu bar shows Finder menu names

» the Application menu icon in the right corner of the menu
bar becomes the Finder icon

€ File Edit liew Label Special @ @

Opening Lines

E Sailing across an unknown sea, we saw the lights of a city in the
distant horizon. Was it another strange land, with strange and
cruel people speaking different languages, eating different food,

4 items

| wearing (FEjE====-= Macintosh H) ===

3.7 MB in disk 34.4 MB available

G2

ReadMe System Folder TeachText Opening Lines

@ ¢ B 0

&l

e

Notice the icon in the Macintosh HD window representing the
document Opening Lines, which you've just created and
saved on Macintosh HD.

continues W
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Two types of programs

Programs that you use to do your work on the computer are
called application programs (or applications), because they’re
ways of applying computer technology to the work that you do.

Word-processing programs, for example, are applications
because they enable you to write memos, reports, papers,
theses, novels—whatever you need or want to write. And if
your work involves creating graphics, calculating numbers,
composing music, or keeping track of large amounts of
data—there are application programs for your work as well.

Most Macintosh programs work in similar ways, so most of
what you learn using one application you can use in other
applications.

Programs that the computer uses to operate, on the other
hand, are called system software (or “the operating system”).

And then there’s the Finder

Between you and system software is an application called the
Finder, which is the program that displays the Macintosh
desktop. It’s called the Finder because, like the viewfinder in a
camera, it gives you a view of all the objects—disks, programs,
documents—that you have in your computing work space
(your “desktop”).

Using the Finder, you can tell system software what you want it
to do for you: which disks you want to use, which programs and

documents you want to open, where you want files to be stored.

3. Make the Opening Lines window active by

clicking anywhere in it. It’s partially hidden by the
Macintosh HD window.

The Opening Lines window comes back to the top. It's now
the active window, and TeachText becomes the active
program.

You make a window active by clicking any part of it. The
program that “owns” the window becomes active as soon as
the window becomes active.

. Make the Finder the active program by choosing

Finder from the Application menu in the right corner
of the menu bar.

Hide TeachText
Hide Others
Bhgnp #H

B Finder .
v 48 TeachText

You choose Finder by pointing to the Application menu icon,
pressing to pull down the menu, dragging to the item
“Finder” so that it’s highlighted, and then releasing the mouse
button.

The Finder becomes the active program, and the
Macintosh HD window becomes the active window.



5. Make TeachText the active program by choosing Close a document
TeachText from the Application menu.
When you close a document, you do not close the program that
you used to create it. (Closing a program is called quitting.) The
Hide Finder program remains open and remains the active program until you
Hide Dthers quit the program or make another program the active program.

Shap f
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1. If the Opening Lines window is not the active window,
@ Finder click anywhere in it to make it the active window.

- TeachText 2. Close the Opening Lines window by clicking the close
box near the left end of the title bar, or by choosing
Close from the File menu.

TeachText becomes the active program, and the Opening

: The Opening Lines window closes but TeachText is still the
Lines window becomes the active window.

active program. Notice that
From the Application menu, you can choose the open
program that you want to make the active program. All open
programs are listed in the Application menu. The icon at the = the Application menu icon in the right corner of the menu
top of the Application menu is the icon of the active program. bar is still the TeachText icon

= the menu bar still shows TeachText menu names

What next?

Go to Chapter 5, where you'll learn how to revise your document
and then print it.
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Chapter 5

Changing a Document and
Printing Your Work

In this chapter

You'll learn how to

= open a document

m change a document

m choose a printer

m  print a document

®  uita program

= make a backup copy of a document
You'll also learn about

= double-clicking as a way to open icons
= using keyboard shortcuts

It will take about 40 minutes to go through this chapter.

Before you begin

You should have already

= gone through Chapters 1 through 4
Also, make sure that

= your computer is connected to a printer

A printer can be connected directly to your computer, or it can be
connected through a network.

Go to the instructions that came with your printer if you need to
connect it to your computer.

If your computer is connected to a network, find out from your
network administrator (or the person who set up your computer)

= which printer on the network you can use

= where it is on the network (its “zone,” if the network has
zones)

= what its name is (every printer on a network has its own
name)

If you turned off the Macintosh at the end of Chapter 4, turn it
back on.

47
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Open a document

When you open a document, the program that you used to create
that document becomes the active program.

1. Ifyou closed the Macintosh HD window at the end of
Chapter 4, open the Macintosh HD icon.

To open the icon, click it to select it and then choose Open
from the File menu.

The Macintosh HD window appears, showing you the
contents of your startup hard disk. The contents include the
TeachText program and the TeachText document called
Opening Lines, which you created in Chapter 4.

2. Open the Opening Lines icon.

Upehing Lines

You can open an icon by double-clicking it: click the icon
twice in rapid succession, without moving the pointer.
Double-clicking an icon has the same effect as selecting the
icon and then choosing the Open command.

48 Chapter 5: Changing a Document and Printing Your Work

When you open Opening Lines, TeachText becomes the active
program. (TeachText is the program that you used to create
Opening Lines.) Notice that

= the Opening Lines window appears
= the menu bar shows TeachText menu names

= the Application icon in the right corner of the menu bar
becomes the TeachText icon

(& File Edit @D &)
E[J&==—=——=—=—=———== Opening Lines S===xu=) 2
ISelling across an unknown sea, we saw the lights of a city in the
distant horizon. Was it another strange land, with strange and
cruel people speaking different languages, eating different food,
wearing different clothes? We wished it were home.

Change a document

The Opening Lines window shows you the text you typed in
Chapter 4. You will be making some changes to the text using
techniques that work in most Macintosh programs.

Keep two things in mind:

m The insertion point—the blinking vertical line—is where
anything you type appears.

m  The I-beam pointer replaces the arrow pointer when you're
dealing with text. You control the I-beam pointer with the
mouse as you would the arrow pointer.

1



Locate the insertion point. It should be in the upper-
left corner of the document.

Locate the I-beam pointer. If you don’t see it, move the
mouse slightly. The pointer moves as the mouse moves.

Now you're ready to insert some text.

Move the I-beam pointer to the immediate left of the
word “an” (after “Sailing across”).

Click. By clicking, you put the insertion point where
you were pointing with the I-beam pointer. Anything
you type is inserted at that point.

=—————— Opening Lines =—————0|
Sailing across [an unknown sea, we saw the lights of & city in the [{]
distant horizon. Was it another strange land, with strange and

cruel people speaking different languages, eating different food,
wearing different clothes? We wished it were home.

Type the words “the blackness of space, adrift in”.

If you make any typing errors, press the Delete key to
backspace over them.

Sailing across the blackness of space, adrift injan unknown sea,
we saw the lights of a city in the distant horizon. Was it another
strange land, with strange and cruel people speaking different
languages, eating different food, wearing different clothes? We
wished it were home.

Next, you'll change some text.

6. Move the I-beam pointer to the immediate left of the
word “lights” (after “we saw the”).

7. Drag horizontally, selecting the word “lights”, then
release the mouse button.

To drag, hold the mouse button down as you move the
mouse. The selected word is highlighted (surrounded by
black or another color).

EO Opening Lines HE
Sailing across the blackness of space, adrift in an unknown sea,
we saw the of a city in the distant horizon. Was it another
strange land, with strange and cruel people speaking different
languages, eating different food, wearing different clothes? We

wished it were home.

8. With “lights” selected, type the words “clear blue”.

Whatever you type replaces the text you selected. If you make
any typing errors, press the Delete key to backspace over
them.

9. Now move the I-beam pointer to the immediate left of
the word “city” (after “of a”).

EO Opening Lines S—————
Sailing across the blackness of space, adrift in an unknown sea,
we saw the clear blue of a Fity in the distant horizon. Was it
another strange land, with strange and cruel people speaking
different languages, eating different food, wearing different
clothes? We wished it were home.

continues ®

Chapter 5: Changing a Document and Printing Your Work 49

!
<!
>
=
Z
o
2z
D




10. Drag horizontally, selecting the word “city”, then
release the mouse button.

Opening Lines Si"—————1|
Sailing across the blackness of space, adrift in an unknown sea,

we saw the clear blue of a in the distant horizon. Was it
another strange land, with strange and cruel people speaking

different languages, eating different food, wearing different
clothes? We wished it were home.

11. With “city” selected, type the word “planet”.

Whatever you type replaces the text you selected.

12. Move the I-beam pointer between the letters “n” and
“t” in the word “distant” (after “in the”).

===
Sailing across the

= Opening Lines =

ackness of space, adrift in an unknown sea, |}
we saw the clear blue of a planet in the distan|l horizon. Was it
another strange land, with strange and cruel people speaking

different languages, eating different food, wearing different
clothes? We wished it were home.
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13. Drag horizontally, selecting the letter “t” and the word
“horizon”, then release the mouse button.

[EC Opening Lines SS=—=—=———n3|
Sailing across the blackness of space, adrift in an unknown sea,

we saw the clear blue of a planet in the distan[iIaERy Wes it
another strange land, with strange and cruel people speaking

different languages, eating different food, wearing different
clothes? We wished it were home.

14. With “t horizon” selected, type the letters “ce”.

If the period is missing after “distance”, type one now.

E=—======= opening Lines ==

Sailing across the blackness of space, adrift in an unknown sea,
we saw the clear blue of a planet in the dislance{. Was it another
strange land, with strange and cruel people speaking different

languages, eating different food, wearing different clothes? We
wished it were home.

If you make any typing errors, press the Delete key to
backspace over them.



Save your work so far

The changes you've made so far are not part of Opening Lines until
you save them; that is, you need to tell the computer to record the
changes in the document that’s stored on Macintosh HD (your
startup hard disk). 4

Until you save them, the changes are in a very temporary,
electronic state. You could lose them if power to the computer
were interrupted or if a problem with a program caused the
computer to stop working properly.

Choose Save from the File menu.

Or hold down the g8 (Command) key on the keyboard as you
press the S key. Pressing 8-S is a keyboard shortcut for choosing
Save from the File menu.

Save regularly, and save often.

Taking a shortcut

I
<o}
>
)
2
Z
(=]

Many commands that you choose from menus can also be
given using keyboard shortcuts. A keyboard shortcut is a
combination of keys that you press at the same time to get
the same result as choosing a command from a menu. One of
the keys is always the 8 key or another modifier key.

For example, instead of choosing Save from the File menu,
you could press the 88 key and the S key together.

You can find out the keyboard shortcuts for commands by
pressing a menu name and looking at the commands in the
menu. Any keyboard shortcuts are shown in a column next to
the commands.

Make more changes to a document

You've saved the changes you've made so far: the changes are
now part of the document that’s stored on Macintosh HD. You'll
be making a few more changes before you're done.

You continue by moving some text to another place in the
paragraph.

1.

Move the I-beam pointer to the immediate left of the
words “We wished” (the start of the last sentence).

Click. By clicking, you put the insertion point where
you were pointing with the I-beam pointer.

conlinues »
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3. Move the I-beam pointer between the letter “e” in
“home” and the period at the end of the last sentence.

Hold down the Shift key on your keyboard and click to

Move the I-beam pointer to the immediate left of the
words “Was” (in “Was it another strange land”).

Click to set the insertion point.

select the words “We wished it were home”. .
e i 8. Choose Paste from the Edit menu.

Holding down the Shift key as you click selects the text
between the insertion point and wherever you click.

iingo Bz
[EO===—=—==—=—===== opening Lines ====ux==xg
Sailing across the blackness of space, adrift in an unknown sea, [& §ask g
we saw the clear blue of a planet in the distance. Was it another 5 o4
strange land, with strange and cruel people speaking different i, £ §7§,§ 73:5%-
languages, eating different food, wearing different clothes? |
wished it were homel " -
\ fipay

5. With “We wished it were home” selected, choose Cut
from the Edit menu.

Select All A

Show Clipboard

Choosing Cut removes whatever you've selected from the
document and stores the selected material in a temporary
electronic space called the Clipboard.

| Eoit

The words “We wished it were home” appear at the location
of the insertion point. When you choose Paste, the Macintosh
takes whatever’s in the Clipboard and puts it in the document.

Hngdo 2 Next, you'll delete a sentence.
Copy ! 3®C

Paste L

Clear

Select Al %A

Show Clipboard
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9. Drag the I-beam pointer across the words “Was it
another strange land” to select them, then release the
mouse button.

If the words are on two lines, drag down to the second line
and release the mouse button when the pointer is to the
immediate right of the word “land”.

EE===——=———— Opening Lines ===
Sailing across the blackness of space, adrift in an unknown sea, [+
we saw the clear blue of a planet in the distance. We wished it
were homelFEERISEIMUTETESEETHERENT, with strange and cruel
people speaking different languages, eating different food,

wearing different clothes? .

10. With “Was it another strange land” selected, choose
Clear from the Edit menu.

When you choose Clear, the Macintosh removes the selected
text from the document. (Pressing the Delete key once has
the same effect.)

s B
Cut 3%H
Copy %C
Paste ] |

AT

Select Rl A

Show Clipboard

11. Select the word “cruel” (after “strange and”) by

double-clicking it.

You can select a word by double-clicking it: point to it with the
[-beam pointer and click twice in rapid succession, without
moving the pointer.

E0==———=————— Opening Lines ===

Sailing across the blackness of space, adrift in an unknown sea, [{3
we saw the clear blue of a planet in the distance. We wished it
were home, with strange and people speaking different
languages, eating different food, wearing different clothes? .

12. With “cruel” selected, type “wonderful”.

Whatever you type replaces the text you selected.

13. Drag the I-beam pointer across the question mark

(after “different clothes”) and the stray period at the
end of the paragraph, then release the mouse button.

Elm] Opening Lines
Sailing across the blackness of space, adrift in an unknown sea,

we saw the clear blue of a planet in the distance. We wished it
were home, with strange and wonderful people speaking different
languages, eating different food, wearing different clothes

continues W
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14. With the question mark and the period selected, type
a period.

You may have left extra spaces or no spaces between words.
If you did, position the I-beam pointer where you need to
delete or add a space, click to set the insertion point, and
press the Delete key or the Space bar as necessary.

=== opening Lines
Sailing across the blackness of space, adrift in an unknown sea, |[{*
we saw the clear blue of a planet in the distance. We wished it
were home, with strange and wonderful people speaking different
languages, eating different food, wearing different clothes]

15. Choose Save from the File menu (or use the keyboard
shortcut $-S).

Choose a printer

Before you can print a document, you have to tell the Macintosh
which printer to use by choosing a printer in a program called the
Chooser.

You don’t need to choose a printer every time you print. You need
to choose one only when you want to use a printer for the first
time and whenever you decide to change printers.

How you use the Chooser depends on whether your Macintosh is
connected directly to the printer or connected to a network.
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If your printer is not on a network

Make sure that you've connected the printer according to the
instructions that came with it and that you know which port you
used (on the back of the computer) to connect the printer.

1. Choose the Chooser from the Apple menu.

About TeachText...

@ Alarm Clock
Calculator
i= Chooser
Control Panels
Key Caps

Note Pad

Scrapbook

The Chooser window appears.



2. Click the icon representing the printer you want to
use. Make sure the icon is selected.

E00 Chooser |
] | Select a port:
i [
AppleShare  AppleTalk gewriter| | |
|
Laser¥riter
froT |
L AppleT...geWriter  LQ Image¥riter 1
I | :
Personal ..Writer SC
e O Active
o arniskals ® Inactive 2.0

<« Ifyou have a Personal LaserWriter SC, go to step S after you
click the Personal LaserWriter SC icon. «

3. Click to select the icon representing the port that you
used to connect the printer.

You have two choices: the printer port or the modem port.
The printer port is automatically selected. Click the icon that
matches the icon of the port (on the back of the computer) to
which you connected the printer cable.

4. Click the word “Inactive” next to the word “AppleTalk”.

5. Close the Chooser by clicking the close box near the
upper-left corner of the Chooser window.

The Opening Lines window should now be the active window.
(Ifitisn't, click anywhere in it to make it the active window.)

If your printer is on a network

Find out from your network administrator (or the person who set
up your computer) which printer you can use, which zone it’s in
(if your network has zones), and what its name is (every printer
on a network has its own name).

1. Choose the Chooser from the Apple menu.

About TeachText...

(® Alarm Clock
Calculator
(S Chooser
Control Panels
Key Caps
Note Pad
HBH Puzzlie
Scrapbook

The Chooser window appears.

continues p
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2. Click the word “Active” next to the word “AppleTalk”.

If Active wasn't already selected, a dialog box appears.
Click OK.

Eim} Chooser %I
Select a LaserWriter:
E Backside iti
AppleShare  AppleTalk..geWriter| Fay

Isadora Duncan NTX
Jaunt (LW plus)
Marathon (LW NTX)
QMs ColorScript 100
Sojourn (LW NTX)

Image\rriter [Lasoritriter]

AppleTalk Zones:

Trek (NTX)
Demilitarized Tum me of f when you're done.
Loading
No Parking &
0
Taxi Background Printing: @ 0n O 0Off
Testing
Twilight @ Active
Unloading AppleTalk QO Inactive 70

3. Click the icon representing the type of printer you
want to use.

4. If you see a list of AppleTalk zones, click the zone
where the printer is located.

You may have to click the up and down scroll arrows to find
the zone. The zones are listed alphabetically.

5. Click the name of the printer you want to use, even if
it’s the only one that appears.
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6. Click the close box near the upper-left corner of the
Chooser window.

If you changed printers, a dialog box appears. Click OK.

The Opening Lines window should now be the active window.
(If it isn’t, click anywhere in it to make it the active window.)

Print a document

Once a printer has been selected in the Chooser, printing
becomes a two-step process. To practice printing, use the
Opening Lines document you created.

1. Make sure that the Opening Lines window is the active
window, then choose Print from the File menu.

| File

N SN
o, B

Close EW
Bapa HE
Save As...

Page Setup...

Quit 0

If the Opening Lines window is not the active window, click
anywhere in it to make it the active window.



The dialog box that appears when you choose Print offers you
many options, depending on the program and the printer
you're using. You can learn more about these options from
the instructions that come with your programs and from
Macintosh Reference, Part 11 of this book.

LaserlWriter “Isadora Duncan NTH” E Print ]]
Copies:@ Pages: @ All O From: To: [ Cancel ]

Cover Page: ® No O First Page O Last Page
Paper Source: @ Paper Cassette (O Manual Feed
Print: @ Black & White (O Color/Grayscale
Destination: @ Printer O PostScript® File

2. Click the button labeled Print.

The printer you chose prints your Opening Lines document.

Quit a program

Quitting a program closes the program as well as any documents
you may have open that were created using that program.
Quitting a program is not the same as closing a document (which
you did at the end of Chapter 4). Closing a document leaves the
program open and active.

Make sure that the Opening Lines window is the active
window, then choose Quit from the File menu.

N

B9,

Close W
Saua H#E
Save fAs...

Page Setup...
Print... 3P

Or press the 8 key and the Q key together.

If a dialog box asks whether you want to save any changes,
click Save. <

The Opening Lines document and the TeachText program
are closed, and the Finder, the program that displays the
Macintosh desktop, becomes the active program.
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Make a backup copy

Storing a copy of your work on another disk is wise practice, like
saving regularly and saving often. In case a file or an entire disk is
damaged, you have a copy of the file on another disk as a backup.
(It seldom happens, but if it happens once to you, it's happened
once too often.)

To practice making a backup copy, put a copy of Opening Lines on
your practice disk.
1. Make sure your practice disk is unlocked.
A moveable tab on the back side of the case should be
blocking the square hole near the lower-left corner (when you

hold the disk as if to insert it), indicating that the disk is
unlocked.

2. Insert the practice disk in your computer’s floppy disk
drive.

The Practice disk icon appears on the desktop, directly below
the Macintosh HD icon.
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3. Drag the Opening Lines icon to the Practice disk icon
until both icons are highlighted, then release the
mouse button.

Hl

24 .2 MB available

E

Dpening Lines’

Both icons are highlighted when the tip of the pointer arrow
reaches the Practice disk icon.

When you release the mouse button, the Macintosh copies
the contents of the Opening Lines icon to the Practice disk.

You copy an icon when you drag it to a different disk. When
you drag it elsewhere on the same disk, you are merely
moving the icon.



4. Open the Practice disk icon.

You open the Practice disk icon by clicking the icon to select it
and then choosing Open from the File menu, or you can
double-click the icon.

The Practice disk window appears, showing that a backup
copy of the file, also called Opening Lines, is stored on the
floppy disk.

5. Eject the Practice disk from the disk drive.

You eject the disk by clicking the Practice disk icon to select it
and then choosing Put Away from the File menu.

New Folder #EN
Open 30
Prind P34
finse Hindaw R

Get Info |
uninais P8
Make Alias

Put Away

Find... 3BF
Find Again 3#0

Page Setup...
Print Desktop...

What next?

Go to Chapter 6, where you'll learn how to organize your work.
Or take a break. Remember to turn off your Macintosh if you'll be
away for more than a few hours.
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Chapter 6

Organizing Your Work

In this chapter

You'll learn how to

= make a copy of a document

m change the name of an icon

= save another version of a document under a different name
= open a document while its program is the active program
= organize icons in a folder

= use an alias for a document or program

= Create stationery

= throw away files you no longer want or need

You'll also learn about

m the difference between Save and Save As

= what an alias is

[t will take about an hour to go through this chapter.

Before you begin

You do not need to go through this chapter before you start
learning how to use your Macintosh programs.

You should have already
= gone through Chapters 1 through 5

If your Macintosh is off, turn it back on.
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Make a copy of a document

In the course of your work, you'll often want to make a copy of a

document so you can preserve the original while making changes
to the copy. To practice making a copy of a document, first create
a new document, as you did in Chapter 5.

1.

62

If you closed the Macintosh HD window, open the
Macintosh HD icon.

To open the icon, click it to select it and then choose Open
from the File menu. Or double-click the icon.

The Macintosh HD window appears, showing you the
contents of your startup hard disk.

Open the TeachText icon.

To open the icon, click it to select it and then choose Open
from the File menu. Or double-click the icon.

When you open the TeachText program,

= an untitled window appears
m the menu bar shows TeachText menu names

= the Application menu icon in the right corner of the

menu bar becomes the TeachText icon

The untitled window contains nothing because you haven't
written anything in it. It stays untitled until the first time you
save your work (name the document and store it on a disk).
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3. Type the following text:
Dear Mom and Dad,

This letter is overdue, I know, but until
I sat down to write, I had no idea how
long overdue it is. Time sure flies when
you don’t have enough of it.

Julie and I are doing well. The dog is
getting better all the time. How are you
allz

Remember:

= Ifyou make a mistake, press the Delete key to backspace
over it.

= Don't press the Return key when you get to the end of a
line. Keep typing. The text will continue on the next line
automatically.

m Press the Return key only when you want to start a new
paragraph.

= The insertion point—the blinking vertical line—is where
the text you type will appear.

m The I-beam pointer replaces the arrow pointer when

you're dealing with text. You control the I-beam pointer
with the mouse as you would the arrow pointer.



.
<2}
; >
4. Choose Save from the File menu. 7. Close the Letter to Parents window. =
: , . z
The dialog box that appears lets you name the document and To close the window, click the close box near the left end of =
decide where you want the computer to store it. the title bar, or choose Close from the File menu.
5. Type “Letter to Parents”. The window closes, and TeachText remains the active
program.
< Macintosh HD 8. Click the Macintosh HD icon, the Macintosh HD
D) Dpening Lines 5] T i h h kton.
Opperny window, or anywhere on the desktop
0 System Fold Deskt - § .
AChEET I'he Finder becomes the active program. Among the contents
of the Macintosh HD window is the Letter to Parents icon,
representing the document you created and saved.
= . . .
9. Locate the Letter to Parents icon in the Macintosh HD
Save this document as: B, . d
|Letter to Parenty | ® O WInGow.

You may have to make the window bigger or use the scroll
arrows to find it.

Usually you need to select text or set the insertion point
before you type text. In this case, because “Untitled” is
selected when the dialog box appears, all you have to do is 5
start typing. Whatever you type replaces the selected text. ﬁ

6. Click Save. m

The window is now titled “Letter to Parents” and the
document has been stored on Macintosh HD (your startup
hard disk).

10. Click the Letter to Parents icon to select it.

continues W
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11. Choose Duplicate from the File menu.

New Folder 3N

Open 30
Print 3P
Close Window 3LV

Get Info
Duplicate

Make RAlias

Pl Busny Y
Find... ®F
Find Again %0
Page Setup...

Print Window...
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Another icon, labeled “Letter to Parents copy”, appears in the
Macintosh HD window. Notice that the icon (as well as its
name) is selected and that the Letter to Parents icon is no
longer selected.

Chapter 6: Organizing Your Work

Change the name of an icon

You can change the name of any icon to anything you like, using
spaces, capital and lowercase letters, numbers, and any other
characters except a colon (:). If you open the icon, you'll see that
the name of its window has also changed.

1. Drag the “Letter to Parents copy” icon away from the

original icon so that the two icons do not overlap.

Click the name (not the icon) “Letter to Parents copy”
(even if the icon is selected).

When the name is selected, it is highlighted and a box appears
around it. Notice that when you point to the selected name,
the arrow pointer becomes an I-beam pointer.

o

. With the name selected, type “Letter to Sister”.

Or drag the I-beam pointer over the words “Parents copy” to
select them, and then type “Sister” to replace them.

Another way to select a word is to double-click it: click
anywhere inside the word twice in rapid succession, without
moving the pointer.

Whatever you type replaces the selected text.



4. Press the Return key. 7. Type “Sis”.
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Whatever you type replaces the selected text.

E _ B —
=== Letter to sister =5

Letter to Parents [R3aCTRd Dear Sig, |
This letter is overdue, | know, but until | sat down to write, | had

no idea how long overdue it is. Time sure flies when you don't

have enough of it.

Julie and | are doing well. The dog is getting better all the time.
How are you all?

Now you have two documents. One is a copy of the other but
they have different names. You can revise one without

changing the other.

8. Choose Save from the File menu.
5. Open the Letter to Sister icon.

9. Choose Close from the File menu.
To open the icon, click it to select it and then choose Open

from the File menu. Or double-click the icon. Or click the close box near the upper-left corner of the Letter
to Sister window. You now have two slightly different versions
of your letter: one for your parents, and the other for your

6. Drag the I-beam pointer over the words “Mom and sister.
Dad” to select them.

TeachText becomes the active program.

TeachText remains the active program.

EO=———— lelter lo Sister =5
Dear ., <3
This letter is overdue, | know, but until | sat down to write, | had

no idea hovs long overdue it is. Time sure flies when you don't have
enough of it.

Julie and | are doing well. The dog is getting better all the time.

How are you all?
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Save another version of a document

There is another way to make a different version of a document.

You can stay in the program you're using to create the document

and save a different version under a different name.

1. Click the Macintosh HD icon, the Macintosh HD
window, or anywhere on the desktop.

The Finder becomes the active program.
2. Open the Letter to Parents icon.

To open the icon, click it to select it and then choose Open
from the File menu. Or double-click the icon.

TeachText becomes the active program.

3. Drag the I-beam pointer over the words “Mom and
Dad” to select them.

4. Type “Juan”.

Whatever you type replaces the selected text.

E[)==—————-—— lLetter to Parents
Dear Juary,

This letter is overdue, | know, but until | sat down to write, | had
no idea how long overdue it is. Time sure flies when you don't have
enough of it.

Julie and | are doing well. The dog is getting better all the time.
How are you all?

Bl
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5. Choose Save As from the File menu. Do not choose

Save.

N
B9, s

Close EW
Save #S

Page Setup...
Print... *EP

Quit 30

Choosing Save would change the original letter (so that the
letter to your parents would read “Dear Juan”).

Choosing Save As, in contrast, lets you create a new document
based on the original document, but including the changes
you made.

The dialog box that appears lets you name the new document
and decide where you want the computer to store it. “Letter
to Parents,” the name of the original document, is already
selected and ready to be changed.



6. Type “Letter to Juan”.

= Macintosh HD¥ = Macintosh HD
O tetter fo Parents i
0 tetter to Sister -
(3 Bpeaing Lines Desktop
0 Read Me
0O System Folder
& Teachient T

&

Save this document as: .
Letter to Juan | @ O

Whatever you type replaces the selected text.

7. Click Save.

The new document, “Letter to Juan,” now appears in the
active window, replacing the original document, “Letter to
Parents.” Notice that the window’s title bar now says, “Letter
to Juan”.

The original document is set aside, unchanged (if you open it,
you'll find that the first line is still “Dear Mom and Dad”).

Save?—or Save As?

=
m
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Choosing Save stores the changes you've made to the active
document (the document in the active window) since you
opened it or since the last time you chose Save.

Choosing Save As, on the other hand, creates a new
document that includes the changes you've made. Save As
sets aside the original document without storing the changes
(in other words, the original document remains unchanged
from when you opened it or last chose Save).

After you give the new document a name, it replaces the
original document in the active window. The title bar of the
active window shows the name of the new document.
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Open a document while its program is
the active program

You can open a document without making the Finder the active
program and then opening its icon on the Macintosh desktop.

You can open a document while the program that you used to
create it remains the active program.

1. Close the document “Letter to Juan.”

Click the close box near the upper-left corner of the
document window or choose Close from the File menu.

TeachText remains the active program.

2. Choose Open from the File menu.

I tipse z;zl

The dialog box that appears lets you find the document you
want to open.
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3. Click “Letter to Parents.”

= Macintosh HD ¥

O Letter to Juan <

D Letter to Parents . = Macintosh HD

D Letter to Sister m

D Opening Lines

0 Read Me Desktop

0 System Folder
=

4. Click the Open button.

The “Letter to Parents” document window appears.

Organize icons in a folder

Sooner or later, in the course of your work, you'll have too many
documents and programs to keep track of easily. The Macintosh
offers numerous tools and techniques (all of them explained in
Macintosh Reference, Part 11 of this book) to help you organize
your work. Creating a folder and putting files in it is the simplest
way.



1. If “Letter to Parents” is open and TeachText is the active
program, choose Quit from the File menu.

The Finder becomes the active program.
2. If the Macintosh HD icon is not open, open it.
The Macintosh HD window should be the active window.

3. Choose New Folder from the File menu.

New Folder
Bopn

Print HE
Close Window W)

An icon named “untitled folder” appears in the Macintosh HD
window. The icon, including its name, is already selected.
(The name is highlighted and has a box around it.)

4. Type “Letters to Family”.

|Letters to Family|

Whatever you type replaces the selected text. If nothing
happens when you type, click the name so that a box appears
around it and then try again.

5. Drag the Letter to Parents icon to the new folder icon
until both icons are highlighted, then release the
mouse button.

s to F-:'slTIﬂ':l

Letter to Sister

- AP YA e =

Letter to Juan

6. Drag the Letter to Sister icon to the Letters to Family
folder icon until both icons are highlighted, then
release the mouse button.

The Letters to Family folder now contains Letter to Parents
and Letter to Sister. You can open the Letters to Family folder
icon if you want to make sure that they are there.
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’ - 6. Choose Make Alias from the File menu.
Use an alias
As you work, you may find it handy to have the same program or o
document stored in more than one folder, so you can open it

: e o . . New Folder 8N
quickly when you're in a particular folder.

Open 30
1. If the Macintosh HD icon is not open, open it. Print P
Close Window 3L
The Macintosh HD window should be the active window.
. Get Info 1
2. Choose New Folder from the File menu. Duplicate %D

Make Rlias
Pl Busny

An icon named “untitled folder” appears in the Macintosh HD
window. The icon, including its name, is already selected.
(The name is highlighted and has a box around it.)

An icon named “Letter to Sister alias” appears on top of the
Letter to Sister icon. The icon and its name are already
selected.

3. Type “October Letters”.

IDctober Letters”

Whatever you type replaces the selected text.

4. Open the Letters to Family folder icon.

5. Click the Letter to Sister icon to select . Note that the name of the alias appears in italics. The name of
an alias appears in italics so you have a way to tell which icons

% are aliases.

Letter to Sister
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What’s an alias?

An alias is a way to represent a program or document in any
folder without having to make a copy of the file. An alias
merely “points” to the original file that it represents, so when
you open an alias, you're actually opening the original file. Any
changes you make and save are stored with the original file,

s0 you see them when you open any of the aliases for the
original file (you can make as many aliases for a program or
document as you need).

(oL, (32]

Aliss Ierigin.ﬂ

2, [

Alizs Original

You could make copies of a program or document and put
them in separate folders, but the copies would take up much
more room on your disk than a single copy. And if you want
the copies to be always exactly alike, you'd have to make the
same changes to each copy if you make any changes to one
copy.

Using aliaSes instead of making copies of a program or
document lets you save space on your disks.

7. Drag the Letters to Family window to the right. You
should be able to see the October Letters folder in the
Macintosh HD window behind it.

8. Drag the Letter to Sister alias to the October Letters
folder in the Macintosh HD window, then release the
mouse button.

Macintosh HD I
EMl Letters to Family e
3 items 3.6 MB in disk 34.4 MB available
2
Letter to Parents
Letter to Juan s
&
=l R

You may have to change the size and position of the Letters to
Family window so you can see both icons.

9. Open the October Letters folder icon.
10. Open the Letter to Sister alias icon.

The document Letter to Sister opens, and TeachText becomes
the active program.

The insertion point (the blinking vertical line) should be at
the beginning of the document, to the left of D in “Dear”.

continues ¥
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11. Type “16 October 91” and press the Return key once.

16 October 91

[pear sis,

This letter is overdue, | know, but until | sat down to write, | had
no idea how long overdue it is. Time sure flies when you don’'t have
enough of it.

Julie and | are doing well. The dog is getting better all the time.
How are you all?

L]
i |

|

12. Choose Save from the File menu.

13. Choose Close from the File menu.

The Letter to Sister document closes, and TeachText remains

the active program.

You can open the original Letter to Sister icon (in the Letters

to Family folder) and see that it is now dated 16 October 91.

Letter to Sister is now available in both the Letters to Family

folder and the October Letters folder. By keeping the original
in one folder and an alias in the other folder, you have access

to the same letter from either folder.

14. Close all the windows on the desktop.
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Create stationery

In your work, you may find it convenient to have a document that
serves as the computer equivalent of stationery, like a memo pad
or “While You Were Out” form. Each time you need a sheet, you
take one from your endless supply of stationery and fill it in.

To practice creating stationery, create a document in TeachText
that works like a memo pad.

1. With TeachText the active program and no TeachText
window open, choose New from the File menu.

Open...
EE RN i
Sapa g

If TeachText is not the active program, open the TeachText
icon in the Macintosh HD window, or choose TeachText from
the Application menu.

An untitled TeachText window appears.



2. Type the following text:
DATE :
TOs
FROM: [Type your name here.]
RE:
3. Choose Save from the File menu.
The dialog box that appears lets you name the document and
decide where you want the computer to store it.
+ If Macintosh HD does not appear above the list, click
Macintosh HD above the Eject button. <
4. Type “Memo Pad”.
= Macintash 0
D Letfer {0 Juan i e
O Letters to Family m
0 October Letters
) Bpeaing Lines
0 Read Me
CiSystem:Eoldern SN | | B e
& Teachient
o
Save this document as: N
Memo Pad ] @® O

Because “Untitled” is selected when the dialog box appears,
all you have to do is start typing. Whatever you type replaces
the selected text.

Click Save.

The window is now titled “Memo Pad” and the document has
been stored on Macintosh HD.

Close the Memo Pad document.

To close the window, click the close box near the left end of
the title bar, or choose Close from the File menu.

The window closes, and TeachText remains the active
program.

Click the Macintosh HD icon, the Macintosh HD
window, or anywhere on the desktop.

The Finder becomes the active program, and the Macintosh
HD window becomes the active window. Among its contents is
the Memo Pad document icon.

Click the Memo Pad icon to select it.

continues W
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9. Choose Get Info from the File menu.

New Folder 3EN
Open 30
Print #EP
Close Window W

Get Info

Duplicate . 3#D
Make Rlias

The Info window that appears contains information on the
selected icon.

10. Click “Stationery pad” near the lower-right corner so
that an X appears in the checkbox.

EO0=== Memo Pad Info =]

Hema Pad

Kind: TeachText stationery pad
Size: 1K on disk (19 bytes used)

Where: Macintosh HD:

Created: Tue, Sep 3, 1991, 6:57 AM
Modified: Tue, Sep 3, 1991, 6:57 AM
Version: nat available

Comments :

[JLocked [ stationery pad
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11,

Clicking “Stationery pad” converts Memo Pad from an
ordinary document to a stationery pad. When you open a
stationery pad, an untitled window appears showing a blank
“form” from that stationery, or a dialog box appears asking
you to name the new document.

You cannot change the stationery pad itself unless you turn
it back into a regular document. You do this by opening the
stationery pad’s Info window and clicking “Stationery pad”

again to remove the X.

Close the Info window.

To close the window, click the close box near the left end of
the title bar, or choose Close Window from the File menu.

Note that the Memo Pad icon has changed from an ordinary
document icon to a stationery pad icon.




On your own: Fill out some stationery

Open the Memo Pad stationery pad icon and type a short memo.

Remember to click the I-beam pointer where you want your text
to appear before you start typing. Clicking in this way sets the
insertion point (the vertical blinking line).

Choose Save from the File menu, name your memo, click the
Save button, and choose Quit from the File menu.

Note that the Memo Pad stationery icon remains in the
Macintosh HD window. The icon for the memo you created
(an ordinary document icon) should also be in the window.

What next?

Go to Chapter 7, where you'll learn how to find out more about

your Macintosh. Or take a break.

Remember to turn off your Macintosh if you'll be away for more

than a few hours.
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Chapter 7

Learning More About
Your Macintosh

In this chapter

You'll learn how to

= use the Balloon Help system

m use Macintosh Reference, Part 11 of this book

You'll also learn about

m the contents of Macintosh Reference

It will take about 20 minutes to go through this chapter.

At the end of this chapter, you'll be ready to start learning the
programs that you intend to use on the Macintosh.

Before you begin
You should have already
= gone through Chapters 1 through 6

If you turned off the Macintosh at the end of Chapter 6, turn it
back on.
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Use Balloon Help

Balloon Help explains the function or significance of icons,
menus, commands, and other features on the Macintosh screen,
using balloons similar to those you see in comic strips. The
balloon points to the object it explains.

Many Macintosh programs have Balloon Help.

1. Point to the Help icon near the right end of the menu
bar.

2. Press to pull down the Help menu.

3. Drag to the Show Balloons command (the second item
in the Help menu) so that it is highlighted, then
release the mouse button.

About Balloon Help...

Finder Shortcuts

After you choose Show Balloons, balloons containing explanatory
text appear next to objects that you point to on screen.
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. To show a balloon describing the Wastebasket, point to

the Wastebasket icon.

Except for the fact that balloons appear next to objects that
you point to, the way you work is the same: you can select
icons, choose commands, and so on.

. Point to the Macintosh HD icon (your startup hard

disk).
A balloon appears next to the icon.
Click the Macintosh HD icon to select it.

You can select the icon even with the balloon showing.

. Point to the File menu.

A balloon appears next to the menu name.

. Press to pull down the File menu.

The balloon disappears when you pull down the menu.

Slowly drag to the Open command so that it is
highlighted, then release the mouse button.

Notice that a balloon appears next to a command if you pause
briefly as you drag past it.

The Macintosh HD window becomes the active window. To
see more balloons, you can point to different parts of the
window and to different icons in the window.



10. Choose Hide Balloons from the Help menu.

| S

About Balloon Help...

Hide Balloons

Finder Shortcuts

To choose Hide Balloons, point to the Help icon in the menu
bar, press to pull down the Help menu, drag to the Hide
Balloons command so that the command is highlighted, and
release the mouse button.

Hide Balloons and Show Balloons replace each other in the
Help menu (after you choose one, the other appears in its
place).

Use Maciniosh Reference

Macintosh Reference, Part 11 of this book, contains all the
information you need to use your computer effectively and
efficiently. Unlike Part I, which is meant to be read from beginning
to end, Part 1T is meant to be used like a dictionary: you turn to it
when you need to look up some information, and then you read
only that information.

To help you find the information, this book has a table of
contents, an index, a glossary, and a summary after Chapter 16
(on the green pages). To practice using the reference, look up a
few topics that you'll probably need to know about in the near
future.

1. Find “Cleaning the mouse” under Chapter 15 in the
table of contents.

2. Go to the page that you're referred to and read about
how to clean the mouse.

3. Use the index to find information on erasing floppy
disks.

Erasing a disk is the same as initializing. Initializing a new disk
is explained in Chapter 3 of this book.

Several index entries refer you to the information you need.
= You could look under “disks” and find “erasing.”
= You could look under “erasing” and find “disks.”

= You could look under “floppy disks” and find “erasing.”
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What'’s in Macintosh Reference

Part I of this book, Macintosh Reference, has almost no
information on using application programs. Your best source
of information about a particular program is the set of books
and disks that came with that program.

Macintosh Reference has detailed information on
= setting up your system software

= using hard disks and floppy disks

= organizing your files

= adapting your Macintosh to your own use

= printing

= using your Macintosh on a network

= expanding your computer system

= care and maintenance

= tips and troubleshooting

The setup book that came with your computer has

information on the features specific to your particular model.
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. Go to the pages that you're referred to and read about

erasing disks.
Some of the pages are about initializing disks.

Find “Glossary” in the table of contents.

. Look up “keyboard shortcuts” in the glossary.

Using keyboard shortcuts as a way of choosing commands is
explained in Chapter 5.



What next?

Congratulations. You've gone through the Macintosh Basics tour
and you're done with Learning Macintosh, Part I of this book.
You've been introduced to and practiced everything you need to
know to start using the Macintosh in a productive way.

There is more to learn before you're using your computer in the
most effective and most efficient ways—but you'll be learning
those ways as you use your programs and gain more experience
with the Macintosh.

At this point, you could
m  start learning how to use your Macintosh programs

= go to Chapter 11 to learn about ways to adapt your Macintosh
to your specific needs or preferences

= go to Chapter 13 to learn about using your Macintosh on a
network with printers and other computers

m take a break

To help you find information in this book, use the table of
contents; the index; the glossary; or the summary, “Working on
the Macintosh Desktop,” on the green pages after Chapter 16.

Chapter 7: Learning More About Your Macintosh 81

o=
<zl
>
=
Z
Z
(+p}







Macintosh Reference

Chapter 8

Chapter 9

Chapter 10
Chapter 11
Chapter 12
Chapter 13
Chapter 14
Chapter 15
Chapter 16

Summary

Setting Up Your Macintosh System

Hard Disks and Floppy Disks

Organizing Your Files

Adapting Your Macintosh to Your Own Use
Printing

Using Your Macintosh on a Network
Expanding Your Macintosh System

Care and Maintenance

Tips and Troubleshooting

Working on the Macintosh Desktop

How to use Part Il

Use this part of the book as you would a dictionary or

encyclopedia: Tirn to it when you need specific information,

and then read only those parts that give you that information—

S0 you can go on with your work.

Macintosh Reference contains little or no information on how to

use your application programs. If you need information on a

particular program, go to the books and disks that came with that

program.

If you're new to computers or new to the Macintosh, go through

the Macintosh Basics tour and Part I of this book, Learning
Macintosh, to learn basic Macintosh skills before you use

Macintosh Reference.

To help you find information in this book, use the index and the
table of contents. Also, use the summary, “Working on the
Macintosh Desktop,” on the green pages after Chapter 16 and
the glossary at the back of the book if you're looking for short

definitions or brief summaries of concepts and procedures.
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If you need information on setting up your Macintosh or any
information on features specific to your particular model, go to

the setup book that came with your computer.

Use this book in combination with the setup book, the books and
disks that came with your application programs, and Balloon Help
to find the information you need.




Chapter 8

Setting Up Your
Macintosh System

In this chapter

= Setting up your computer hardware
Arranging your office
Avoiding fatigue
Adjusting your keyboard
= Setting up your system software
Installing, reinstalling, or updating system software
Starting up with a floppy disk
= Setting up your programs
Installing a program

Working with several programs at a time

Setting up your computer hardware

For information on assembling the hardware components of
your computer system, go to the setup book that came with
your Macintosh.

If you're connecting your Macintosh to a printer, 2 modem, an
external floppy disk drive, an external hard disk drive, or other
external devices, go to the instructions that came with the device,
or see Chapter 14, “Expanding Your Macintosh System.”

If you're connecting your computer to another Macintosh or to a
printer on a network, see Chapter 13, “Using Your Macintosh on a
Network.”
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Arranging your office

Here are some guidelines for adjusting the furniture in your office
to accommodate your physical size and shape.

Adjust the chair so your thighs are horizontal, your feet flat on
the floor, and the backs of your knees slightly higher than the
seat of your chair. (If your chair is too high for your feet to rest
on the floor, use a footrest.)

Use a chair that supports your lower back.

When you use the computer keyboard, your shoulders should
be relaxed. Your upper arm and forearm should form a right
angle, with your wrist and hand in roughly a straight line.

Arrange the monitor so the top of the screen is at or slightly
below eye level when you're sitting at the keyboard.

Position the monitor to minimize glare and reflections on the
screen from overhead lights and windows.

Clean your screen regularly.

A variety of accessories, including document holders, keyboard
trays, and monitor stands, may enhance your comfort while using
the computer.
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Avoiding fatigue

These tips should help you get the most out of your work
sessions with the computer.

Regularly change your seated position, stand up, or stretch
whenever you start to feel tired. Research indicates that
frequent “micro-breaks” are helpful in reducing fatigue and
discomfort.

Use a soft touch on the keyboard and keep your hands and
fingers relaxed. Some computer users may develop
discomfort in their hands, wrists, or arms if they do intensive
work without breaks. If you begin to develop chronic pain and
discomfort in your hands, wrists, or arms, consult your
physician.

Keep two fingers (the index and middle fingers) resting lightly
on the mouse button when you use the mouse.

Occasionally rest your eyes. From time to time focus your eyes
on a distant object. Blink often while you work.



Adjusting your keyboard

If you bought the Apple Extended Keyboard II with your
Macintosh, or if your Macintosh Classic or Macintosh LC came
with its standard keyboard, you can adjust the angle of the
keyboard so that your hands and wrists are relaxed and you're
comfortable as you type.

The Macintosh Classic or Macintosh LC standard keyboard has
tabs on either side that swing out under the keyboard, changing
the angle of the keyboard on your desk.

The Apple Extended Keyboard II has a sliding tab in the back that
controls how much a bar extends under the keyboard, changing
the angle of the keyboard on your desk.

Apple Extended Keyboard 11

A bar extends
as the slide is moved,
increasing the
keyboard angle.
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Setting up your system software

Your Macintosh cannot operate without system software—the
programs and other files that the Macintosh needs to start itself
up and to run the application programs you use. When you turn
on your Macintosh, it looks for a disk that contains the system
software (in a folder called the System Folder). Any disk that
contains the system software is a startup disk.

Almost always, the startup disk is a hard disk that’s inside or
connected to your computer. A floppy disk can also be a startup
disk.

If your Macintosh cannot find a startup disk, it displays this icon in
the middle of the screen:

If you see this icon, you have to install system software on your
computer’s internal hard disk (or an external hard disk that you
turned on before you turned on your Macintosh).

< Ifyowve already installed system software and you see this
icon, you may need to reinstall system software. See “Starting
Up With a Floppy Disk” later in this chapter. «
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Installing, reinstalling, or updating system software

You use the Installer program to install, reinstall, or update system
software on a hard disk that you want to be able to use as a
startup disk.

2\ Important: Before you install a new version of system
software, make a backup copy of the old version on another
disk in case you need it at a later time (to run a program that
is incompatible with the new version, for example).

When you use the Installer to update your system software, you
keep any fonts, sounds, drivers, and other files you may have
installed in addition to standard system software. (You could
throw away your current System Folder and replace it with the
newer one, but then you'd lose those special files.)

Before you begin
To install, reinstall, or update system software, you need
= an initialized hard disk

m the set of Macintosh system software disks that came with
your computer or that you purchased as a separate system
software kit. The Installer program is on the disk named
Install 1.



If your Macintosh is connected to a network and you have access
to the Installer program and system software on a file server or
another computer, you don’t need the system software disks. You
can open the Installer program and then follow the procedure
below, beginning with step 4.

If you have a hard disk that hasn’t been initialized (that s, its
icon doesn’t even appear on the Macintosh desktop), go to
Chapter 9, “Hard Disks and Floppy Disks,” for instructions on
initializing a hard disk.

A Warning: If you purchased a hard disk with the A/UX
operating system installed on it, do not initialize that disk;
doing so will erase A/UX. See the instructions that came with
the A/UX operating system. A

Installing a standard system

The Installer program’s Easy Install dialog box lets you install the
standard system software on your Macintosh.

1. Turn off your Macintosh.

2. Insert the Install 1 disk into the internal floppy disk
drive.

If your Macintosh has two floppy disk drives, you can use
either one.

3. Turn on your Macintosh.

The Easy Install dialog box appears.

The Installer program opens automatically.

4. Click OK or press the Return key on your keyboard.

Button to switch

Parts of the system to a different disk
software to be installed for installation =
<o
=y
i
Easy Install :
Click Install to update to Uersion 7.0 of %
[« Macintosh 11 system sortware e
® Ainy Existing Printing Software -
|__- File Sharing Software @
on the hard disk named
o Hard disk #2

Disk on which system
software will be installed

Button to change to a
customized installation

continues P
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Make sure that the hard disk indicated in the box is
the one you want to install system software on. If a
different disk name appears, click the Switch Disk
button until the correct disk name appears.

Click Install or press the Return key on your keyboard.

The Installer begins to install system software for your
Macintosh model.

Follow the instructions that appear on screen.

When a disk is ejected and you see a message instructing
you to insert another system software disk, insert the disk
specified.

When you see a message reporting that the installation
was successful, click Quit or press the Return key to
quit the Installer program.

If a message reports that installation was not successful, follow
the instructions on screen to try installing again.

Click Restart in the dialog box that appears when you
quit the Installer.

The Macintosh restarts using the newly installed system (or
using your current startup disk if you already have one). If you
want to change your startup disk, see “Designating a Hard
Disk as the Startup Disk” in Chapter 9, “Hard Disks and
Floppy Disks.”

Chapter 8: Setting Up Your Macintosh System

Installing a customized system

Custom installation allows you to select the combination of
system files, drivers, and other files you want for your own specific
needs. You can also use custom installation to install or update a
single system software component or to save space on your
startup disk by not installing files that you don’t need.

1
2

Turn off your Macintosh.

Insert the Install 1 disk into the internal floppy disk
drive.

If your Macintosh has two floppy disk drives, you can use
either one.

Turn on your Macintosh.

The Installer program opens automatically.

Click OK or press the Return key on your keyboard.
The Easy Install dialog box appears.

Make sure that the hard disk indicated in the box is
the one you want to install system software on. If a
different disk name appears, click the Switch Disk
button until the correct disk name appears.

Click the Customize button.

The custom installation box appears. All parts of the system
software are listed, and you have a choice of standard or
minimal system software for each model of the Macintosh
computer.



7. Scroll through the list of items and hold down the 9. Follow the instructions that appear on screen.
Shift key as you click the items you want to install. X T , .
When a disk is ejected and you see a message instructing
you to insert another system software disk, insert the disk
Click the items you want to select; speciﬁed.
Shift-click to select multiple items.
Software for Imagelriter LQ 10. When you see a message reporting that the installation
i B TS ) H was successful, click Quit or press the Return key to
AppleShare (workstation software) H
DS aa Sa quit the Installer program.
EtherTalk software = Walthrop : ) =
TokenTalk software Ifa message reports that installation was not successful, follow [
Eject Bisk ] F 3 L g . <o)
_ EtherTalk software the instructions on screen to try installing again. =
ed i . _ . =
s e e 11. Click Restart in the dialog box that appears when you o
|S. ackade contains software needed to use your . <o)
LSS h e I e okl quit the Installer.
(uit ] .
Make a backup copy of the System Folder or its contents on one
or more floppy disks (or on another hard disk), and keep the
Information about the item selected disks in a safe place.
; “ If your Macintosh is running System 6, you cannot use desk
+ Ifyou want to install a small system to conserve space on /) ¥ §2) L Y .
; ; ; ; R H metbe & accessories and Tru€elype fonts supplied with System 7. Also,
your startup disk, click the “Minimal software” option. < ; - .
you may notice extra or missing folders on any disk that
: contains System 7. The contents of the System 7 disk will
2\ Important: Be sure to install the system software files that ) ’ ,
s . . . appear normally when you resume running System 7. <
your Macintosh uses to communicate with the printers and
any other devices you use. A ; ,
’ Y A Warning: Your startup disk must have only one System
: Folder. Having more than one System Folder on your startup
8. Click Install or press the Return key on your keyboard. ; & ; Y . ’ :
disk can cause your Macintosh to malfunction and cause you
The Installer begins to install system software for your to lose information. Use the Find command (in the Finder’s
Macintosh model. File menu) to see if there is more than one System Folder on
your hard disk. A
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Starting up with a floppy disk

You need a hard disk as the startup disk to use Macintosh system
software version 7, but if you're unable to use your hard disk, you
can start up your Macintosh by inserting the Disk Tools disk in

the internal floppy disk drive and then turning on your computer.
This disk contains programs that you can use to initialize, test, and
repair disks.

If your startup hard disk has malfunctioned, see “Testing and
Repairing Disks” in Chapter 9, “Hard Disks and Floppy Disks.”

Setting up your programs

In addition to setup information, this section describes how to
work with more than one program at a time.

Installing a program

You can install many application programs simply by copying
them from the original disk to your hard disk. (Some programs
have specific installation procedures. See the instructions that
came with your program.)

2\ Important: Some program disks contain a System Folder.
Whenever you copy the contents of a program disk to your
startup hard disk, check that you have not copied an extra
System Folder. If you have, throw away the extra System
Folder.
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Put only one copy of each program on your hard disk. Having
more than one copy of the same program on the disk can lead to
problems when you're running the program.

If you want to open a program automatically when you start up
your Macintosh, go to “Specifying Which Items You Want Opened
at Startup” in Chapter 11, “Adapting Your Macintosh to Your Own
Use” for instructions.

You can also put a program or an alias for it in the Apple menu, so
you can open the program more conveniently. See “Installing an
Item in the Apple Menu” in Chapter 11.

_\ Important: Keep the original program disk in a safe place as
a backup copy. If the program on your hard disk malfunctions
consistently, you can replace it with a fresh copy from your
backup disk.

If a program malfunctions consistently, and installing a fresh copy
of the program does not correct the problem, you may need to
find out from the software manufacturer whether the version of
the program you have is compatible with the Macintosh system
software you're using. (You can often upgrade to the latest
version of a program at no charge or for a modest fee.)



Checking for computer viruses

In recent years, “viruses"—malicious programs that damage files
or erase disks—have become a significant problem for people
who use computers. A virus can be introduced into your
Macintosh system from a disk you or someone else puts in a disk
drive, from a network device such as a file server, or from an
electronic bulletin board service.

You can use any of several virus-detection and -elimination
programs to check your Macintosh disks for viruses. Such
programs are available from user groups, computer bulletin
boards, and dealers.

Even if you don't notice problems with your computer’s operation
or with the information on your disks, you should check for
viruses frequently if you exchange disks or information with other
users.

m  Whenever you get a disk from anyone—even if it’s commercial
software—check it for viruses before using it or copying
anything from it to your hard disk.

m  Check your startup disk and other disks regularly with a virus-
detection program and correct any problems it finds.

If your Macintosh is on a network or you use a modem to
connect with information services or bulletin boards, check
for viruses as often as it’s practical—ideally, each time you
copy any information from an outside source.

If you are part of a work group that includes a number of
Macintosh users, set up a “virus-detection station” that
everyone can use to check disks (and to copy the latest
version of the virus-detection software your group uses).

If you give information to other Macintosh users on disks or
send information electronically, make certain that there are

no viruses on your computer system before distributing the
information.

Since new viruses appear regularly, make sure you have the
latest version of any virus-detection software.

To avoid compatibility problems, be sure to use only one
virus-detection program at a time.
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Working with several programs at a time

You can keep as many programs and desk accessories open at the
same time as your computer’s memory allows.

All open programs are listed in the Application menu, which
appears at the right end of the menu bar. The active program’s
name has a checkmark next to it, and its icon appears in the menu
bar as the Application menu icon.

The Finder icon

Hide Finder
Hide Others
i fi

v [E Finder ;]
t

<% TeachTex

Commands used to hide or
display windows currently open

Open programs

Checkmark indicates the
program currently in use.
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Switching programs

You switch between open programs or desk accessories by
choosing their names from the Application menu in the right end
of the menu bar.

If a program’s icon is dimmed in the menu, that means its
windows are hidden. You can choose it from the Application
menu to display its windows.

You can also click in a window that “belongs” to an open program,
or double-click a program icon (or the icon of a document that
was created in the program) to make that program the active
program.

Finding out what programs are open

If you have several programs and windows open, you can find out
which program is active and what other programs are open by
pulling down the Application menu.



Hiding and showing windows on the desktop Changing the amount of memory a program uses

You can hide all the open windows except those of the active On rare occasions you may need to increase or decrease the
program by choosing the Hide Others command in the amount of memory a program sets aside for itself. You might want
Application menu. Though hidden, the other windows remain to increase the program’s memory allocation so that you can
available. open more documents at once, or you might want to decrease it

so that you can open more programs. You can do this by adjusting

When the command takes effect, all windows except those , L :
the program’s memory size in its Info window.

belonging to the active program are hidden.
1. Quit the program if it’s open, then click the program’s

The windows remain hidden until you switch to another open . p
icon to select it.

program, at which time that program’s open windows are
displayed. If you want to see the windows of all your open 2. Choose Get Info from the File menu.
programs, choose Show All from the Application menu.
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The Info window appears.

ECJ==== TeachText Info =i

TeachText
System Software v7.0

Kind : application program
Size: 36K on disk (36,612 bytes used)

Where: Walthrop ‘TeachText

Created:Tue, Jul 17, 1991, 12:00 PM
Modified: Tue. Jul 17, 1991, 12:00 PM
Yersion: 7.0, © Apple Computer, Inc.
1985-91
Comments :

(~Memory - -
i Suggested size: |

[ Locked ELr.urmt size:

| Program manufacturer’s suggested
minimum memory

Current memory allocation

continues P
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3. Drag across the number in the box labeled “Current
size” to select it.

4. Type the number of kilobytes (K) of memory you want
the program to set aside for itself.

Making the program smaller than the amount shown in the
box labeled “Suggested size” may cause it to work more slowly
or cause other problems.

5. Close the Info window.

If you make the allocation too small, you'll see a message
asking whether you want to make it smaller than the
manufacturer’s suggested minimum size.

A Warning: Ifyou set the memory allocation for a program
to a size that’s smaller than the manufacturer’s suggested
minimum size, the program may function improperly or
notatall. A
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Chapter 9

Hard Disks and
Floppy Disks

In this chapter
» Initializing disks
m  FErasing a disk
m  Designating a hard disk as the startup disk
= Protecting the information on a disk
Locking a floppy disk
Locking a file
Backing up your files
= Ifyou can't save files on a floppy disk
= Ejecting a disk
= Disk care
Hard disk precautions
= Testing and repairing disks
Using Disk First Aid
Testing a hard disk

Initializing disks

Before you can use a new disk, you need to initialize it—to
prepare it so that the computer knows where to store and retrieve
information on the disk.

A Warning: You lose any information you may have on a disk
when you initialize or reinitialize it. A

Most hard disks designed for use with the Macintosh are already
initialized (that is, ready to store information) when they leave the
factory. When new, the 3.5-inch (89-millimeter) floppy disks that
your Macintosh uses need to be intialized.
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Initializing a hard disk

If you have a hard disk that hasn’t been initialized, its icon does
not appear on screen when you start up your Macintosh using
another hard disk or a floppy disk as a startup disk. (See
Chapter 14, “Expanding Your Macintosh System,” if you need
instructions on connecting a hard disk to your computer. See
Chapter 8, “Setting Up Your Macintosh System,” if you need to
create a startup disk.) Make sure that you turn on the hard disk
before you turn on your Macintosh.

If your hard disk’s icon does not appear on screen, use the
Apple HD SC Setup program, on the system software floppy
disk labeled Disk Tools, to initialize and name the disk.

A Warning: If you purchased a hard disk with the A/UX
operating system installed on it, do not initialize that disk;
doing so will erase A/UX. See the instructions that came with
the A/UX operating system. A
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1. Locate the Apple HD SC Setup icon and open it.

Apple HD SC Setup is on the system software floppy disk
labeled Disk Tools. If you're already using a hard disk as a
startup disk, you can copy the program to your startup disk
and open the program from there.

ey
2

Apple HD SC Setup

A dialog box appears. The name of the hard disk currently
selected for initialization is shown as the “volume name.” The
SCSIID number of the selected hard disk is displayed above
the Drive button. (The ID number of an internal hard disk

is 0. The ID number of an external hard disk is usually preset
to5.)

Apple HD SC Setup
i scsi Device: 0 —f—— SCSIID number
(Cupdate ] of the current
‘ hard disk
|
(ot ) |
The volume name is Hard disk ——— The name of the
#2 current hard disk




. If the “volume name” or the SCSI ID number shown

does not belong to the hard disk you want to initialize,
click the Drive button until the hard disk you want to
initialize is the selected hard disk.

You cannot initialize your current startup disk or the disk that
the Apple HD SC Setup program is on.

. When the SCSI ID number (and name, if any) of the
hard disk you want to initialize is shown, click the
Initialize button.

A dialog box appears in which you must confirm or cancel
your decision.

. Click the Init button to initialize the hard disk.

Messages appear to update you on the initialization process. If
a message reports that initialization failed, begin the process
again.

. In the dialog box that appears asking you to name the
disk, type a name and then click OK.

. Click Quit when the message reports that initialization
was successful.

Initializing a floppy disk

Before you can use a new floppy disk, you need to initialize
it—prepare it so that the computer knows where to store and
retrieve information on the disk.

1. Insert your new floppy disk into the floppy disk drive.

Ifyou inserted a high-density disk, this dialog box appears:

This disk is unreadable:
Do you want to initialize it?
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If you inserted a double-sided (800K) disk, this dialog box
appears:

This disk is unreadable:
Do you want to initialize it?

[ Eject ]| [one-sided] [Two-sided)

continues W
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2. Depending on which dialog box appears, click
Initialize or Two-Sided.

Another dialog box appears:

This process will erase all
information on this disk.

This dialog box gives you one last chance to cancel. It alerts
you that you're about to erase—and therefore lose—any
information that may be on the floppy disk.

3. Click Erase.

A third dialog box appears:

Please name this disk:
Untitled
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} 4. 'Type the name you want for the disk.

If you make any typing errors, press the Delete key to
backspace over them.

When you name a disk, you can type up to 27 characters,
including spaces. You cannot use a colon in the name. If you
don’t name the disk, it will have the name “Untitled.”

Click OK or press the Return key on the keyboard.

The computer takes about a minute to initialize the disk. A
series of messages appears on the screen to let you know how
the process is going.

When initialization is completed, the floppy disk’s icon
appears on the desktop. You can rename the disk by clicking
its name and typing a new one.



Erasing a disk

Erasing a disk actually initializes it.

A Warning: You lose any information you may have on a disk
when you erase it. A

1. Click the icon of the disk you want to erase.

2. Choose Erase Disk from the Special menu.

A dialog box appears, giving you a chance to cancel the
procedure.

3. Depending on the type of disk you're erasing, click
Initialize or Two-Sided.

Designating a hard disk
as the startup disk

If you use more than one startup disk with your Macintosh, you
can specify which hard disk you want used as the startup disk the
next time you turn on your computer.

1. Choose Control Panels from the Apple menu and then
open the Startup Disk control panel.

[EO== startup bisk

m

Select a Startup Disk:

ressa] (Ean)
YWalthrop

2. Click the icon of the disk you want to use as the

startup disk.

continues W
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3. Close the Startup Disk control panel.

When you turn on your Macintosh, it looks for a startup disk (a
disk containing a System Folder) in the following sequence:

1. internal floppy disk drive
2. second internal floppy drive (if any)
3. external floppy drive (if any)

4. startup device selected in the Startup Disk control panel (if
any)

5. internal SCSI hard disk (the computer waits a few seconds for
the internal hard disk to warm up)

6. external SCSI hard disk (if there is more than one, it looks for
the hard disk with the greatest SCSI ID number)

7. internal hard disk (the computer returns to this drive and
waits another few seconds)
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If no startup disk is found, the computer displays a blinking
question mark in the middle of the screen.

< If you want to bypass the internal hard disk as a startup disk,
press 3-Option-Shift when the computer starts up. «

A\ Important: If you use any external hard disks, turn them on
and wait a few seconds before you turn on your Macintosh;
otherwise, the computer will not recognize them. A

Protecting the information on a disk

You can protect all the information on a floppy disk and you can
lock individual documents and application programs. Another way
to protect your work is to keep backup copies of all your files.

The information in a locked document or on a locked disk can’t
be changed or thrown away, but it can be opened or copied.



Locking a floppy disk Locking a file

To lock a floppy disk: You use the Get Info command to lock a document or program.
= Slide the tab on the back side of the disk so that the Liseiing 2 program Mg A KeaLitsppEraion.

square hole is open. 1. Click the icon of the file you want to lock.

Use your thumbnail to move the tab, or a push pin inserted 2. Choose Get Info from the File menu.

into the notch next to the tab.

The file’s Info window appears.

3. Click the Locked box in the lower-left corner so that
an X appears in the box.
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EJ==== from nmg Info %’
Fromdry

Kind : TeachText docurnent
Size: 1K on disk (161 bytes used)

Where: J’s disk: From Amy

Created:Mon, Oct 8, 1991, 10:33 PM
Modified:Mon, Oct 8, 1991, 10:35 PM
Yersion: not available

Comments :

Locked Unlocked

m Locked [] stationery pad

Sliding the tab back so that it covers the square hole unlocks
the disk.

continues P
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4. Close the Info window.

<« Locking folders: You can’t lock a folder, but you can lock the
items in a folder. Also, you can protect the contents of folders
that you're sharing on a network. (See Chapter 13, “Using
Your Macintosh on a Network,” for more information.) <

« Locking an alias: You can lock an alias, but doing so does not
lock the original file. Locking an alias merely protects it from
being thrown away. «

Backing up your files

You can hack up the work you store on a hard disk by copying
individual files onto another disk in the usual way (dragging their
icons to the icon of the other disk). You can back up the contents
of an entire floppy disk by dragging its icon to another floppy disk
icon or a hard disk icon.

You can also use a commercial backup program to copy some or
all files from a hard disk to another hard disk, to a tape drive, or to
a series of floppy disks.
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If you can't save files on a floppy disk

If you can’t save files on a floppy disk, then the disk is damaged or
locked, it’s too full to store more information, or the disk drive is
not working properly.

m  Make sure the locking tab on the back of the disk is in the
unlocked position (so that the square hole is closed).

m Ifyou see a message reporting that the disk is not initialized,
and you know that it has been initialized, eject the disk and
carefully insert it again. If the same message appears, the disk
is probably damaged. (You may be able to recover the
information on it with Disk First Aid or a disk-recovery
program; see “Testing and Repairing Disks” later in this
chapter.)

= Ifyou see a message reporting that the disk is full, eject that
disk and insert another that has adequate space for your
document, or erase unneeded files from the disk.

m  Check the disk for obvious damage to the plastic case or the
sliding metal shutter.

w Insert a different disk and try saving again. If you can’t save on
the second disk, the problem may be with the disk drive.

= Before concluding that the disk drive is the problem, save
your files on a disk in a different drive, if you have one, and
then restart the Macintosh. Try using a disk that you know is
not damaged in the suspect drive. See your service provider if
you still can’t save any files using that drive.



Fiectin isk 2. If step 1 doesn’t work, turn off the Macintosh. If the
) L d 5 disk isn’t ejected, then hold down the mouse button

You can eject a floppy disk by doing one of the following: when you turn the computer on again.
m  Click the disk icon to select it and choose Put Away from the 3. If step 2 doesn’t work, locate the small hole to the
File menu. The icon disappears from the desktop. right of the disk drive’s opening, and carefully insert

the end of a large straightened paper clip into it. Push
gently until the disk is ejected. Do not use excessive
force.

= Drag the disk icon to the Wastebasket icon. The disk icon
disappears from the desktop. (Dragging a disk to the
Wastebasket does not erase the disk’s contents.)

m  Click the disk icon to select it and choose Eject Disk from the
Special menu. The disk’s icon remains on the desktop, but it’s
dimmed.
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Paper clip

You can use the first two methods to remove a hard disk icon
from the Macintosh desktop (or to remove an icon for a disk that
you're connected to over a network).

All three methods also work with CD-ROM discs.

If you can’t eject a floppy disk

The signal to eject the disk is not reaching the computer or the

disk or drive is damaged. 4. If step 3 doesn’t work, take the computer or disk drive

to your authorized Apple service provider to have the
1. Hold down the 3 and Shift keys and press the disk removed.

number 1 key in the top row of the keyboard to eject
a disk in the internal drive; press 38-Shift and the
number 2 to eject a disk in an external floppy drive
or the second internal drive.
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Disk care

For information on floppy disk care, see Chapter 3, “Setting Up
Your Programs,” or read the instructions that came with your
floppy disks.

Hard disk precautions

Hard disk drives are very delicate mechanisms and should be
handled with care.

= Do not roughly handle a hard disk or a computer with an

internal hard disk. Never move either when it’s turned on and

the hard disk drive is operating.

= Do not place your Macintosh on its side unless it is designed

to operate this way; it could damage the hard disk. See your
setup book to check if your Macintosh model can be placed
on its side.

= Always keep the hard disk on a sturdy, level surface.

= Operate a hard disk at temperatures between 10 and
40 degrees Celsius (50 and 104 degrees Fahrenheit) and at
a relative humidity of 20 to 80 percent.

= Do not spill any liquids on or near the drive.

= Do not expose the drive to hazardous vapors, such as those
from cleaning solvents.
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Testing and repairing disks

Both floppy disks and hard disks can become damaged from
repeated use and handling. If you see a message reporting that a
disk is damaged or unreadable, Disk First Aid or Apple HD SC
Setup (both programs are supplied with the system software) may
help diagnose and correct the problem.

If you can’t start up from a hard disk or don’t see its icon on the
desktop, the computer does not recognize the disk or the disk
drive is not working properly.

s If the hard disk drive is an external one, make sure it is turned
on and its cable is connected firmly, then restart the
Macintosh.

w If the disk drive is an internal one, turn off the Macintosh, wait
at least 10 seconds, then turn it on again.

= If the hard disk is your startup disk, start up with a different
disk and, if the disk’s icon appears, reinstall the system
software on the hard disk.

= Ifyou have more than one hard disk in your Macintosh
system, check the SCSI ID number of each external hard disk
and all other SCSI devices connected to your computer. If two
devices have the same ID number; or if any external device
has the ID number 7 or 0, the computer will not recognize
one of the devices.



Using Disk First Aid 4. Choose Repair Automatically from the Options menu,

) . . or click the Start button to begin testing the disk.
You can test floppy disks and hard disks with the Disk First Aid

application. Disk First Aid also repairs some types of disk damage.

% File Edit JI[LE
Repair Automatically
Erase Disk...
UVolume: Archives

1. Locate and open the Disk First Aid icon.

Ready to s{

Disk First Aid is on the system software disk labeled

Disk Tools.

=
<2!
=
lozgi 5. When testing and repair are completed, choose Quit =
Disk First &id from the File menu. =
. . . <]

< Ifyou want to test another disk, choose Close from the File

A dialog box appears. menu, then select and open the other disk (as in step 2). «

2. Click the Drive or Eject button as necessary until the If Disk First Aid doesn't correct the problem:

name of the disk you want to test appears. You may

s - = Use Disk First Aid one or two more times with the disk.
have to insert the damaged floppy disk.

Occasionally, repeating this process corrects the problem.

3. Click Open or press the Return key. = Use another disk repair or recovery utility. Some disk repair

The name of the disk you selected appears, and a message utilities let you recover information from a damaged disk.

reports that Disk First Aid is ready. = Consult a technician or other specialist for help.

= Once you have recovered all the information you can, erase
(reinitialize) the disk. If reinitializing doesn’t work, discard the
damaged disk.
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Testing a hard disk

You can test a SCSI hard disk with the Apple HD SC Setup
program.

1. Locate and open the Apple HD SC Setup icon.

Apple HD SC Setup is on the system software disk labeled
Disk Tools.

e

dpple HD SC Setup

A dialog box appears.

Apple HD SC Setup

Update

Test

i

Quit

=~y The volume name is Hard disk |l The disk’s name
#2

B
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SCSI Device: 0 The disk’s SCSI ID number

. Click the Drive button until the name of the disk you

want to test appears as the “volume name.”

. Click Test.

A dialog box appears asking you to confirm that you want to
test the disk.

. Click OK.
. When a dialog box appears telling you that testing is

complete, click Quit.

If the test reveals a problem, you may be able to correct it by
using Disk First Aid or another disk repair utility, or you may
have to reinitialize the disk. Consult a technician or other
specialist for assistance if necessary.



Chapter 10

Organizing Your Files

In this chapter
m  Straightening up your files

m  Using folders to organize your files
Creating and naming folders

= Saving your files where you want to

m  Making items easier to find
Using an alias
Installing an item in the Apple menu
Moving an item to the desktop

= Finding a file or a folder
Finding an item by name
Finding an item by other characteristics
Finding items through a two-stage search
Uses of the Find command

m Creating a template

= Getting information about your files
Using the Info window
Using the View menu

Straightening up your files

Choose the Clean Up command from the Special menu to
straighten up the icons in the active window or on the desktop.
(The form of the Clean Up command changes depending on
which items are active or selected.)

Hold down the Option key while choosing Clean Up Window to

arrange icons alphabetically by name or according to the list view
displayed most recently in that window. Holding down the Option

key also moves the icons to the top left portion of the window.

Hold down the Option key while choosing Clean Up Desktop to

line up icons near the right edge of the screen.

If one or more items are selected, holding down the Shift key
while choosing the Clean Up command rearranges the selected
items only.
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Using folders to organize your files

Like paper filing systems, the Macintosh uses folders to store and
organize documents. You can place one folder inside another to
create a hierarchy of files that has many levels.

Budgets

0000 ec0000000
°
°

Fcusnb_lll[y sums Iss.ucs
studies list
Comments Draft 1 Draft 2 Draft 3
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Creating and naming folders

Most programs let you create and name a new folder in the
directory dialog box that appears when you first save a document,
or when you choose Save As from the File menu to save another
version of a document.

When you're working on the desktop (when the Finder is the
active program), you create and name a new folder as follows.

1. With the Finder the active program, choose New Folder
from the File menu.

A new folder named “untitled folder” appears in the active
window (or on the desktop if no window is active). The name
is already selected.

2. Type a name for the folder and press Return.

You move, copy, and remove folders in the same way that you do
any other icons. (See the summary, “Working on the Macintosh
Desktop,” on the green pages after Chapter 16, for instructions.)



Saving your files where you want to

The first time you save a document that you're creating in an
application program (or whenever you choose Save As from the
File menu to create another version of a document), a directory
dialog box appears. A directory is the list of files and folders

contained in a folder or a

disk.

You use the directory dialog box to name your document and
decide where to store it. Directory dialog boxes vary slightly from
program to program, but every directory dialog box has certain

features.

The current directory:
a list of the files and
folders in the folder
or disk that’s named
in the pop-up menu

Use this pop-up

above the directory ~ dir

The name

= Macintosh HD ¥ l

DY finnual yeport 91
3 App. programs
O] art farm

C] art samples

] Belsy 87277940
o] Baok st

Sqve this document as:

menu to choose  of the
a higher-level current
ectory. disk
l Click to list the
< Macintosh HD disks on the
I Macintosh desktop
in the current

L directory.
| Click to create a

....... - new folder.

When you open

a folder, its contents
are listed in the
current directory.

Type the name
of the document
here.

Click Save when you have
named the document and the
directory you want to put it in
is the current directory.

A similar dialog box appears when you choose Open from the File
menu to open a document that was created in the program you're
currently in (the “active” program). The dialog box lets you find

the document and open it.

1 App. programs 8
0O art-10/4

O Car info

[ Caspar maps

O Envelopes

0O Glossary

0 JH Status reports
[ Matching Devel.
[ old backups

0O Paint pics

D Picture 0

[<t] = wWwaithrop

fiect
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Making items easier to find

Your Macintosh offers several ways to make a file, folder, or other
item easy to find and open. You can

m  create aliases for the item and put the aliases wherever it’s
convenient for you

= install the item in the Apple menu

= move the item to the Macintosh desktop so that it’s in
plain sight

Using an alias

An alias serves as a signpost to a file, a folder, a disk, or another
item (even a shared item that you access over a network). You can
make as many aliases for an item as you want. See Chapter 6,
“Organizing Your Work,” for more information on aliases.

Creating an alias

1. Click to select the item that you want to make an
alias for.

2. Choose Make Alias from the File menu.

The alias appears on top of the original. Its name is in italics
and ends with ‘alias” The name is already selected.

3. If you wish, change the name of the alias, then move it
to wherever you want to put it.
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Uses of aliases

Alias of Location Purpose

Any document or Every part of your  Access to key information
folder that could be filing system where  from several places
stored in several that item logically

places fits

Apple Menu
Items folder

On the desktop Easy way to put items into or
take items out of the Apple

menu

A program that
must be located
with associated files

On the desktop; in
the Apple menu

Starting the program without
opening the folder or disk in
which the original and its
associated files are located

Adocument or folder  Anywhere on your
stored on a separate primary disk or
archive disk disks

When opened, the alias
displays a message with the
name of the disk needed, then
opens the original when the
disk is inserted.

A program, document,  Anywhere on your
or folder on a file primary disk or
server disks

When opened, the alias
automatically finds and
opens its original on the
server, essentially creating an
automatic server connection.

<« Trouble? 1f you open an alias and nothing happens, or you see
a message reporting that the original file isn’t available, then
the alias is damaged or the original has been deleted. Open
the alias’s Info window to find out where its original is. «



Locating the original of an alias

You can locate the original of an alias by opening the alias’s Info
window.

1. Select the icon of the alias whose original you want
to find.

2. Choose Get Info from the File menu.

The alias’s Info window appears.

[ECIE== Jn memos alias Info =

I:_] JH memos atiss

Kind: alias
Size: 1K on disk (521 bytes used)

Where: SE backup *2: choozerz atin: —— Location of the original—includes
folder levels and disk name (if the

SRR L s L original is on a different disk)

Original: SE backup ®2:chooser2

Comments :

[CJrocked Find ﬂrlginél '

3. Click the Find Original button.

The window containing the original item opens, with the
item’s icon highlighted.

If you deleted the original, you'll see a message reporting that
the original can’t be found. Aliases are not deleted when the
original files are deleted.

Installing an item in the Apple menu

You can install a file or other item in the Apple menu so you can
open it by choosing it from the menu.

1. Open the System Folder icon and locate the Apple
Menu Items folder.

2. Locate the item you want to install in the Apple menu
and drag it (or its alias) into the Apple Menu Items
folder inside the System Folder.

The item appears immediately in the Apple menu.

You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging its icon (or its alias) out of the
folder.

<+ Trouble? If the Apple menu does not contain the items it
should, make sure that the Apple Menu Items folder is in the
System Folder of your startup disk. Also, open the Apple
Menu Items folder to check that all the items that you want in
the menu are in the folder. «

Chapter 10: Organizing Your Files 113

=
<2]
rry
<o ]
=
<2]
2
(@)
<]




Moving an item to the desktop

You can make an item easy to find by dragging its icon to the
desktop. The icon stays there until you remove the disk on which
the item is actually stored.

If you've placed an icon on the desktop, you can put it back in its
original location by using the Put Away command.

1. Click to select the item you want to put back in its
original location.

2. Choose Put Away from the File menu.

Finding a file or a folder

When the Finder is the active program, you can use the Find
command in the File menu to find a file or folder on any disk
whose icon is on the desktop. (The Find command cannot locate
items inside the System file, such as fonts and sounds. You must
open the System file to see its contents.)
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Finding an item by name
1. Choose Find from the File menu, or press &-F.

The dialog box that appears lets you find a file or a folder by
searching for its name.

— You type the name (or partial
Find: | H— name) you want to find here.

(cancer ) [ Fina I Clicking this button
starts a search.

[ More choices )

Clicking this button displays a larger
dialog box with more choices of
search characteristics.

If the dialog box has more items in it than shown here, click
the Fewer Choices button in the lower-left corner.

2. Type the name (or part of the name) of the file or
folder you want to find.

It doesn’t matter whether you capitalize any letters, as long as
the letters or numbers you type are in the name of the item
you're looking for.



3. Click the Find button.

The first item that matches the name (or partial name) you
typed is shown highlighted in a Finder window. If no item is
found, your Macintosh makes the alert sound.

4. To see the next matching item, choose Find Again from
the File menu, or press 3-G.

If no more items are found, your Macintosh makes the alert
sound.

Finding an item by other characteristics

You can use the Find command to find a file or a folder by
searching for its size, its label, the date it was created or modified,
or other characteristics.

1. Choose Find from the File menu.

The Find dialog box appears.

2. Click the More Choices button.

The dialog box that appears lets you set different search
characteristics through pop-up menus that together form a
search order.

Pop-up menus of
search characteristics

Type text (when searching
for text) or set a date here.

= — Option to
- — display search
p J I results all at
‘[ name v | [ contains - | once (instead
ofoneata
Search [ on all disks v l [J all at once LB timc)
[fewer Choices ﬁ Find '
Clicking this button Pop-up menu of Clicking this button

displays a smaller search locations

begins the search.
dialog box.

The content of the middle pop-up menu and the text area vary
according to the item selected in the left pop-up menu.

3. Press the pop-up menu on the left to open it, drag to
choose an item, and then release the mouse button.

4. Press the pop-up menu in the middle to open it, drag
to choose an item, and then release the mouse button.

continues »
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5. Adjust the date, choose an item, or type text in the 7. If you want all found items displayed at once, click the
upper-right area of the dialog box. checkbox labeled “all at once” so that an X appears.

Clicking a number selects it; clicking the up or 8. Click the Find button .Wl.len you've finished setting
down arrow changes the selected number. your search characteristics.

The first item that matches your search characteristics is shown

L highlighted in a Finder window. To see the next item found,
[ date modified v | [ is before ~) 10/H1/90 gll choose Find Again from the File menu (or press $-G).
3 When the items found are displayed all at once, they are shown
Search [ on all disks | [Jall at once 5,15 ; : .
highlighted in one or more Finder windows.
(o) ()
Alist view shows the

contents of folders at
all levels on the disk,  Items found in the search
6. Choose a search location from the pop-up menu i ULHCE fokT freshighlighted.

labeled “Search.”

=== Jsdisk=——_ "1
Name Size Last Modified
3K Wed, Oot 10,1990, 11:13 PM [+
R 15K Fri, Sep 29, 1989, 10:59 AM
7K Thu, Oct 4, 1990, 8:50 PM
— Mon, Oct 8, 1990, 2:04 PM
T 29K Thu, Jun 22, 1989, 2:49 PM
24K Thu, Jun 22, 1989, 2:51 PM
Mon, Aug7, 1989, 7:16 AM |1 ]

J1T}
-

You can choose to search all disks, a specific disk, or the active
Finder window.

==e=e————- - e ("N ]

Find and select items whose
[ date modified v | [ is before ] 10/[E/90 5]

Indentation indicates that the item
located is inside a folder.

search [von all disks [Jall at once
0 1

on “SE backup #2”

(Fewer Cho| [ cancet ] | Find

January folder

Disk selected for searching
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Finding items through a two-stage search Uses of the Find command

You can use two sets of characteristics and locate the items that The Find command can help you locate files quickly, organize
meet both sets of characteristics. large quantities of documents, and develop an efficient system for

s backing up and archiving your work.
1. Choose the first set of characteristics you want to cking up &Y

search for.
: Search characteristic Can be used to locate
2. Click the “all at once” box so that an X appears.
Checking “all at once” displays the items found highlighted in Name 1. Files whose names you can't recall exactly =
a list. 2. All items for which you use a standard name, :
. . such as status reports or expense reports :
3. Click the Find button. 2
o ) ' _ Kind 1. All application programs a2
T'he items found are shown highlighted in a Finder window. 2. All aliases
4. Choose the Find command again, before you click or Size Large files, to make space available on a disk
take any other action.
Label All the files to which you added the same label
You choose Find before taking any other action so the items (such as “top secret” )
located in the first stage of the search remain highlighted.
8 ghiig Lock Locked files, to unlock them for editing
5. Choose the second set of characteristics you want to o , ,
Modification date All files changed since a certain date, for regular

search for. backup of new and changed files

6. Choose “the selected items” in the Search pop-up

Creation date All files created before a certain date, for
menu.

archiving or erasing outdated material

7. Click Find to begin the second stage of your search.

The search is limited to the items found in the first stage,
and only those matching both sets of characteristics are
highlighted.
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Creating a template

Most documents can be saved as or converted into a stationery
pad, which is a template form of the document. The template
retains the format and content it had at the time you made it into
stationery, and you can use it repeatedly as a master for similar
documents.

Many application programs let you save a document as a

stationery pad when you first save the document or choose Save
As from the File menu. If the directory dialog box that appears has*
a stationery pad option, you can click it to save your new
document as a template.

= Walthrop + = Walthrop
O finnual vepart 91 |10 m
O App. programs
Dart form Desktop
O art samples
D Botsy 8727791

i Fie e b e sl o i UL - i = i

O car info
5 Cospor maps |
D Einance teport = Regular
L document icon
Save this document as: N )
®|=)0o[= : ‘
| —A Il Stationery pad icon

When this button is selected, the
document is saved as a stationery pad.
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If the program you're using does not offer a stationery pad
option, you can use a document’s Info window to create a
stationery pad.

1. Click to select the icon of the document you want to
use as a template.

2. Choose Get Info from the File menu.

3. Click “Stationery pad” near the lower-right corner so
that an X appears in the checkbox.

[EC=== Memo Pad Info ==

EJ Memo Pad

Kind: TeachText stationery pad
Size: 1K on disk (19 bytes used)

Where: Macintosh HD
Created: Tue, Sep 3, 1991, 657 AM
Modified: Tue, Sep 3, 1991, 6:57 AM
Version: not available

Comments:

[ Locked [X] stationery pad

Clicking “Stationery pad” converts the document from an
ordinary document to a stationery pad.

4. Close the Info window.

The document icon has changed into a stationery pad icon.



When you open a stationery pad, an untitled window appears
showing a blank “form” from that stationery, or a dialog box
appears asking you to name the new document.

You cannot change the stationery pad itself unless you turn it back
into a regular document. You do this by opening the stationery
pad’s Info window and clicking “Stationery pad” to remove the X.

Getting information about your files

When you're working on the desktop, you can choose the Get
Info command from the File menu to get information about a file,
such as when a document was created or how much memory a
program needs.

You can also use the View menu to see certain types of
information about the files listed in a Finder window.

Using the Info window

The Get Info command displays information about a selected item
in a window.

1. Click to select the item you want information about.

2. Choose Get Info from the File menu, or press 38-1.

E[N==== Read Me Info ===

Read Me
System Software

Kind : document
Size: 3K on disk (1,622 bytes used)

Where: J’s disk: Read Me

Created:Thu, July 11,1991, 11:13FM
Modified:‘ed, Nov 6, 1991, 12:00 PM
Yersion: not available

Comments:

D Locked D Stationery pad

Besides getting information, you can use the Info window to
lock a file (so it can’t be changed or thrown away), turn a
document into a stationery pad, change a program’s memory
allocation, and change the file’s icon. (See Chapter 11,
“Adapting Your Macintosh to Your Own Use,” for information

on the last two procedures.)

You can type comments in the Info window and later search
for them with the Find command.

3. Click the close box.

Chapter 10: Organizing Your Files 119

=~
<]
=y
<o)
=~
<2l
2
O
<o




Using the View menu

You can use the View menu to display the contents of a window
by icon or small icon, or you can list them according to name,
size, kind, date, or label. (See Chapter 11, “Adapting Your
Macintosh to Your Own Use,” for information on using the Views
control panel to change how files are listed and what information
is included.)

Windows are set to show items in the icon view. One of the list
views (name, size, kind, label, or date) is useful when you have
too many files to see easily as icons or if you want your files
arranged according to a particular attribute. For example, listing
documents by the date and time of their most recent modification
makes backing up files an orderly task.

The type of list displayed is underlined.

== Jlidata/2 o= D¢

Name Size Kind Label Last Modified
D [ Art ideas — folder Essential Sat,May S, 140
D O caspar maps — folder Hot Thu, Nov 2, 1 .

D) credit union account

17K document Personal Mon, Jun 19,
D 3 B i
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When the contents of a window are displayed as a list and you
want them arranged in another list view, you don’t have to use the
View menu. You can click a column heading (such as Size or the
Last Modified date) to rearrange the list according to that
heading.

See the summary, “Working on the Macintosh Desktop,” on the
green pages after Chapter 16 for information on using a list view
to select items in different folders.
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Specifying which items
you want opened at startup

To have a file (a program or a document) open automatically
when you start up your Macintosh, drag the file’s icon or its alias
to the Startup Items folder, which is inside the System Folder.
Any programs or documents (or their aliases) that you put in
the Startup Items folder are opened when you start up your
Macintosh. You can have as many files open automatically as
your computer’s memory allows.

If you no longer want a file to open automatically when you start
up your Macintosh, remove the file’s icon or its alias from the
Startup Items folder.

Installing an item in the Apple menu

To have a program, document, or other item appear in the Apple
menu, drag the item’s icon or its alias to the Apple Menu Items
folder, which is inside the System Folder.

You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging the item’s icon (or its alias) out
of the folder.
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Installing files in the System Folder

Certain types of programs and other files need to be installed in
the System Folder so your Macintosh can use them as part of the
system software. These files include

m  system extensions and control panels (also called INITs and
CDEVs)

m files of preferences for application programs
m drivers for printers, scanners, and other devices
= sounds (instructions for installing sounds are in this chapter)

m fonts (see Chapter 12, “Printing,” for instructions on installing
fonts)

Usually, you install these files by dragging their icons to the
System Folder icon (ot the System Folder window). Sometimes
these files are installed using an installer program that comes with
the files. Check the instructions that came with the files for any
specific installation procedure.



These files are stored in specific folders inside the System Folder. Removing files from the System Folder
When you drag a file’s icon to the System Folder icon, your

Macintosh recognizes which type of file it is and stores the file in You remove a file from the System Folder by dragging its icon out

of the System Folder.

the appropriate folder.

T : Depending on the external devices you use, whether or not
This folder holds networking The System file holds fonts, ) I,
software, printer software, and sounds, keyboard layouts, you're on a network, and how you use your Macintosh, you can

other system extensions. and other resources. remove the following types of files from your System Folder if you
I want to conserve space on your startup disk:

E[J&==—=————= System Folder *f =
8itemms -9 M8 in disk 542118 available m  drivers for printers or other devices you don't use (for &
@ ‘ = This program example, the AppleTalk ImageWriter driver) =
Apple Menu ltems Extensions System Finder ﬁan‘ﬂ%es fghe k d f k ( h ;
4cintos = networking drivers, if you are not on a network (such as o
o e -—' desktop. =
Prefc:r—e‘ms Shms leanels Sanﬂe 5 P AppleShar € SOftwar e)
[ Big ,
= Apple menu items you don’t use (you need the control
This folder holds settings This file holds items you panels, but you may not need the Calculator or the Puzzle,
for application programs. put in the Scrapbook. for example)

If you drag one of these files to the System Folder window instead ™t fonts, sounds, o keytiarel files you have inselied

of the System Folder icon, the file is not stored in the appropriate Be sure you have backup copies of the files on floppy disks before
folder automatically. Items you want in the Apple Menu Items you remove them from your System Folder.

folder or the Startup Items folder inside the System Folder need
to be dragged to either folder directly. (See the instructions in this
chapter for installing Apple menu items and specifying the files
you want opened at startup.)
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Changing the items in the Label menu

You can change the labels (and colors, if your monitor displays
colors or shades of gray) available in the Label menu. You make
these changes in the Labels control panel (choose Control Panels
from the Apple menu and open the Labels control panel).

J

——
Labels

EI== Labels ==

In Progress

[E
=
(] [ Labels
()
(]
J

Personal

Project 1

Project 2

Colors

To change a label, drag across it to select it and then type your
new label.
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To change a color:
1. Click the color you want to change.

The color wheel dialog box appears.

Color square (new color appears in top half,
current color in bottom half)

Color for|"Essential”
| Circle
indicates
selected
color.
Hue (20996 |
Saturation |36051 @
Brightness |50229 @ _Brightness
Red [35933 | control
Green 50229 |(3)
Blue [22598 |(3)
Numbers correspond to | Color wheel shows colors available.

the selected color on

(When four colors or grays are
the color wheel.

selected, letters appear in the wheel
indicating color values.)



2. Click a color on the color wheel to select it. Settine the time and date
O

The new color is displayed in the top half of the color square.
The current color remains in the bottom half of the square for
comparison.

Your Macintosh has a clock that keeps track of the time and date
(a battery keeps it running when the computer is turned off).

Many programs rely on the clock to automatically enter times and
dates in documents you create or print, so sooner or later you will
need to set the clock to the current time and date.

3. To experiment with other colors or shades, drag the
pointer around the wheel or click at another point on
the wheel.

4. Click OK when you have selected the color you want.

1. Choose Control Panels from the Apple menu. =

The new color is displayed in the upper half of the color o =
square as you drag or click. The Control Panels window appears, showing you the =
different control panels that are installed in your System =

@)

<o}

Folder.

The color wheel dialog box closes. 2. Open the General Controls panel,

5. Close the Labels panel. The General Controls window appears. The time and date

The labels and colors you choose remain in effect until you adjustments are in the lower-right corner.
change them.

E[J== General Controls 0=

Rate of Insertion
Point Blinking

Desktop Pattern O @ O

Slow  Fast
Menu Blinking Time ®
== 11:31:55 A
= @ 12hr. O 24hr.
0 0@O [ o [EFy
off 1.2 3 21/12/91

continues W
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3. If you want to change the way the time is displayed
(12-hour or 24-hour), click the appropriate button.

The 12-hour format uses A.M. and p.m.; the 24-hour format
does not (1:30 p.m. is displayed as 13:30).

4. Click the hours, minutes, or seconds in the time
display to select them.

Up and down arrows appear to the right of the time display.

Time ®
m:32:12 AM3)

5. Click the up or down arrows repeatedly until the
current hour, minute, or second appears.

6. Repeat steps 4 and 5 as necessary to set the entire time
display.

7. Click the clock icon (above the time display) to set the
current time.
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8. In the date display, click the month, day, or year to
select it.

Up and down arrows appear to the right of the date display.

Date [Ei]

&/2/91 @)

9. Click the up or down arrows repeatedly until the
current month, day, or year appears.

10. Repeat steps 8 and 9 as necessary to set the entire date
display.

11. Click the calendar icon (next to the word “Date”) to set
the current date.

12. Close the General Controls window.

You can also set the time and date in the Alarm Clock, which you
open by choosing Alarm Clock from the Apple menu.



Se tting 4 time f()[‘ the 3. Click the alarm clock icon in the lower-right corner to

select it.
Alarm Clock to go off - _
The alarm clock icon is highlighted when you select it. The

You can set the Alarm Clock to alert you when it’s time for an time that appears in the middle section is the current alarm
appointment or a meeting. clock setting.

1. Choose Alarm Clock from the Apple menu.

[J 3:53:34PM ¢

The Alarm Clock opens.
p @ 8:21:00 AM =
2. Click the upward-pointing lever near the upper-right O g =
corner to expand the Alarm Clock. =
2
(@)
[0 3218 oM g|—— Lever 1o make the Alarm Clock 4. Click the Pours, minutes, or seconds in the alarm &=
bigger or smaller clock setting to select them.

Up and down arrows appear to the right of the time display.
The lever points downward, and the Alarm Clock expands to its
full size. 5. Click the up or down arrows repeatedly until the hour,

minute, or second when you want the alarm to go off
appears.

O 3:52:40 PM ¢
21/6/90 6. Repeat steps 4 and 5 as necessary.

® @;@F The highlighted icon indicates what's
displayed in the middle section—the continues »
date, in this example.
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7. Click the button to the left of the alarm clock setting
to turn the alarm on.

When you click, the button moves up and the alarm clock
icon changes to indicate that the alarm is turned on. (Clicking
again turns the alarm off.)

Button in the upper position
indicates that the alarm is on.

[0 3:53:34PM ¢
@ 8:21:00 AM

@ @ Icon showing ringing alarm

8. Click the close box to close the Alarm Clock.

The alarm will not go off unless you close the Alarm Clock or
click the lever to make the alarm clock smaller, click
elsewhere in the clock, or make another window active.

Turning the alarm off

When the system clock reaches the time set for the alarm, the
alert sound plays twice (the menu bar flashes once if the speaker
volume is set to zero) and an alarm clock icon blinks over the
Apple icon at the left end of the menu bar.

To turn off the alarm, choose Alarm Clock from the Apple menu
and click the button to the left of the alarm clock setting so that
the button moves down.
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Adjusting the way the mouse works

You can adjust two aspects of mouse operation in the Mouse
control panel: tracking, which is the relation between mouse
movement on your desk and pointer movement on the screen,
and double-clicking speed.

1. Choose Control Panels from the Apple menu.

2. Open the Mouse control panel.

il

Mouse

E[J=== Mouse
Mouse Tracking

8 B
o 000®00
Very Slow Slow Fast
Yl

¥

ill ¥ ®) ¥ O ¥ ®
[@] Double-Click Speed




3. Click the tracking speed you want.

If you click Fast, the pointer moves more than twice as fast as
you move the mouse. The Very Slow option is useful for
drawing with the mouse or a graphics tablet because the
pointer moves at a constant speed relative to mouse
movement.

Your choice takes effect immediately and remains in effect
until you choose a different tracking option.

Click the double-clicking speed you want.

You may have to adjust the double-clicking speed if your
Macintosh often interprets two clicks as a double click, or a
double click as two single clicks.

| The space between arrows
1 I (
i + @ + 0] ¥ 0 corresponds to the interval

between clicks.
Double-Click Speed

|M()use button highlights twice at the
interval selected when you click a button.

Your choice remains in effect until you choose a different
double-clicking speed.

Adjusting the way the keyboard works

You can adjust the rate at which a character repeats when its key
is held down as well as the delay before the character begins
repeating. You can also change the keyboard layout.

1. Choose Control Panels from the Apple menu.

2. Open the Keyboard control panel.

=~

=

e |

=

&
== 3
Keyboard =

Options for the speed at
which a character repeats

E[J===== Keyboard =——=|

| Key Repeat I!a(e I Delalg Until Repea(l O[)[iOﬂS fOI' delav bCf()l‘e 2
O00®O Ol0®00 haracterheoins reneat:
o) petdl (odiptaa s od: character begins repeating
Keyboard Layout
mk & Options for keyboard layout
e (if more than one keyboard
T layout is installed)

continues P
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3. To adjust the rate at which a key repeats when it is Controlling the pointer from the keyboard

held down, click the button for the rate you want. . .
With a Macintosh system software feature called Mouse Keys, you

After you close the control panel, your choice remains in can use the numeric keypad on the right side of the keyboard
effect until you change it. (instead of the mouse) to control the movement of the pointer on

4. To adjust the delay before keys repeat, click the button the screen.

for the delay you want. To turn Mouse Keys on, press $€-Shift-Clear (the Clear key is on

If the keys repeat when you don’t want them to, you should the numeric keypad).

adjust the keyboard’s sensitivity to your touch by setting a To turn Mouse Keys off, press Clear.
longer delay before a character begins repeating. (If you click

the Off button, the keys don’t repeat at all) With Mouse Keys on, you can click, drag, and perform all the

usual mouse actions from the numeric keypad. The 5 key serves
After you close the control panel, your choice remains in as the mouse button: press once to click; press twice to double-
effect until you change it. click. The 0 key locks the mouse button down for dragging. The
decimal point key (to the right of 0) or the 5 key unlocks the

5. To change the keyboard layout, click the name of the
mouse button.

keyboard layout you want to use.

Depending on which country you bought your Macintosh in,
you may have a choice of more than one keyboard layout.
(Additional keyboard layouts are available from various
sources, and you install them in the System Folder as you
would fonts or sounds.)

After you close the control panel, your choice remains in
effect until you change it.

6. Close the Keyboard control panel.
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Press once to
click; press twice
to double-click.

J Press cither key
to release the

» mouse button.

um
X1
| S
w
-y tam
g
4
V4
L7

Press to lock
A mouse button
down for dragging.

NI

. N

You can adjust how quickly the pointer moves on the screen and
how long the delay is before the pointer starts moving when you
press a mouse key. You make these adjustments in the Easy
Access control panel (choose Control Panels from the Apple
menu and open Easy Access).

Making keyboard shortcuts easier to type

With the Macintosh system software feature called Sticky Keys,
you can type keyboard shortcuts (such as $8-S for the Save
command) without actually pressing the keys simultaneously.

To turn Sticky Keys on or off, press the Shift key five times without
moving the mouse.

With Sticky Keys on, you can type a keyboard shortcut by first
pressing the modifier key (38, Option, Control, or Shift) and then
pressing the character key. An icon in the right end of the menu
bar (to the right of the Application menu icon) changes to
indicate whether Sticky Keys is on and whether a modifier key has
been pressed or locked.

HIONTHTITT

Sticky A modifier key A modifier key is locked
Keys has (pressing the key twice
ison. been pressed. locks it for repeated use).

You can have Sticky Keys make an alert sound when a modifier
key is pressed. You set this option in the Easy Access control panel
(choose Control Panels from the Apple menu and open Easy
Access).
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Adjusting the keyboard for very slow typing

The Macintosh system software feature called Slow Keys lets you
type very slowly and ignores accidental keystrokes by delaying the
acceptance of the next keystroke.

To turn Slow Keys on or off, hold down the Return key for about
four seconds, until an alert sound indicates that the feature is on
or off.

You can adjust how long you want Slow Keys to delay acceptance
of the next keystroke. You can also set Slow Keys to make an
audible click each time a key is pressed. You make these
adjustments in the Easy Access control panel (choose Control
Panels from the Apple menu and open Easy Access).
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Setting the alert sound

Many programs have the Macintosh make a sound, called the alert
sound, when your attention is required or when you're giving a
command or attempting an action that the computer cannot
recognize or perform at that time.

You can choose among several sounds that you want the
Macintosh to make. You can also set the sound’s volume.

1. Choose Control Panels from the Apple menu.

2. Open the Sound control panel.

=13}

11—
Sound

The Sound window appears. The alert sound that your computer
is currently using is already selected.

3. Click the alert sound that you want the Macintosh
to use.

== Sound =iF——

Speaker Alert Sounds
Yolume




5

When you click a sound to select it, it’s played at the current
volume setting.

Your Macintosh may have sounds installed in addition to those
shown here. It may also have additional features in its Sound
control panel, such as controls for recording sounds. See
“Recording Sounds” later in this chapter for information on
recording sounds. For information on any additional features,
go to the setup book that came with your Macintosh.

Drag the slide control up or down to set the volume
level.

If you want to be alerted silently: Drag the slide control to
zero. Instead of hearing an alert sound, you'll see the menu
bar flash. «

Close the Sound control panel.

Installing a sound

The Macintosh comes with a standard set of alert sounds. You can
get additional sounds from various sources. To install a sound, you
drag its icon to the System Folder icon (not the System Folder
window). The sound is automatically installed in the System file,
where it belongs.

)
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Once you add a sound to the System file, it is listed in the Sound
control panel.
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Removing a sound

You can remove sounds in the Sound control panel. Make sure
you have a backup copy of the sounds on floppy disk before you
remove them from your Macintosh system.

1. Choose Control Panels from the Apple menu.
2. Open the Sound control panel.
3. Click to select the sound you want to remove.

Make sure you select the correct sound. You cannot undo the
next step.

4. Choose Cut or Clear from the Edit menu.
5. Close the Sound control panel.

You can also remove a sound by dragging its icon out of the
System file and out of the System Folder. If your Macintosh can
record sounds, you can remove a sound by clicking to select it
and then clicking the Remove button.

Recording sounds

Some Macintosh models (such as the Macintosh LC) can accept
and process sound input. These computers come with a sound
input port, to which you can connect either a microphone (to
record sounds that you create) or a phono jack adapter (to record
sounds from another audio source such as a compact disc or an
audio cassette).
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You can record a sound and add it to your available alert sounds in
the Sound control panel. Make sure you've connected a
microphone to your Macintosh as described in the setup book
that came with your computer.

1. Choose Control Panels from the Apple menu.
2. Open the Sound control panel.

The Sound control panel appears. Icons representing the
available sound input devices appear near the bottom of the
window.

3. Click the icon that represents the sound input device
you want to use.

Microphones fptivas..

RS

()
o o
m@ Recorder —é—

4. Click the Add button.

A dialog box that looks like the controls of a tape recorder
appears.



5. To record your new sound, click the Record button. When you're finished recording new sounds, close the Sound

; g ; control panel.
Recording begins immediately; you have ten seconds to P

record your sound. There is no recording volume control.

Changing the desktop pattern

’Eb.l @ @ E] 4 You can §hange the pattern that appears on the Macintosh
Rsord 'Stop Faise P18y desktop in the General Controls panel.
S i 1. Choose Control Panels from the Apple menu. 2
2. Open the General Controls panel. E
6. Click Stop to stop recording. E
7. To listen to the sound you recorded, click Play. % I% =
8. To save the sound you recorded, click Save. General Controls

A dialog box appears in which you name your new sound.

E[J== General Controls ==

9. Type a name fOl‘ the SOund. Rate of Insertion
. - Point Blinking
10. Click OK. .
Desktop a(tern
Menu Blinking Time (D)
= 10:27:51 AM
Give this sound a name: «
=] @ 12hr. O 24hr.
[Andrea's first word |
O QO® | oate (Y]
0K off 123 28/3/90

continues p

The new sound appears in the Alert Sounds list in the Sound
control panel.
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You can choose from a variety of patterns provided for the 5. To edit a pattern, click in the square to the left of the
Macintosh desktop, or you can create your own design by miniature desktop.

editing one of the patterns supplied. If your Macintosh can
display colors or shades of gray, you can also select your own
colors to use in the pattern.

Each dot in the square changes color when you click it. Your
changes are displayed in the miniature desktop.

Pattern-editing area

I T e
(magnified view of pattern)
| Miniature desktop

Desktop Pattern

| Color bar for selecting
colors or shades of gray

6. To use another color, click the color in the color bar
(under the words “Desktop Pattern”) to select it, then
click the dots you want to change.

3. To see the patterns available, click either of the small
triangles at the top of the miniature desktop on the
right side of the Desktop Pattern area.

You can also change the color of an existing pattern by

double-clicking a color in the color bar and choosing a new

4. To choose a pattern, click the miniature desktop to see color from the color wheel in the dialog box that appears.
the new pattern on your desktop.

The pattern changes each time you click.

7. When you've finished creating your new pattern, click
The new pattern replaces the current pattern for the desktop. in the miniature desktop to display the pattern on
The desktop pattern remains in effect until you change it. your desktop.

By double-clicking in the miniature desktop, you can save the
new pattern. Otherwise it is lost when you display another
pattern in the miniature desktop.
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Adjusting the blinking of a menu item

You can change the number of times a menu item blinks when it’s
chosen. You make this adjustment in the General Controls panel
(choose Control Panels from the Apple menu and then open the
General Controls panel).

To adjust menu blinking, click the button for the number of times
you want the menu item to blink. Clicking the Off button prevents
amenu item from blinking.

Menu Blinking

-
E"

HY
7 kN

O
Off

=)

O®
24z

The option you selected remains in effect until you change it.

Adjusting the blinking of
the insertion point

You can adjust how quickly the insertion point blinks (the
insertion point indicates where any text you type will appear). You
make this adjustment in the General Controls panel (choose
Control Panels from the Apple menu and then open the General
Controls panel).

To adjust the blinking of the insertion point, click the button for
the blinking rate you want.

Rate of Insertion
Point Blinking

Slow Fast

When you click, the insertion point in the control panel shows the
rate of blinking you selected.

The option you selected remains in effect until you change it.
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Changing the way the contents
of windows appear

You can change the way the contents of Finder windows are
displayed in the different views available from the View menu
(icon view, small icon view, and the list views by name, size, kind,
label, and date). You make these changes in the Views control
panel (choose Control Panels from the Apple menu and open the
Views control panel).

[
i

Views

Use the Views control panel to change

= the font and font size used in all views (press to open the
pop-up menu, then drag to choose a font or a size)

= the arrangement of icons or small icons in icon and small icon
views

m the size of icons used in list views

= what information is included in list views, including folder
sizes and the amount of available space on disk
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Options for Pop-up menu of fonts for
layout of icons icon names and list views

= “iewﬁ% Pop-up menu of font

| sizes for icon names
'l a_ €S [0r 1Icon names

and list views

[Font for views: l Geneva

~flcon Views

?D DD @ Straight grid
(h] n Op () Staggered grid

Option to snap icons
to an invisible grid

[J Atways snap to grid

- List Vi whenever they are
[ Show size moved
@ @ @ X show kind
® @) Q [X] show 1abel
=y [ show date

[ catculate folder sizes
[[] Show disk info in header

D Show version
D Show comments

Options for the size
of icons displayed in
list views

Options for information
displayed in list views

The options you select remain in effect until you change them.
(See the summary, “Working on the Macintosh Desktop,” on the
green pages after Chapter 16 for more information about using
windows and list views.)



Changlng the appearance Of ICOHS 2. Copy the picture by choosing Copy from the Edit

menu.
You can customize icons by changing the icons themselves. If your
Macintosh displays color or shades of gray, you can have icons
appear in a specific color that’s associated with a label.

3. Switch to the Finder, then click to select the icon you
want to change.

4, Choose Get Info from the File menu.

Changing an icon The icon’s Info window appears.

In a graphics program, you can create or copy the picture you 5. Click the icon at the upper-left corner of the Info &

want to use as an icon, and then paste it into an icon’s Info window to select it. =

window. =
Abox appears around the icon when it’s selected. If no box Z

Some icons can’t be changed, including those for control panels appears when you click, the icon can’t be changed. =

and other parts of the system software. Every icon fits inside a
32-pixel square. (A pixel, or picture element, is the smallest dot

E[J= overseas accounts Info ==

you can draw on the screen.) Aboxaround the icon
D SreEbIs doconts indicates that it’s selected.
1. Ina graphnc.s program, select the picture you want to L el
use for the icon. items

Where: J’s disk: untitled folder

_____ Created: Wed, Oct 9, 1991, 9:25 AM
1 | Modified: Yed, Oct 9, 1991, 9:25 AM
| | Comments :
; : |
1 L Amoving dashed line
et | indicates the selected area

in many graphics programs.

continues W
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6. Choose Paste from the Edit menu.

The picture you copied replaces the selected icon in the Info
window. If the picture is bigger than the icon, it automatically
shrinks to fit.

[EN= overseas accounts Info =

@ overseas accounts

7. Click the close box to close the Info window.

You can change an icon back to its original by clicking the
picture in the upper-left corner of the Info window and
choosing Cut from the Edit menu.

Assigning a label and a color to an icon

You can add a label and its associated color to each icon. A label is
different from the icon’s name. The label is visible only when the
contents of a window are displayed as a list. The associated color
is visible whenever the Macintosh is set to display colors or grays.

Labels provide a way to group related files (choose By Label from
the View menu). If you have a color monitor, you can identify
related icons by assigning a label and its color to each group.

To assign a label and color to an icon, click the icon to select it and
then choose the label (and its color) that you want from the Label
menu.
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Changing the highlight color

If your Macintosh displays colors or shades of gray, you can
change the color your Macintosh uses to highlight selected text
on the screen. You make this adjustment in the Color control
panel (choose Control Panels from the Apple menu and open the
Color control panel).

i3

Color

fEB——— Color iF———|

Highlight color: [l Black & White <] ——— ' OP-up menu of choices

for highlight color

Window color: [[—J Standard ~}——— Pop-up menu of choices for
window color

You can also use the Color control panel to change the color of
window borders (go to “Changing the Color of Windows” in this
chapter).



. Press the “Highlight color” pop-up menu to open it 2. To change the brightness of the color wheel, drag the
and drag to choose a color or choose Other. scroll box up or down.

If you choose a color, it appears in the “Sample text” box 3. Click a color on the color wheel to select it.

e The new color is displayed in the top half of the color square

If you choose Other, the color wheel dialog box appears. if your monitor is set to display 16 or more colors or grays.
The current color remains in the bottom half of the square for
Highlight color square (new color appears comparison; you can click there to go back to it.

in top half, current color in bottom half)

=
4. To experiment with other colors or shades, drag the o
Choose|a highlight color: pointer around the wheel or click at another point on =
| Circle the wheel. =
indicates g
selected The new color is displayed in the upper half of the color
o square as you drag or click.
Hue (20996 |(3)
saturation (36051 |() ; - 5. Click OK when you have selected the color you want.
Brightness [50229 |3) - IC}(;%’[h([)ll]ess ¥ y
Red [35933 | The dialog box closes. The new highlight color is displayed in
Green (50229 |(3) the “Sample text” box in the Color control panel.
Blue [22598 ()
The highlight color you specified takes effect immediately and
| , remains in effect until you change it.
Numbers correspond to Color wheel shows colors available. :
the selected color on (When four colors or grays are
the color wheel. selected, letters appear in the wheel

indicating color values.)
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Changing the color of windows

If your Macintosh displays colors or shades of gray, you can
change the color of window borders. You make this adjustment in
the Color control panel (choose Control Panels from the Apple
menu and open the Color control panel).

&

Colar
I (g)or |
Highlight color: [l Black & White v] ——— Pop-up menu of choices
(o for highlight color
Window color: [[—J Standard ____v]——— Pop-up menu of choices
for window color

You can also use the Color control panel to change the color your
Macintosh uses to highlight selected text on the screen (go to
“Changing the Highlight Color” in this chapter).

To change the color of window borders, press the pop-up menu
labeled “Window color” to open it and then drag to choose a new
color.

The color you choose takes effect immediately and remains in
effect until you change it.
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Displaying colors or grays

If your Macintosh displays colors or shades of gray, you can
designate the number of colors or shades of gray you want
displayed. (How many colors or shades your Macintosh can
display depends on the video capability it has. See the setup book
that came with your Macintosh and the instructions that came
with your monitor for more information.)

You set the number of colors or grays in the Monitors control
panel (choose Control Panels from the Apple menu and open the
Monitors control panel).

—{
Monitors

E[I=——= Monitors =iF"—=

Characteristics of selected monitor :

@Graus: Black & White H
4

O Colors: 16

Drag monitors and menu bar to rearrange them.

B (o)




You also use the Monitors control panel to configure your Confieuring H]Ul[ipl@ monitors
monitors if you have more than one (go to “Configuring Multiple 2 2

Monitors,” the next section in this chapter). If you use more than one monitor with your Macintosh, you need
to indicate the monitors’ positions and designate one as the main

1. If you have more than one monitor, click the icon of monitor (the one that displays the menu bar).

the monitor whose colors you want to adjust.
You make these adjustments in the Monitors control panel
(choose Control Panels from the Apple menu and open the
Monitors control panel).

A dark border appears around the icon to show that it is
selected.

=
2. Click the Grays or the Colors button. !
m
Some monitors can display only shades of gray, even if you o
click the Colors button. = a
<o}
3. Click the number of colors or shades of gray you want Hontios
displayed on the selected monitor (or click Black & o _ ,
Whi ) MERIToTS Clicking Options opens a dialog
te). Characteristics of selected monitor: box [hil[ ]iS[S [hC [Y[)e Of \’ide()
o ) SO )i & hite card to which the selected
Your changes take effect immediately. The number of colors or 8;,,0“,5; 3 =

_ monitor is connected.

shades of gray you specified remains in effect until you change it.

\ g I . Drag the tiny white menu bar to
°:' [fyOlleWdClniOSb /9615 bull[—l?’l l/ld(?O (YOU dldﬂ t hélVG tO lﬂS[Zl]l [he n]()ni[()r y()u \\r;]n[ [O dlbplﬂ\'

avideo card in your Macintosh before you could connect a the menu bar.
monitor), increasing the number of colors or grays you want
displayed increases the amount of memory your Macintosh
uses for its v'1deo display and decreases the amount of , L Clicking Identify displays each
memory available to run your programs. Your programs monitor’s ID number on its screen.

performance may suffer as a result. If you want to change the o | _
amount of memory set aside for video, click the Options Colors in this box Icons for the monitors

The dark line around a monitor icon
indicates that it is selected.

[(1dentiry }

] ‘ y . correspond to the connected to the Macintosh,
button in the Monitors control panel and click the appropriate number of colors showing their ID numbers
buttons in the dialog box that appears. the selected and their relative positions

monitor is set to
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You also use the Monitors control panel to set the number of
colors or shades of gray you want displayed (go to “Displaying
Colors or Grays” in this chapter).

1. Check the ID numbers of your monitors by clicking
the Identify button.

A'large number appears in the center of each monitor’s
screen,; it corresponds to the number of the icon in the
control panel.

The ID numbers help you identify which icon belongs to
which monitor.

2. Decide which monitor is your main monitor and drag

the menu bar to the top of that monitor icon.

The menu bar snaps to the top of that monitor icon when you

release the mouse button.

If one of your monitors displays colors or shades of gray, you

may want to make it the main monitor so you can use the
color capabilities of your programs and of the Finder.

If your monitors are different sizes, you may want to make the

largest one the main monitor because some programs limit
their window size to the size of the main monitor.
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3. Drag the icons of the other monitors to their positions

relative to the main monitor.

To avoid becoming disoriented when you're using the
monitors, position the monitor icons so that they correspond
to their actual positions on your desk.

The pointer can cross from one screen to another where the
monitors’ icons touch in the control panel.

Choose Restart from the Special menu.

The positions you specified remain in effect until you change
them and restart your computer.



Adjusting screen brightness

Most Macintosh models have brightness and contrast dials on the
monitor or a brightness dial on the computer itself. See the setup
book that came with your computer or the instructions that came
with your monitor for more information.

Brightness
control

Contrast control

Brightness control

A few models do not have brightness and contrast dials. If your
Macintosh does not have such dials, you adjust screen brightness
in the Brightness control panel (choose Control Panels from the
Apple menu and open the Brightness control panel).

Brightness

To adjust screen brightness in the Brightness control panel, drag
the slider control to the left or the right.

.

< Tip: Turn down the brightness if you'll be away from your
computer for a while. If an image is left on the screen for
several hours or more, it may begin to “burn in” and damage
the screen. You can use “screen saver” programs, available
from various sources, to dim the screen automatically or
display a moving image after a set period of inactivity. «
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Magnifying the
screen image

The CloseView control panel lets you
magnify the image on your Macintosh
screen up to sixteen times. It is supplied on
one of the Macintosh system software disks.

CloseView is not automatically installed by
the Installer program when you install
system software.
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To install CloseView:
1. Locate the CloseView control panel.

%

—1—]
Closehiew

2. Drag the CloseView icon to the
System Folder icon (not the System
Folder window) on your startup
disk.

3. Choose Restart from the Special
menu.

To turn CloseView on or off, press
88-Option-O.



To turn the magnification on or off, press
$8—Option—X. (When CloseView is on and
the magnification is off, a rectangle on the
screen indicates which area will be
magnified. You can move the rectangle by
moving the pointer.)

To increase or decrease magnification, press
$—Option—Up Arrow or 8—Option—Down
Arrow.

You can set additional options in the
CloseView control panel (choose Control
Panels from the Apple menu and open the
CloseView control panel):

SO=—= Closeliew =——| Tyns
CloseView
Cl®§e on or off
) on

View ®orr| *% | Turns

magnification

{®) Black on White Flagnification on or off
“hite on Black o g
() white on Blac ) on N a
(@) 0ff &
= — Keyboard =
Keyboard |{® On ECETEN hoe =
Shorteuts E} aff H NP ¢ shortcuts E
o
. =g = [Option i | % =|Command : i
©1928-1991, developed by
Apple Computer, Inc. Berkeley Systems, Inc.
Inverts  ITurns Arrows change
screen  shortcuts magnification
image  onor off power
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Turning off the Empty Wastebasket
warning

When you choose Empty Wastebasket from the Special menu, a
dialog box appears warning you that you will not be able to

recover the contents of the Wastebasket once it’s emptied. (The
warning helps you avoid throwing away items unintentionally.)

You can turn off this warning in the Wastebasket’s Info box.
1. Click the Wastebasket icon to select it.
2. Choose Get Info from the File menu.

3. Click the checkbox labeled “Warn before emptying” to
remove the X.

To turn the warning back on, click the checkbox so that an X
appears.

You can also override the Empty Wastebasket warning when it is
on by holding down the Option key when you choose the Empty
Wastebasket command.

Until you choose the Empty Wastebasket command, items in the
Wastebasket continue to occupy space on your disk.
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Managing memory

Occasionally you may need to make adjustments in how your
Macintosh uses its random-access memory (RAM) in order to
work efficiently with large programs or with several programs
at once.

Checking memory use

You can find out how much memory your Macintosh has, how
much of it is not being used, and how much memory is being
used by each program you have open. You find this information
by making the Finder the active program and choosing About This
Macintosh from the Apple menu.

E[J==——=—= About This Macintosh Si0——=03,

System Software 7.0
©Apple Computer, Inc. 1983-1991

[==] Macintosh 1Ifx

Total Memory: 5,120K  Largest Unused Block: 351%K

System Software  1250K | Y |
TeachText 192 | ]

Total memory in
this Macintosh

[

GG

Programs Memory The bar indicates how much memory a
currently  allocated for program reserves for its own use. The dark
open each program portion is the amount it is actually using.

Your Macintosh must have at least 2 megabytes (MB), or
2048 kilobytes (K), of RAM to use System 7.



You can adjust how much memory a program sets aside for itself
when you open it (go to “Setting Up Your Programs” in Chapter 8,
“Setting Up Your Macintosh System,” for instructions).

If you're unable to open a program or use network services such
as printers or electronic mail, you may have to quit from one or
more programs to free some memory for what you want to do.
You can also restart your Macintosh to reset the way its memory is
being used.

Adjusting the disk cache

The disk cache is memory set aside to help programs work more
quickly and efficiently. The memory in the disk cache is not
available for opening more programs or documents, so the size of
the disk cache affects how many files you can have open at the
same time.

The preset and maximum sizes of the disk cache depend on the
amount of memory your Macintosh has. If you often want to open
more programs than memory allows, set the disk cache to a
smaller size—such as 32K or 64K.

You set the size of the disk cache in the Memory control panel
(choose Control Panels from the Apple menu and open the
Memory control panel).

i

e 1—
Mernory

To set the size of the disk cache, click the up or down arrows next
to the Cache Size box. The new size takes effect after you restart
your Macintosh and remains in effect until you change it.

El| Memorny S5S—————

Cache Size _Arrows adjust cache in

Disk Cache

AL preset increments.
Hard Disk:

Virtual Memory gmmer 4
O On Available on disk: 27M
® off Total memory : 4M

: This button sets the disk

32-Bit Addressing . .

Oon cache at the system’s

® orr preset amount (which
depends on the RAM in

Use Defaults | your computer).

Depending on your Macintosh model, you also use the Memory
control panel to adjust how virtual memory is used and to turn
32-bit addressing on or off (see “Using Hard Disk Space as
Memory” and “Turning On 32-bit Addressing” in this chapter).
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Using hard disk space as memory

Some Macintosh models can use space on a hard disk to increase
the computer’s memory. The disk space, called virtual memory,
is not available for storing information when it is being used for
this purpose.

Your Macintosh should contain enough built-in memory for your
regular needs—that is, for the programs you frequently have open
simultaneously. You can use virtual memory when you want to
open additional programs or to work with extremely large
documents that can’t be opened while using only the built-in
memory.

Virtual memory is more effective when you are using several small
programs simultaneously. It is less effective when using one very
large program.
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If your Macintosh can use virtual memory, you can adjust its use
of virtual memory in the Memory control panel (choose Control
Panels from the Apple menu and open the Memory control
panel).

2

E— 11—
Mernory
Lim; Memory
Disk Cache ol Pop-up menu of hard disks
Alvays On in use (dimmed when

. . s
R RE— virtual memory is off)
Virtual Memory {enmer A 4

Oon vanabis on diek: 27 ——|— Space available on the
® off Jetalnemory : disk Hummer

Total memory

32-Bit Addressing

Oon (exclusively RAM in this
Tl example; includes virtual
memory if it’s on)




You also use the Memory control panel to adjust the size of the 4. Choose Restart from the Special menu.
disk cache and (depending on your Macintosh model) to turn
32-bit addressing on or off (see “Adjusting the Disk Cache” and
“lurning On 32-bit Addressing” in this chapter).

After you restart, your computer’s total memory (as indicated in
the window that appears when you choose About This Macintosh
from the Apple menu) includes the virtual memory you set aside

1. Click the On button to turn on virtual memory. on the hard disk.
The Select Hard Disk pop-up menu becomes active (black) A\ Important: When you turn on virtual memory, the system
when you click On. software creates a file named VM Storage in your System

. Folder (if the startup disk is used for virtual memory) or on =

2. Press the pop-up menu to open it and drag to choose ) - M &

A . . the desktop (if another hard disk is used for virtual memory). =

the hard disk on which space will be allocated for b . ; : =

" This file is large—the size of the computer’s RAM and the &

virtual memory. ; : . Z

designated amount of virtual memory combined. For a

3. Click the up and down arrows to adjust the amount of example, if your Macintosh has 4 MB of RAM and you add g
disk space to be used as virtual memory. 2 MB of virtual memory, the VM Storage file will occupy

- ; 6 MB of space on your startup disk. A
The Memory control panel is preset to allot the same amount P ! l

of virtual memory as the amount of RAM installed in your
Macintosh. Choosing a larger amount of virtual memory is
likely to slow the computer’s performance.

Itis recommended that you accept the preset size. The
numbers for “Available on disk” and “After restart” change as
you adjust the amount of disk space.
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Turning on 32-bit addressing

Some Macintosh models can use very large amounts of memory
(more than 8 megabytes) by taking advantage of a feature called
32-bit addressing—the use of very long (32-digit) binary numbers
to control the way data is manipulated.

If your Macintosh can use 32-bit addressing, you can turn the
feature on or off in the Memory control panel (choose Control
Panels from the Apple menu and open the Memory control
panel).

To turn 32-bit addressing on or off, click the appropriate buttons
in the control panel, then choose Restart from the Special menu.

i

— B —
Mernory
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E(l=——— Meminy ="rc————
Disk Cache Cache Size

Always On

Virtual Memory

Oon Trvaiiable on disk: 271

Ol Tetalmemeny i When you turn on 32-bit
addressing, a status

—  32:Bit Addressing — | message appears here.

@ Qon

= @ off

Use Defaults

You also use the Memory control panel to adjust the size of the
disk cache and (depending on your Macintosh model) to set aside
hard disk space for use as memory (see “Adjusting the Disk
Cache” and “Using Hard Disk Space as Memory” in this chapter).



Chapter 12

Printing
In this chapter

= Before you print
Choosing a printer
Selecting Page Setup options
Updating printer drivers on networked computers

= Printing your work
Printing the contents of a window
If the printer doesn’t print your document

= Printing while using the computer for other work

= Working with fonts
Outline fonts and bitmapped fonts
Installing fonts
Removing fonts
Transferring fonts to a LaserWriter printer
Finding out about available fonts
Using the LaserWriter Font Utility

Before you print

Before you can print, your Macintosh must be connected to a
printer, either directly or over a network. See the instructions that
came with your printer if you need information about connecting
it to your computer.

Then, you must tell your Macintosh which printer to use by
choosing the printer.

Choosing a printer

You tell the Macintosh which printer to use by choosing the
printer in a program called the Chooser. You don’t need to choose
a printer every time you print. You need to choose one only when
you're using a printer for the first time and whenever you decide
to change printers.

How you use the Chooser depends on whether your Macintosh is
connected directly to the printer or connected to a network.
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If your printer is not on a network

Make sure that you've connected the printer according to the
instructions that came with it and that you know which port you
used (on the back of the computer) to connect the printer.

1.

Choose the Chooser from the Apple menu.
The Chooser window appears.

Click the icon of the printer you want to use. Make
sure the icon is selected (highlighted).

O Chooser
= ] | Select a port:
= 5]
AppleShare App\efalk,..géVriler
E
i il oo
i LaserWriter
Lo Ap;;leY...g;Vri(er LQ ImageWriter
[ =
===
Personal .. Writer SC
O Active
AppleTalk ;
O] hR ® Inactive
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« Ifyour printer’s icon does not appear in the Chooser; then
the appropriate printer driver—the program that
communicates with, or “drives,” the printer—has not been
installed in your System Folder. Close the Chooser and install
the driver you need. You can use the Customize option in the
Installer program (see Chapter 8, “Setting Up Your Macintosh
System”), or you can install the driver directly by dragging its
icon into the System Folder. If your printer is not an Apple
printer, review the instructions that came with it for
information on installing its driver. <

If you have a Personal LaserWriter SC, close the Chooser window
after you click the Personal LaserWriter SC icon.

3. Click the icon representing the port that you used to
connect the printer. Make sure the icon is selected.

You have only two choices: the printer port or the modem
port. Click the icon that matches the icon of the port (on the
back of the computer) to which you connected the printer
cable.

4. Click the Inactive button next to the word “AppleTalk.”

If the Inactive wasn't already selected, a dialog box appears.
Click OK.

5. Close the Chooser window.



If your printer is on a network

Find out from your network administrator (or the person who set
up your computer) which printer you can use, which zone it’s in
(if your network has zones), and what its name is (every printer
on a network has its own name).

1. Choose the Chooser from the Apple menu.
The Chooser window appears.
2. Click the Active button next to the word “AppleTalk.”

If Active wasn't already selected, a dialog box appears.
Click OK.

Types of devices available

Names of individual printers

Select a LaserWrifer:
Accounting |
Human Resources
Marketing
Sales
=
AppleTalk Zones:
4th floor west
Sth floor east 5]
6th floor east Background Printing: @ On O 0Off
6th floor west
|| Active
S applelalk I-g Inactive

| AppleTalk must be active to
use any network devices,
including network printers.

Network zones (appear only
if the Macintosh is on a
network that has zones)

3.

Click the icon representing the type of printer you
want to use.

You may have to click the up and down scroll arrows to find
the icon.

Ifyour printer’s icon does not appear in the Chooser; then
the appropriate printer driver—the program that
communicates with, or “drives,” the printer—has not been
installed in your System Folder. Close the Chooser and install
the driver you need. You can use the Customize option in the
Installer program (see Chapter 8, “Setting Up Your Macintosh
System”), or you can install the driver directly by dragging its
icon into the System Folder. (If you install the LaserWriter
driver, be sure to install the PrintMonitor program also.) If
your printer is not an Apple printer, review the instructions
that came with it for information on installing its driver.

JONIYIITYH

If you see a list of AppleTalk zones, click the zone
where the printer is located.

You may have to click the up and down scroll arrows to find
the zone. The zones are listed alphabetically.

Click the name of the printer you want to use, even if
it’s the only one that appears.

continues ¥
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6. If you want to be able to use your Macintosh for other When a LaserWriter printer is chosen, this Page Setup dialog
work while it’s printing documents, click the On box appears:

button next to Background Printing.
. o o ) ) Pop-up menu of special paper sizes
The background printing option is available only if both the

~ PrintMonitor program and the LaserWriter driver have been RSN Toge et
installed in your System Folder. (See “Printing While Using the Paper: @ US Letter O A4 Letter z &=
cts e e s : OUSLegal OBS Letter O[ Tabloid |
Computer for Other Work” in this chapter for information = : : _
; ) ) educe or % Printer Effects: Options
about using PrintMonitor.) Enlarge: & Font Substitution?
Orientation (] Text Smoothing?
(X Graphics Smoothing?
7. Close the Chooser. I X Faster Bitmap Printing?

Printed copy as Clicking the Options button
percentage of original opens a dialog box for
selecting enhancements

to the printed image.

Selecting Page Setup options

You use the Page Setup dialog box when you've selected a new
printer in the Chooser or when you want to use a different paper

size or printing option. . o . .
When an ImageWriter printer is chosen, this Page Setup dialog

= Choose Page Setup from the File menu and select the options box appears:
you want.

Imagellriter 0K -
Paper: @ US Letter O A4 Letter
QO US Legal O International Fanfold

(O Computer Paper

Orientatio Special Effects: [ Tall Adjusted

E []150 % Reduction
[ = [ No Gaps Between Pages

|
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You can choose Show Balloons from the Help menu to get
descriptions of the enhancements provided in the Options dialog
box, or check your printer’s manual for details.

You'll see different options for each type of printer you use. Some
programs provide additional options. Options you set in the Page
Setup dialog box remain in effect until you change them.

Updating printer drivers on networked computers

All computers on a network that share one or more printers must
have the same version of the printer driver software that
communicates with (or “drives”) the printers. When someone on
the network sends a document to the printer using a version of
the printer driver that’s different from the last version the printer
recognized, the printer restarts itself (which takes time and clears
any fonts from its temporary memory).

~\ Important: All computers on a network must have the same
version of printer drivers in their System Folders.

If your Macintosh is part of a network, you or your network
administrator should update the printer drivers on any Macintosh
computers on your network that are running any system software
version earlier than version 7.0. You do not have to update other
components of the system software; version 7.0 printer drivers
work with earlier versions of the system software.

To update printer driver software, you use the Installer program
and the accompanying Printer Update document (both files are
on one of the system software disks that came with your
computer).

Inztaller  Printer Update

JONTYTITYH

You can store these files on a file server or a shared disk on the
network and install the update from there.

1. Locate the Installer and Printer Update files (supplied
on one of the system software disks), and then open
the Installer icon.

A dialog box appears, showing the printer driver icons and
explaining your installation options.

continues W
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2. Click OK. 4. If you want to install different printer drivers in
addition to those already on your disk, click the
Customize button, then click the names of the drivers
you want to install.

The Easy Install dialog box appears.

Drivers to be updated

If you want to update only the drivers that are already

Eosy pnstall installed on your disk, go to step 5.
Cligk Install to update to Uersion 7.0 of
» Ainy Existing Printing Software When you click Customize, the custom installation dialog box
(Cinstan ) appears, showing a list of the printer drivers available. Press
. the Shift key while you click if you want to select more than
on the hard disk named ) g / /
© Hard disk #2 one printer driver.

_ Printer drivers available

Click the items you want to select;
Shift-click to select multiple items.
C@ Software for Laserllriter

install

=

Software for Personal Laserlriter SC

Disk on which drivers will be updated
= Hard disk #2

<l

3. Make sure that the hard disk indicated in the box is
the one you want to update the printer drivers on. If a
different disk name appears, click the Switch Disk
button until the correct disk name appears.
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5. Click Install. Ifa LaserWriter printer is chosen in the Chooser, this dialog

6. Click Quit when you see a dialog box reporting that box appears:

installation was successful. Page range (clicking All prints the entire

i B ; : X s Paper-feed Number document; entering page numbers in the
Ilf a dmiiog box reports that installation was not successful, try method of copies From and To boxes prints those pages only)
the update again.
Laserwrit% “LaserlUriter” i m
Pl’lﬂ[lng your WOI’k Copies:| Pages: @ All O From: To:
CoverPage: @ No O First Page (O Last Page :
The most common way to print a document is while it’s open and oy @ Rauey Cossette @ Manunf feed &
.5 X s A . . Print: @ Black & White O Color/Grayscale =
while its window is the active window. You can also print S e O PostScript® File &
documents while the Finder is the active program. 3
<o}
1. Make sure that the document you want to print is in
the active window. “ Printing color or gray-scale documents: You can print color
’ o _ . ' or gray-scale documents on any color printer that can use the
ﬁ/; youre pr‘llnllngfrom the Fmd'e"i C:(l(k th%’ llC(i)n of the o LaserWriter driver. If you print a color document on a printer
DLIIEAL yOu WanLto BHbE (or click several document icons that prints only in black and white, the document will be
while holding down the Shift key). + produced in a halftone format; that is, it will be composed of
2. Choose Print from the File menu, or press $-P. patterns of dots.
A dialog box appears, in which you can set printing options. Some programs offer additional printing options, such as the
The options vary depending on the printer you have chosen order in which a document’s pages are printed. See the
and the program in which the document was created. manuals that came with your programs for more information

on their printing features.
3. Click the Print button in the upper-right corner.

After a moment, a status box appears. If background printing
is turned on in the Chooser, the status box disappears after a
few seconds, and you can do other work while printing
continues.
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Printing the contents of a window If the printer doesn’t print your document

You can print the contents of the active window when you're The Print command isn’t reaching the printer, the printer is
working in the Finder. getting conflicting signals, or the printer isn’t working properly.
1. Make sure that the window whose contents you want m  Check that the printer is turned on and warmed up (if it's a
to print is the active window. LaserWriter, it should have printed a sample page).
2. Choose Print Window from the File menu. m  Check the cable connections to the printer.
A dialog box appears. = Ifyour printer is an ImageWriter, make sure that the Select

light is on. (Press the Select button to turn the light on.) A

Select the options you want. ; ; M
dialog box on the screen may inform you that the printer is

4. Click the Print button. not responding.
The window’s contents are printed in the format currently = Check that the printer (and its name, if it's a LaserWriter) is
displayed, including items not visible on the screen. selected in the Chooser.
When no window is active, you can print the contents of the m  Make sure that you are using the same version of the printer
Macintosh desktop by choosing Print Desktop from the File driver as all other people on your network.
menu.

= Ifan error message states that the printer could not print your
document, turn off the printer for at least 10 seconds, then
turn it on again and wait for the printer to warm up before
trying to print again.
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Printing while using the computer 1. After you have started printing a document, choose
fO roth er work PrintMonitor from the Application menu.

You can use your Macintosh for other work while you're printing
on a LaserWriter printer if the background printing option is
turned on in the Chooser. (See “Choosing a Printer” in this . o
chapter for information about turning on background printing.) When you choose its name from the Application menu, the
PrintMonitor window appears.

When background printing begins, PrintMonitor opens
automatically and its name appears in the Application menu at
the right end of the menu bar.

You can control background printing with PrintMonitor, a program

=
that’s installed automatically when you install system software Name of the document being printed =
using the Installer program’s Easy Install option. and printer currently in use =
2
PrintMonitor === Q
T R
T T wgneJ‘Lgmg ] Documents to be printed
2 &) Banana Slug Lyrics @ Wellesley next (a selected item can
|| be removed from the list)
5
[ Cancel Printing ] LSeQ Print Time... }'—_ Cth‘mg this b_u[to_n lets
rinking Stetus: Sea Lion Solute you set the print time.
One Fage To Print L
status: starting job —1 Description and status
of the current job

appear here.

|Clicking this button cancels
the current printing job.

continues W
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You can use PrintMonitor to

monitor the status of printing
cancel a document currently printing or waiting to print

set the time you want a document to print (date and
hour) or postpone a job indefinitely

monitor paper supply (PrintMonitor’s icon blinks at the
right end of the menu bar when the printer is out of
paper; you can change the notification method with the
program’s Preferences command in the File menu.)

signal when to feed paper manually (PrintMonitor’s icon
blinks at the right end of the menu bar to signal that you
must confirm the manual operation; you can change this
notification with the program’s Preferences command in
the File menu.)

2. Select the options you want, and then click the close
box.
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Working with fonts

A font is a collection of letters, numbers, and symbols in a
distinctive typographic design.

When you install Macintosh system software, several fonts are
installed in the System file, which is in the System Folder on your
startup disk. You can install additional fonts and remove fonts.

Additional fonts are supplied on one of the system software disks.
Fonts are also available from independent manufacturers, user
groups, and computer bulletin board services.

Outline fonts and bitmapped fonts
Your Macintosh uses two types of fonts:

= outline fonts

= bitmapped fonts

Both types of fonts are installed in the System file in the System
Folder of your startup disk when you install system software.



Outline fonts (also called scalable or variable-size fonts) describe
each letter, number, or symbol as a mathematical formula that
defines the character’s shape and adjusts itself to make the
character’s size larger or smaller. Your Macintosh, therefore, needs
only a single outline font in a particular typeface (such as Times)
to be able to print or display that typeface in different sizes.

The outline fonts supplied with Macintosh system software are
called Tru€lype fonts.

5

Courier

.

 When your Macintosh is running System 6, you cannot use
Truélype fonts supplied with System 7. <

Bitmapped fonts (also called fixed-size fonts), on the other hand,
describe each character as a grid of black and white dots (called a
bit map), which is a rendering of the character’s shape in a
specific size.

TTTE

T
T
11T
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Your Macintosh needs a separate bitmapped font of a typeface in
each size it prints or displays, such as 12-point Times® or 10-point
Helvetica®.

2

FMonaco 9

An outline font character is like a cookie recipe that you can use
to make as big or as small a batch of cookies as you need. A
bitmapped font character is like a cookie cutter: it gives you one
size—that’s all.

For information on how the system software finds the fonts it
needs, see “Getting the Best-Looking Fonts” in Chapter 16, “Tips
and Troubleshooting.”
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Installing fonts Removing fonts

To install a font: To remove a font:
1. Quit all programs that are open. 1. Open the System Folder on your startup disk.
Pull down the Application menu to make sure that the Finder 2. Locate the System file icon and open it.

is the only open program. Choose any other open program
from the Application menu and then choose Quit from the
File menu.

3. Locate the icon of the font you want to remove and
drag it out of the System window and out of the
System Folder window.

2. Locate the icon of the font you want to install and drag 4
it to the System Folder icon (not the System Folder
window) on your startup disk.

J
. Close the System window and the System Folder
window.

You can click multiple font icons while holding down the Shift
key to select more than one icon.

A dialog box appears, letting you know that the fonts will be
stored in the System file, where they belong.

3. Click OK.
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Transferring fonts to a LaserWriter printer

If you're using a LaserWriter printer that’s equipped to handle
PostScript® and you want to print using PostScript outline fonts
that are not built into your printer, you can transfer, or download,
outline fonts from your System Folder to the printer. (PostScript is
a programming language that describes the characters, symbols,
and images appearing on each page of a document.)
Downloading fonts saves you printing time if you plan to print a
batch of documents that use those fonts.

When you download a font, it’s stored in the printer’s memory or
on a hard disk attached to the printer. You can download as many
outline fonts as the printer’s memory and hard disk space allow.

You download a font using the LaserWriter Font Utility, which is
supplied on the system software disks.

1. Locate and open the LaserWriter Font Utility icon.

=

Laserw'riter Font Utility

Choose Download Fonts from the File menu.

A dialog box appears.

D load to

@® Printer
Q Printer’s disk{s)

Fonts to download:

Courier
Courier-Bold

B

Fonts currently

Courier-BoldOblique
Courier-0Oblique
Helvetica
Helvetica-Bold

5

(__cancet ] [ pownload J|—

—( Aad.. ) [ nemave ——f———sclected in the list.

available for
downloading

Clicking this button
removes any fonts

HONTITITY

Clicking this button

downloads all fonts

listed to the printer.

Clicking this button displays a directory dialog

box for locating and selecting additional fonts.

If the font you want to download is not listed, click the

Add button to add fonts to the list.

A directory dialog box appears, which you use to locate the

fonts you want.

continues W
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. Click the name of the font you want, then click Add.

You can press the Shift key while you click to select more than
one font.

[= condensed Garamond ¥ |

0 GaramBollta — Hard disk
DO Garamlig =
D GaramLiglta
O GC Printer Fonts Desktop
D GC Screen Fonts

(@EITIY)

. When you've added all the fonts you want to
download, click Done.

The directory dialog box closes and the fonts you added are
listed in the Font Utility dialog box.

Click the Download button to send all the fonts in the
list to the printer or its hard disk.

A status box appears. You can click Cancel to stop the process.

. Click OK when the status box reports the results of
downloading.

Choose Quit from the File menu.
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Finding out about available fonts

Most application programs have a Font menu that lists the fonts
installed in your System file, though some programs do not list
them all (you can open the System file icon, inside the System
Folder; to see all the fonts stored there).

The LaserWriter Font Utility program (supplied on the system
software disks) provides three ways to see the fonts available for
printing on a LaserWriter. You can display a list of fonts on the
screen, print a catalog of fonts, or print a set of font samples. You
choose the method you want from the LaserWriter Font Utility’s
File menu.

2 Displays a window
listing all fonts

Download Fonts... 3D currently available to

Display Available Fonts... gL the printer

initintize Printee’s Bisk..,

Prints a list of the

Page Setup... fonts available to
Print Font Catalog... agp +— the printer
Print Font Samples... — 1 Printsasample of
each font available
Quit %0 to the printer




Using the LaserWriter Font Utility

While the LaserWriter Font Utility is most useful for transferring
(or downloading) fonts from your System Folder to a LaserWriter
printer and finding out about available fonts, you can also use the
program to

» initialize a hard disk attached to a printer

= control whether a printer prints a sample page when you turn
iton

m restarta printer
= send PostScript files to a printer

The LaserWriter Font Utility program is supplied on the system
software disks.

Initializing a hard disk attached to a printer

Some printers let you attach a hard disk so you can store fonts on
it (in addition to the fonts stored in the printer’s memory). See
the manuals that came with your printer if you need information
about connecting a hard disk.

1. Open the LaserWriter Font Utility icon.
2. Choose Initialize Printer’s Disk from the File menu.

A dialog box appears.

3. Click the box next to the SCSI ID number of the hard
disk that you want to initialize so that an X appears in
the box.

4. Click the Initialize button.

Turning the printer’s sample page on or off

The LaserWriter prints a sample page each time it is turned on or
restarted.

1. Open the LaserWriter Font Utility icon.

JONTYTITY

2. Choose Start Page Options from the Utilities menu.

A dialog box appears.

Laserdirier Printer start page:
e @ 0n

S

3. Click the On or Off button.
4. Click OK.
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Restarting a LaserWriter printer

Restarting the printer clears its memory, removing the fonts

stored there and making room for other fonts that you may want

to transfer to the printer.
1. Open the LaserWriter Font Utility icon.
2. Choose Restart Printer from the Utilities menu.

A dialog box appears.

fAre you sure you want to
restart your PostScript printer?
Doing so will erase all fonts in
the printer's memory.

(Concel)

3. Click Restart.

Transferring a PostScript file to a LaserWriter

You can use the LaserWriter Font Utility to send a file in PostScript

format to a LaserWriter. (PostScript is a programming language
that describes the characters, symbols, and images in a file to be
printed or displayed.)

1. Open the LaserWriter Font Utility icon.
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2. Choose Download PostScript File from the Utilities

menu.
A dialog box appears.

Click the name of the file you want to download to the
printer, and then click Open (or double-click the
name).

A second dialog box appears, asking you to name a file that
saves a record of the PostScript activity. This file has the preset
name “PostScript Log.”

= Travel disk v —Travel disk .
0O 7.0 beta draft -m
0 7.0 figs !
D activwindow Desktop
O -Amsterdam
O Art ideas
D Disk to Burr e
Save PostScript output as:
PostScript Log )

The name of a printing log, which
records PostScript activity
Type a name for the printing log, then click Save.

The file is sent to the printer and a record of the PostScript
activity is saved in the printing log.

You can open the printing log to see the sequence of
PostScript commands when the file was sent.



Chapter 13

Using Your Macintosh
on a Network

In this chapter

= What you can do on the network

= Setting up your Macintosh on a network
Connecting to a network
Configuring your Macintosh for a network

= Gaining access to files on other computers
Before you begin
Connecting to a shared disk
Disconnecting from a shared disk
Using an alias to connect quickly to a shared disk
Connecting automatically when you start up

m  Working with files and folders on other computers
Creating a new folder on another computer

Giving folder ownership to someone else

Sharing your files over the network
How file sharing works
Turning file sharing on
Selecting a folder or disk to share
Naming the people who'll have access to shared files
Selecting a user or group to share a folder or disk

Giving away ownership of a folder or disk on your
computer

Turning file sharing off
Monitoring file-sharing activity

Gaining access to your computer when you're away
from it

Using access privileges
Understanding access privileges
Setting access privileges to folders and disks
Linking programs over the network
Linking to a program on another computer
Allowing other people to link to your programs
Using communications products with System 7
Using the Communications Toolbox

Using Data Access Language
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What you can do on the network

You can do several things with your Macintosh once it is
connected to a network:

= Gain access to information on other computers.

Working at your own computer, you can connect to other
computers and gain access to files that are stored there.

= Allow access to information on your own computer.

You can designate the contents of specific folders and hard disks
on your computer as “shared files” that other people can gain
access to over the network.

170 Chapter 13: Using Your Macintosh on a Network

= Print documents on network printers.

You can print documents on network printers as you would on
printers that are connected directly to your computer.

= Link programs to programs on other computers.

You can link your programs to programs on other computers in
order to share features between those programs. For example,
you could link a word-processing program to a dictionary
program to check the meaning and spelling of the words in a
document.



= Update files over the network automatically.

You can automatically update documents created in programs that
use the Macintosh system software’s publish-and-subscribe
feature (see the documentation that came with your programs for
information about this feature).

Setting up your Macintosh on a network

Before you can use your Macintosh on a network, you have to
physically connect your computer to the network, install
networking software, make sure that your computer can
communicate with the network, and identify your computer and
yourself to others on the network.

If you have a network administrator, he or she may have already
set up your Macintosh on the network. Before you proceed, ask
your network administrator whether these tasks have been
completed.

Connecting to a network

Your Macintosh has built-in AppleTalk networking software that
allows your computer to connect to a network quickly and easily.

If you're using a LocalTalk network (a type of AppleTalk network),
then all of the software and hardware you need is already built
into your Macintosh. You can connect your computer to the
network by plugging LocalTalk-compatible cables into the back of
your computer. (See the documentation that came with your
cables if you need more information.)

Printer port
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If you're using an Ethernet or a Token Ring network, your
Macintosh needs both an EtherTalk or a TokenTalk expansion card
installed in one of its expansion slots and the appropriate software
to communicate with the network. (See the documentation that
came with your expansion card if you need more information.)

The EtherTalk and the TokenTalk software are provided on the
system software disks that came with your computer. If a network
expansion card was already installed in your computer when you
installed system software, the software for it was installed
automatically. If you installed the expansion card affer you
installed the system software, you need to install the network
software separately (see “Installing a Customized System” in
Chapter 8, “Setting Up Your Macintosh System”).

Configuring your Macintosh for a network

Before you can use the networking features of your Macintosh,
you have to take a few steps to prepare it.
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Making sure AppleTalk is on

The first time you turn on your computer after you have
connected it to a network, AppleTalk—your computer’s built-in
networking software—is turned on automatically. But if you have
turned AppleTalk off—for example, to connect an ImageWriter
printer to your printer port—you need to turn it back on again.

1. Choose the Chooser from the Apple menu.

Select a file server:
Artificial Intelligence |5
Artiste

Corner Pocket

General Purpose

Greg's Macintosh

Kitty Margola's Macintosh
Monterey

Niles Davis's Macintosh

LaserWriter

ImageWriter

_AppleTalk Zones:

Engineering & Sonoma
Ventura
Marketing 1=
Production
Publications 4K
Research G
meemmmaele . AppleTalk
appieTelx D Active st be active
= O Inactive must be active
for your
Macintosh
This list appears only if your to use a
network has zones. network.

2. Click the Active button (in the lower-right corner of

the Chooser) to turn on AppleTalk.

3. Close the Chooser.

AppleTalk remains on until you turn it off in the Chooser.



Selecting a network connection 2. Click the icon of the network connection you want to

: . use.
If you're using a LocalTalk network, go to the next section,

“Naming Your Macintosh and Its Owner.”

= — Network == = ——

If you want to use an EtherTalk or a TokenTalk network Seynkin ABNAK couetion:

connection type or switch between two or more types of network 0,
connections, you have to select which connection you want in the b

Network control panel.

1. Choose Control Panels from the Apple menu and E
double-click the Network icon to open it. =
2
) A dialog box warns you that you may be disconnected from e
= [ any network services (such as printers or file servers) that you
Nmk are using with your current network connection. This means
that you must reconnect to the network services on the new
network.
< Ifyou can't find the Network control panel: The Network g
3. Click OK.
control panel, EtherTalk software, and TokenTalk software
were installed only if you already had an EtherTalk or a Next, you need to select the network zone your computer will
TokenTalk expansion card in your computer when you use.

installed the system software. If you have an expansion card
installed now and no Network control panel appears in the
Control Panels folder, use the Installer program to install
EtherTalk or TokenTalk software. (See “Installing a Customized
System” in Chapter 8.) <«

continues W
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4. Double-click the icon of the network connection you
chose in step 2.

The default zone that’s preselected by
your network administrator

Marketing
Sales Group
Finance

Please select
this computer’'s
AppleTalk zone.

Product Support

(cancel ]

5. Click the name of the zone you want to use.

Zones are set up by a network administrator and are used to
distribute the devices on a network among groups for easier
access.

6. Click OK.
7. Close the Network control panel.

You can now use the network connection you selected.

Naming your Macintosh and its owner

Before you begin to use the network, you must give your
Macintosh a name and name yourself as its owner. The name you
give your Macintosh appears in the Chooser of other computers
on the network so that people on the network can gain access to
files on your computer.
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1. Choose Control Panels from the Apple menu and
double-click the Sharing Setup icon to open it.

ﬂ

Sharing Setup

< Ifyou can't find or can’t open the Sharing Setup icon: Make
sure that the Sharing Setup icon is in the Control Panels
folder, and that the File Sharing Extension file and the
Network Extension file are in the Extensions folder inside the
System Folder. Then restart your computer. <

[[===== snharing setup e
Network Identity
T e e Troe vour name
Owner Password: _ ) pc }()UI ndm(’!
Macintosh Name : [Jonathon Jones's Masintosh your password, and
a name for your
[k}l herien Macintosh.

Staty

(Cstart ) | File sharing is off. Click Start to allow other users |
1 to access shared folders. |

@ Program Linking

Statu:
Start ) | Program Tinking is off. Click Start to allow other |
{users to link to your shared programs. |




. Type a name in the box labeled Owner Name and press
Tab.

Type the name of the primary user of this computer—very
likely, this is you.

. Type your password in the box labeled Owner
Password and press Tab.

Your password can be up to eight characters in length. Your
password prevents others from gaining access to your files
without your permission. After you type your password and
press Tab, it is replaced by bullets () to help keep your
password private.

. Type a name for your Macintosh in the box labeled
Macintosh Name.

If a name already appears in the Macintosh Name box, you can
use that name or type in a new one.

. Close the Sharing Setup control panel.

Your computer is now ready to be used on a network.

Gaining access to files
on other computers

When your computer is connected to a network, you can retrieve
and store information on other computers, including a file server
—usually a computer on the network with special sof tware that
allows you to access it, store files on it, or retrieve files from it.

Files on a file server are stored on shared disks—hard disks or
CD-ROM discs that can be accessed over the network. Private
Macintosh computers (not file servers) on your network might
also have shared disks if they are running system software v‘crsion
7 and if they are using file sharing—the ability to share
information on a private Macintosh. (See “Sharing Your Files Over
the Network” in this chapter.)
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Before you begin
Before you attempt to retrieve or store information on the
network, do the following:

= Find out the name of the shared disk you want to
access and the name of the file server or private
Macintosh that it’s on.

Ask your network administrator for the name of a file server;
ask the owner of a private Macintosh for its name.

= If your network has zones, find out the name of the
zone the other computer is in.

= Find out if you are registered on the computer or if it
allows guest access.

A Macintosh owner or network administrator can limit access
to files on a shared disk. Ask the Macintosh owner or your

network administrator how much access you have to the files.

» If you're allowed access as a registered user, ask the
Macintosh owner or your network administrator for
your user name and your password.

Find out exactly how your name and your password are
spelled, including the use of capital and lowercase letters in
your PZISSWOI'd.

176 Chapter 13: Using Your Macintosh on a Network

Connecting to a shared disk

1;

Choose the Chooser from the Apple menu.

The Chooser opens.

AppleShare File servers and other
icon computers that have shared disks

Select a file server:
Artificial Intelligence — |
ST Artiste
Corner Pocket
[} General Purpose
p——1 Greg's Macintosh
ImageWriter Laser'riter

Kitty Margola's Macintosh

AppleTalk Zones:

Monterey

Niles Davis’'s Macintosh
Engineering Sonoma
Ventura
Marketing 1o
Production
Publications -(KK
Research CJ
@ Active
aoplelalK Q Inactive 7.0
2. Make sure that AppleTalk is active.

Click the AppleShare icon in the upper-left section of
the Chooser window.

If the AppleShare icon does not appear: Make sure that the
AppleShare file is in the Extensions folder in your System
Folder. «



4. If your network has zones, click the zone in which the
computer with the shared disk you want resides.

If you do not see a box in your Chooser labeled AppleTalk
Zones, skip this step.

5. Click the name of the computer with the shared disk
that you want to use.

@ Ifthe name you want isn't listed: Make sure that you have
selected the correct zone. If the zone is correct, ask your
network administrator or the Macintosh owner if the
computer is turned on. You cannot connect to a computer
that’s turned off. <

6. Click OK.

A dialog box appears for you to identify yourself as a
registered user or guest.

&

Connect to the file server "Artiste” as:

Click here if you are
not registered on

O Guest
@ Registered User

Name: [sonathon Jones ] the com.putcr youre
Password: | (scrambleq) connecting to.
((cancel ]  (setpassword] [ ok ||

s

Click Guest or Registered User.

If you are a guest or if you are not certain that you are
registered, click Guest and go to step 10. If you are a
registered user, click Registered User.

If the Guest option is dimmed, guests are not permitted
access to this computer.

If you are a registered user, make sure your user name
is displayed in the box exactly as it is registered.

Any name that appears in the box is taken from the Owner
Name in the Sharing Setup control panel on your computer. If
that name is different from your registered user name on the
computer you're connecting to (or if no name appears in the
box), type your registered user name now.

HONTYIITYT

Type your password.

Type your password exactly as it is registered. Capital and
lowercase letters must match.

If your password is not accepted: Make sure that you haven’t
made any typographical errors. Check that your Caps Lock
key has not been pressed inadvertently. «

continues »
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10. Click OK. 12. Click OK.

When you click OK; the dialog box closes and the icon of the
shared disk appears on the right side of your desktop.

% Artiste

Select the items you want to use:

0 [m] _
fAdam's Folder O | Shared disks
Boilerplate 0j | and folders
Hichner B O

Checked items (X ) will be opened at Shared disk icon

system startup time.

13. Close the Chooser.

Disconnecting from a shared disk

Dimmed items are not available to you, or

you're already connected to them. When you're finished using a shared disk, you can disconnect
from it in three ways (after you've closed any open files or
11. Select the shared disk you want to use by clicking its programs on the shared disk):

fiame. m  Click to select the icon of the shared disk you want to

A dimmed name indicates either that you are already
connected to that shared disk, or that you don’t have access
to it. If a folder or disk you want does not appear, then you
don’t have access to it.
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disconnect from and choose Put Away from the File menu.
Drag the icon to the Wastebasket.

If you are finished working for the day, choose Shut Down
from the Special menu. Your computer is disconnected
automatically when it is shut down.



Using an alias to connect quickly to a shared disk
You can connect to a shared disk quickly by using aliases.

1. Connect to a shared disk.

2. Click to select the shared disk icon.

3. Choose Make Alias from the File menu.

An alias icon appears that has the same name as the shared
disk with the word alias appended to it. The name is selected
for editing.

4. If you wish, rename the alias, then drag it to a
convenient place on your desktop or disk.

5. The next time you want to connect to the shared disk,
open the alias you created in step 3.

If you originally connected to the shared disk as a registered
user, a dialog box appears. Type your password.

If you connected as a guest, this dialog box does not appear.

The shared disk icon appears on your desktop.

Connecting automatically when you start up

You can set up your computer to connect automatically to shared
disks whenever you turn it on.

1

Connect to a computer with the shared disk you want.
You see the dialog box containing a list of shared disks.

Click the checkbox next to the name of a shared disk
that you want to connect to automatically.

% :
Select the items you want to use:

Accounts
Adam's Folder
Boilerplate
Richner Art
Checked items () will be opened
system startup time.

@® Save My Name Only

(O Save My Name and Password

(=) D

OO0
[ I

t

o

continues W
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3. If you're connecting as a registered user, click the
button that indicates whether you want the shared
disk to save your name only or both your name and
your password.

If you select Save My Name Only, you'll have to type your
password when you start up your computer. Click this option
if you want to prevent unauthorized people from gaining
access to the shared disk from your computer.

If you click Save My Name and Password, your Macintosh will
automatically connect to the shared disk when it starts up.

4. Click OK.

5. Close the Chooser.
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Working with files and folders
on other computers

Once you are connected to a shared disk, you can use the files
and folders on it as you would the files and folders on your own
computer. For example, you can

= double-click a folder on the shared disk to open it

= copy afile to or from the shared disk by dragging the file icon
to where you want the copy

In some cases, you are not able to open certain items on a shared
disk because the owner of the computer that has the shared disk
has restricted access privileges to them. Access privileges
determine whether you can see, open, or modify a file or a folder
on a shared disk. To find out how to check your access privileges,
see “Working With Privileges That Others Have Set” in this
chapter.

Creating a new folder on another computer

You can create a new folder on shared disks on other computers
(as long as you have the necessary access privileges). If you are
connected to a computer as a registered user, you become the
owner of any folder that you create on that computer. If you are
connected as a guest, you share ownership of a folder you create
with all guests and registered users. To learn about the access
privileges you need to create a folder, see “Understanding Access
Privileges” in this chapter.



The icons of folders that you own have a darkened tab.

&

When you own a folder, you can set its access privileges to
determine who can use it and in what way. See “Using Access
Privileges” in this chapter for more information.

Changing your password

1. Connect to the computer with the shared disk you
want.

A dialog box appears in which you identify yourself as a
registered user or guest.

&

Connect to the file server "fArtiste” as:

O Guest
@ Registered User

Name: |Jonalhon Jones

Password: :] (Scrambled)

[ cancel |  (setPassword] [ ok |

Click here to change
your password.

2. Click the Set Password button.

A dialog box appears.

If a warning box tells you that you cannot change your
password, your network administrator has prevented you
from being able to do so.

0ld password:

[P
New password: [:

JONTYTITY

Type your current password. Then press Tab and type a
new password.

Abullet () appears for each letter you type. Use a password
that will not be easily guessed by someone else.

Click OK.

A dialog box asks you to retype your new password to verify it.
Click OK.

Retype your password and click OK.

Your new password is now in effect.
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Giving folder ownership to someone else

You can give away the ownership of any folder that you own. Once
you do so, the new owner controls access to the folder and can
restrict your access to it. Make sure that you have moved any files
you may need to another folder that you own before you give up
ownership.

You can only give folder ownership to a registered user or
registered group on the computer to which you're connected.
(See “Naming the People Who'll Have Access to Shared Files” in
this chapter for more information about registered users and
registered groups.)

1. Connect to a shared disk.

2. Click to select a folder that you own.
3. Choose Sharing from the File menu.
+

In the box labeled Owner, type the name of the
registered user or group that you want to give folder
ownership to.

Type the name exactly as your network administrator or the
Macintosh owner has registered it.

5. Close the dialog box.

Another dialog box asks you to confirm that you want to
change the owner of the folder.
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6. Click OK.

The user or group that you named assumes ownership
immediately.

Sharing your files over the network

You can let other people on the network gain access to files stored
on your Macintosh. For example, if you've written a report that
you'd like people in your work group to read, you can let them
connect to your computer and open the file from their own
computers.

You can always control what information you share and whom you
share it with:

= You can share as much or as little as you like.

= You can specify who can use the information on your
computer—one person, a group of people, or everyone on
the network.

= You can gain access to everything on your own computer
from another computer on the network.



How file sharing works

Sharing files on your computer consists of a few discrete steps
that allow you to control exactly how you want to share
information on your computer. This section provides an overview
of these steps. For detailed instructions, continue on to
subsequent sections.

m  First, you turn on the file-sharing capability of your Macintosh.

= Second, you allow others to gain access to the files in
designated folders or disks (you “share” those files).

Anyone on the network can gain access to the folders and
disks you've shared. If you want to share certain files with only
certain people, you continue with the following steps:

m  Third, you name the people (the registered users) whom
you'll allow to gain access to shared files on your computer.

m  Fourth, for each shared folder or disk, you pick from your list
of registered users the people whom you want to have access
to the folder or disk.

m  Fifth, you prevent anyone else from being able to gain access
to the shared folder or disk.

Turning file sharing on

Before you turn file sharing on, make sure that you have named
your Macintosh as described in “Naming Your Macintosh and Its
Owner” earlier in this chapter.

1. Choose Control Panels from the Apple menu and
double-click the Sharing Setup icon to open it.

H

Sharing Setup

The Sharing Setup control panel opens.

Owner Password:

Macintosh Name: [Jonathon Jones's Macintosh |

[i:l File Sharing Click here to

—Status

| File sharing is off. Click Start to allow other | start file sharing.
e e 8

@ Program Linking

Stat

!Prog-u-n linking is off. Click Start to allow other |
j users to link to your shared programs.

continues p
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2. In the section labeled File Sharing, click the Start
button.

When file sharing is turned on, the button is labeled Stop.

3. Close the Sharing Setup control panel and the Control
Panels folder.

File sharing is now turned on. You still need to select a specific
folder or disk to share over the network.

Selecting a folder or disk to share

You can share any folder or disk on your computer—including
hard disks and CD-ROM discs (but not floppy disks). You can
share up to ten folders or disks at one time. (This number does
not include the folders that are within the folders or disks that
you share.)

1. Make sure file sharing is turned on.

2. Select a folder, hard disk, or CD-ROM disc to share by
clicking its icon.

A window appears.

=For All Euesml

Jonathon Jones's Macintosh:
For AllEyes

E' Yhere:

E,Shve this item and its contents

See See  Make
Folders Files Changes

Owner

User /Group: |

Everyone X B X

[J Can’t be moved, renamed or deleted
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to place an X in it.

3. Choose Sharing from the File menu.

Click here to share the
item you've selected.

. Click the box labeled “Share this item and its contents”

To find out more about the access privileges checkboxes—the
ones in the columns labeled See Folders, See Files, and Make
Changes—see “Using Access Privileges” later in this chapter.

save your changes.

. Close the window and click Save in the dialog box to

The folder or disk you shared is now considered a shared
folder or shared disk. Anyone on the network can gain access
to it—and the files and folders inside it—over the network.



If you shared a folder, its icon appears on your desktop with a
darkened tab and network cables connected to it.

aun

:E:

6. Drag any files and folders that you want to make
available to the network into your new shared folder
or disk.

The files and folders that you place in the shared folder or
disk become available to the users who connect to your
computer.

When people on your network are connected to a shared
folder, the icon of the folder on your desktop appears with
faces in the center to indicate that it is in use.

o

ey

:h:

2\ Important: Copyright laws apply to sharing programs over a
network as well as to copying programs from a floppy disk.
Before you put programs inside shared folders or disks, check
with any applicable licensing agreements and follow their
specifications. A

Making a shared folder or disk private

To make a shared folder or disk private again, click to select the
shared disk icon, choose Sharing from the file menu, and click the
“Share this item and its contents” checkbox to remove the X. After
you close the window, the folder or disk and any files or folders
inside it cannot be accessed from the network.

Naming the people who'll have access to shared files

You can share a folder or disk only with specific people on the
network. To do so, you first have to name those people as
registered users or as belonging to a registered group, and then
you have to designate a shared folder or disk as being accessible
to a specific registered user or registered group.

JONTYTITY

Naming a registered user

You can register as many as 100 users and groups of users

combined, but the network’s performance may suffer if you name
more than 50.

1. Choose Control Panels from the Apple menu and
double-click the Users & Groups icon to open it.

i1

Users & Groups

continues »
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The Users and Groups control panel appears. It contains at
least two icons. One (outlined in bold) represents you as the
owner and primary user of your Macintosh.

The other icon is the <Guest> icon. You use this icon to
allow or disallow guests to gain access to the shared files on
your computer. (Guest access is automatically allowed when
you first turn on file sharing.)

EJ&==——= Users & Groups mg]

2 items

Jonathon Jones  <Guest>

=l

] B

You type this name in the
Sharing Setup control panel.

« Ifyou don’t see the bold icon: You haven’t named your
Macintosh and named yourself as its owner. See “Naming Your
Macintosh and Its Owner” earlier in this chapter for
instructions. «

2. Choose New User from the File menu.

An icon labeled New User appears. Its name is selected for
editing.

2,
s

If you can't find the New User command, click anywhere in
the Users & Groups control panel to make it active. <
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3. Type the name of a person on the network whom you

want to make a registered user of your computer.

Make sure that you tell the person exactly how you registered
him or her as a user.

EO====== Users © Groups ===

3 items

2

@ @ : New user icon
Jonathon Jones  <Guest> %

el

=

il

As a registered user, that person has access to any folders or
disks you decide to share.

4. o register more users, repeat steps 2 and 3.

To give your users passwords or to name groups of users,
continue with the next two sections. If you want to start
sharing folders or disks with your users immediately, go to
“Selecting a User or Group to Share a Folder or Disk” in this
chapter.



Setting a user’s password

You can assign passwords for your registered users to help verify
their identities when they want to gain access to your computer.

1. Open a user icon in the Users & Groups control panel.

A window with the name of the user appears.

The user’s name

@ ====== Niles Davis ﬁl

User Password: E— Tpr a paSSWOI’d
for this user here.

File Sharing

(X Altow user to conneot
Allow user to change password

Groups :

I

<

@ Program Linking

3
D Allow user to link to programs
on this Macintosh

2. Type a password in the box labeled User Password,
then press the Tab key.

The password can be up to eight characters long. When you
finish typing the password and press Tab, each character of
the password is replaced by a bullet to help keep that
password private.

3. Close the window and click Save in the dialog box that
appears.

Naming a group of users

You can name a group of registered users as a registered group
and share a folder or disk with the members of that group.

1. Open the Users & Groups control panel and choose
New Group from the File menu.

An icon labeled New Group appears. The name is selected for
editing.

E[J====== Users & Groups ===
9 items

@ @ Group icon
Jonathon Jones <Guest>

Niles Davis Betty Cartier Keith Garretti

HONTITITH

Drag the icons of
E; @ the users you want
in the group to the

Ellen Fitzwater Steven Moreland Bill Evens — L
group 1con.

=]

& =

continues ¥
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2. Type a name for the group.

3. Drag the user icon of each person that you want to be
a member of the group to the new group icon.

You don’t need to drag your Macintosh owner icon to the
group icon because you always have access to the entire
contents of your computer (unless you specify otherwise).
Also, you don’t need to include the <Guest> icon in any
group.

To allow this group of people to gain access to a shared folder
or disk, go to the section “Selecting a User or Group to Share
a Folder or Disk.”
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Seeing who's in a group

= To see the names of the members of the group, open
the group icon.

A window opens and shows a member icon for every user
that you added to the group.

The group’s name

00

3 items

. . . —I Group members

Ellen Fitzwater Betty Cartier Niles Davxs

Testing Team

L]
T

[

el

el =

You can open any user’s member icon if you want to see or
change the settings you've made for that user.



To see the names of all of the groups that a user

belongs to, open the user’s member icon or user icon.

You can double-click either the member icon that appears in
the group window or the original user icon that appears in the
Users & Groups control panel. A window opens and displays a
list of all the groups that the user belongs to.

E(J===== Niles Davis

User Password:  [T00XN)

File Sharing
=

B Altow user to connect
E Allow user to change password

Groups : —
Testing Team

Cracker jack Team
Lunch Group

@ Program Linking

[ Allow user to link to programs
on this Macintosh

The user’s name

The groups the
user belongs to

Selecting a user or group to share a folder or disk

You can give one registered user or group exclusive access to a
shared folder or disk on your computer. Make sure that file
sharing is turned on and that you have named the registered user
or group as described in “Naming the People Who'll Have Access
to Shared Files” earlier in this chapter.

1,

Select a folder, hard disk, or CD-ROM disc to share
with a user or group by clicking its icon.

Choose Sharing from the File menu.
A dialog box appears.

Click the box labeled “Share this item and its contents”
S0 an X appears.

continues P
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4, Choose a user or a group from the User/Group pop-up

menu.

s For Al [yes B

[;I Yhere:

Jonathon Jones's Macintosh:
For All Eyes

[ Share this item and its contents

User /Group:

See See
Folders Files

Owner: B ®

® <None> = =

D Make all cur|

Testing Team = =
Cracker jack Team

Make
Changes

i)
=

[

Lunch Group life this one

[ can’t be mo

Betty Cartier

Ellen Fitzwater
Jonathon Jones.
Keith Garretti
Niles Davis
Steven Moreland

The registered users
and groups you've named
on your computer

The User/Group pop-up menu contains the names of the
users and groups that you registered. The name you choose is

displayed when you are done.
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5. To share this folder or disk with only the user or
group that you've chosen, click the bottom row of
checkboxes (to the right of Everyone) to remove the X
from each box.

Only you and the user or group you've chosen now have
access to this folder or disk. For more information about
access privileges and strategies to use them, see “Using Access
Privileges” later in this chapter.

=== for fll [yes B

Yhere: Jonathon Jones's Macintosh:
For All Eyes
H= 2

[X) Share this item and its contents

See. See Make
Folders Files Changes

Owner: [Jonathondones ¥] ) [
UstrlGroup: X ]
Everyone =]

[ Make all currently enclosed folders Tike this one

[ Can’t be moved, renamed or deleted

6. Close the window and click Save in the dialog box that
appears.



Preventing a user or guests from accessing your computer 3. To deny access to a user, click the box labeled “Allow
user to connect” to remove the X. To deny access to all
guest users, click the box labeled “Allow guests to
connect” to remove the X.

You can prevent a specific user from connecting to your
computer, or you can prevent any guests from connecting.

1. Choose Control Panels from the Apple menu and
double-click the Users & Groups icon to open it.

i1

Uzers & Groups

4. Close the window and click Save in the dialog box that
appears.

If you denied access to a specific user, that user can no longer
access your computer from the network as a registered user.
In addition, that user is no longer a member of any groups. If
the user is currently connected, he or she is disconnected
immediately. If your Macintosh is set up to allow guest access,
2. To deny access to a specific user, open the user icon. To that user can still connect as a guest.

deny access to guests, open the <Guest> icon.

HONTYTITY

If you denied access to guests, any guests currently connected
N , are disconnected immediately.
T'he user’s name

FO= Niles Davis s

User Password:  [TX023003

Removing a user’s membership in a group

To deny access to guests,
Q File Sharing femfiove thie X in this box 1. In the Users & Groups control panel, open the group

(R0 Mo st sonaest by clicking it. icon that the user belongs to.

[ Allow user to change password

2. Drag the member icon for that user to the

Groups:

Testing Team =y k
Craker ok Tean i i te sharing Wastebasket.
= Allow guests to connect
7 _ _ 3. Select Empty Wastebasket from the Special menu.
Jﬁé Program Linking @ Program Linking
e o e o ok o oo The user is no longer a member of that group.

To deny access to this user,
remove the X in this box
by clicking it.
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Removing a user or group from your list of registered users

You can remove a registered user or group at any time. When you
remove a user, that user’s membership in any registered groups
on your computer will be removed.

1. Double-click the Users & Groups icon to open it.
2. Drag the user or group icon to the Wastebasket.
3. Select Empty Wastebasket from the Special menu.

You cannot throw away the <Guest> icon or the owner icon. To
prevent guest access, see “Preventing a User or Guests From
Accessing Your Computer” earlier in this chapter.

Giving away ownership of a folder
or disk on your computer

You can give away ownership of a shared folder or disk on your
Macintosh to another registered user or a registered group.
Because you are the owner of your Macintosh, a new owner of a
folder on your computer cannot restrict your access to it.
However, the new owner can change the access privileges that
other people have to the folder or disk. If you give away
ownership of a folder or disk, make sure that you move any
important folders or documents out of it first so that no one else
can see or alter those documents.
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1. Click to select the icon of a shared folder or disk.
2. Choose Sharing from the File menu.

3. Choose the name of a registered user, group, or
<Any User> in the Owner pop-up menu.

If you select <Any User>, then anyone on the network can
change the access privileges of the folder or disk or choose a
New OWner.

EO==—=== for fll Eyes Beeee——=
m Where:  Jonathen Jones's Macintosh:
Ly ] For All Eyes

[X] Share this item and its contents

See See Make
Folders Files Changes

Owner: | ¢Any User> = = =X
User/Group: | Testing Team 4] =
Cracker jack Team
Lunch Group E & @
[ Make all cur{__Betty Cartier Tike this one

[J can’tbe moy  Ellen Fitzwater
® Jonathon Jones
Keith Garretti

Niles Davis
Steven Moreland

4. Close the window and click Save in the dialog box that
appears.

5. Click OK again to confirm that you want to change
ownership.



Turning file sharing off 2. In the section labeled File Sharing, click the Stop

button.
You can turn off the file-sharing capability of your Macintosh at
any time. When file sharing is off, people on the network cannot If users are currently connected to your computer, a dialog
access any folders or disks on your computer, and you cannot box appears in which you can specify a delay before file
access your computer from another computer on the network. sharing is turned off. This gives current users some time to

, . ' save their work and to disconnect from your computer.
If you turn file sharing back on, all of the shared folders or disks

will again be available to people on the network.

1. Choose Control Panels from the Apple menu and open Sharing s disabled? E
the Sharing Setup control panel. =
2
(cancer ) ox ) =
H
Sharing Setup 3. Type the number of minutes you want to elapse before

file sharing is turned off.

To disconnect users immediately, type the number 0.
Otherwise, type the number of minutes to elapse before the
users are disconnected.

4. Click OK.

File sharing is turned off after the amount of time you specify
elapses. Users who are currently connected receive warning
messages so they can save their work. If someone is using files on
your Macintosh when file sharing is turned off, any changes he or
she has made and has not saved will be lost.
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Monitoring file-sharing activity

When file sharing is on, you can see who is connected to your
computer and what folders or disks you've shared.

= Choose Control Panels from the Apple menu and open the
File Sharing Monitor control panel.

ek
ENut
==l

File Sharing Monitor

The File Sharing Monitor control panel opens.

Folders and disks currently Users currently connected to

being shared are listed here. your computer are listed here.

E0====———— File Sharing Monitor %

Jonathon Jones's Macintosh

__g Shared Items (3 Connected Users

Rt (| et & To disconnect a
LEeren Byes || || user, click his or
o > her name and

File Sharing Rctivity:
| ]

(oisconnest 3—+— then click here.

Idle Busy
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Alist of your shared folders and disks appears on the left side of
the window. All of the files and folders listed are accessible to
network users, unless you have restricted their access privileges.

A scrolling list of all the network users currently connected to
your Macintosh appears on the right side of the window.

Disconnecting someone who is connected
to your computer

You can disconnect users who are currently connected to your
Macintosh in the File Sharing Monitor control panel.

1. Select the user or users that you want to disconnect.

To select more than one user, hold down the Shift key while
clicking the names of all the users you want to disconnect.

2. Click Disconnect.

A dialog box appears.

How many minutes until selected
users are disconnected?

[ cancer ) [ x )




3. Type the number of minutes that you want to elapse
before disconnection occurs.

To disconnect a user immediately, type the number 0.
Otherwise, type the number of minutes to elapse before the
user is disconnected. It's a good idea to give people enough
time to save any changes they have made to the files.

4. Click OK.

If you typed a number greater than 0 in step 3, a box displays
how much time will elapse before the user is disconnected.
The warning box disappears when the user is disconnected.
You can continue with your work in the meantime.

5. When the designated amount of time has elapsed,
close the File Sharing Monitor.

You can’t close the File Sharing Monitor until the amount of
time you specified has elapsed and the user is disconnected.
However, you can open other windows and continue with
your work during that time.

Gaining access to your computer
when you're away from it

You can connect to your own Macintosh from another computer
on the network and access everything on all of the hard disks or
CD-ROM discs attached to your computer. As the owner of your
computer, only you have this privilege.

1. Make sure that file sharing is turned on.

2. Choose Control Panels from the Apple menu and
double-click the Users & Groups icon to open it.

152

Users & Groups

3. Open the owner icon (the one with the bold outline).

ECJ&==== Jonathon Jones ===
With an X in this box, you can
connect to your computer
Q siaishanng from another computer.

é Allow user 1o connect

E Allow user to change password
E::VW keibell b With an X in this box, you
can see everything that's

on your computer.

I

@ Program Linking

D Allow user to link to programs
on this Macintosh

continues
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4. Click the boxes labeled “Allow user to connect” and
“Allow user to see entire disk” to place an X in them if
there isn’t one there already.

When these boxes are checked, you can see and use
everything on your hard disks or CD-ROM discs from another
computer.

To restrict the access you have from another computer, click a
checkbox to remove the X.

5. Close the window and the Users & Groups control
panel.

6. Leave your computer turned on.

To gain access to your computer from another computer, connect
to it as a registered user. Type your owner name and password (as
they appear in the Sharing Setup control panel of your computer).
Then continue the connection process as you normally would.

« Ifyou are unable to connect to your computer: Make sure
that your computer is turned on, that file sharing is turned on,
and that you have given yourself access privileges to connect
to your computer. Also make sure that you type your
password exactly as it is entered in the Sharing Setup control
panel, including the use of capital and lowercase letters. «
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Changing your password

You can change the password you use to gain access to your own
computer from another computer.

1. Choose Control Panels from the Apple menu and open
the Sharing Setup control panel.

H

Sharing Setup

EO====== snaring Setup M’
Network ldentity

Type your new
password here.

J[esseeese ]
Owner Password:

Macintosh Name: |Jonathon Jones's Macintosh

D File Sharing

Status

Efﬂf sharing is off. Click Start to allow other users |
{ 10 access shared folders. |

@ Program Linking

Stat

| Program linking is off. Click Start to allow other |
{ users to link to your shared programs. i




2. Type a new password in the box labeled Owner
Password.

3. Press Tab.

Each character of your password is replaced by a bullet (o) to
help keep it private.

4. Close the Sharing Setup control panel.

Your new password is now in effect.

Using access privileges

When people share information over a network, network users
may want to control what other people can do with that
information. For example, you might want to let people see a file
but prevent them from changing it. This section describes how to
use and work with access privileges—the abilities to see files and
folders and make changes to them.

Before you proceed with this section, make sure you know how to
share a folder on your own computer as described in “Sharing
Your Files Over the Network” earlier in this chapter, or that you
know how to connect to a shared disk on another computer as
described in “Gaining Access to Files on Other Computers” in this
chapter.

Understanding access privileges

You can set access privileges for any shared folders on your own
computer and any folders you create on a file server or on
another Macintosh. In addition, owners of other computers can
set access privileges that restrict what you can do with their

shared disks.

There are three categories of people who can have access
privileges to shared disks and folders:

The owner: The owner of a folder is the only person (or
group) who can control the access privileges of the folder. You
become the owner of a folder automatically when you create
it. You can keep ownership, or give it to a registered user or
registered group on the computer. You can also give
ownership to <Any User>, which allows anyone on the
network, including guests, to modify the folder’s access
privileges.

HONTITITYH

m A vegistered user or group.

m Lveryone. Privileges assigned to guests apply to everyone,

since everyone can connect to a computer as a guest (as long
as guest access is allowed).
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Owners, registered users, and guests can be given three types of Action See Folders  SeeFiles Make Changes
access to shared disks and folders:

m  See Folders allows people to see the folders within a folder or Copy or move files to folder
d1‘sk.‘ If people do not have the See Folders prmlege, folders Byl bl
within a shared folder do not appear on their screen.
. L ) Copy a folder from folder
= See Files allows people to see the files within a folder or disk. l
If people do not have the See Files privilege, files within the Create a folder in folder

folder or disk do not appear on their screen. ] i
Delete a file from folder

m  Make Changes allows people to make changes to a folder or
disk—copy files or folders to it, delete files or folders, or
change any of its contents. Open and use a file in folder

Delete a folder from folder

OO0XOKKODO
HHOKDOORKIDO
HOHKHHOOK

You need different access privileges to do certain operations with Save changes to a file in folder
items in a shared folder or disk.
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Setting access privileges to folders and disks

You can set access privileges for any shared folders or disks on
your own computer and for any folders that you own on other
computers.

1. Select the folder or disk by clicking it once.
2. Choose Sharing from the File menu.

A window appears.

EO======= ror nllEyes e

Yhere: Jonathon Jones's Macintosh:
L For All Eyes

E Share this item and its contents

See See  Make
Folders Files Changes

Owner: B ®
User /Group: =
Everyone E E

[J Make all currently enclosed folders like this one

Use these
checkboxes to set
access privileges.

BRER

[J Can’t be moved, renamed or deleted

This window may be slightly different on your computer.

If you've selected a folder that is inside a shared folder, the
checkbox labeled “Share this item and its contents” does not
appear. Instead, a checkbox labeled “Same as enclosing
folder” appears.

If you've selected a folder on another computer, the area next
to the Owner and User/Group labels will be boxes, in which
you type text, and not pop-up menus.

If you've selected a folder on another computer and you are
not its owner, all of the checkboxes and their labels are
dimmed.

JONTYTITYH

Choose a registered user or group to share the item
with.

If the folder you've selected is on your own computer, choose
from the list of users and groups in the pop-up menu next to
the label User/Group. This menu contains the names of the
registered users and groups on your computer.

If the folder you've selected is on another computer, type the
name of a registered user or group in the box next to the label
User/Group. You must type the name exactly as it is registered
on the computer you're connected to.

continues »
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4. To give access privileges to yourself, to a registered
user, or to everyone, click the appropriate checkbox to
place an X in it.

To set privileges for the folders within this folder or disk,
place an X in the box labeled “Make all currently enclosed
folders like this one.” When you place an X in this box, the
access privileges for the folders inside this folder or disk
are the same as this folder or disk’s access privileges. You
can change the access privileges for an enclosing folder at
any time.

If you use this feature for an item that contains a large
number of folders, such as a CD-ROM disc, this action
could take a few minutes to complete.

To prevent anyone on the network—including yourself—
from moving, deleting, or renaming this folder, place an X
in the box labeled “Can’t be removed, renamed, or
deleted.” You can use this checkbox to ensure that a
folder stays where you leave it.

To give this folder the same privileges as the folder or disk
enclosing it, place an X in the checkbox labelec “Same as
enclosing folder.” This checkbox only appears for folders
that are inside shared folders. When you move a folder
that has this box checked to another folder, its access
privileges change to reflect those of its new enclosing
folder.
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5

When you’re finished setting access privileges, close
the Sharing window and then click Save in the dialog
box that appears.

The access privileges go into effect immediately.

Access privilege strategies

You can combine access privilege settings in any way you like.
Some useful configurations follow.

Allow everyone on the network all access privileges.

When guest access is allowed on the computer storing a
shared folder or disk, everyone on the network can open,
read, and change the files and folders inside it.

Make
Changes

Owner E E E

See See
Files Folders

User /Group X X (<]
Everyone E E E



Keep a folder or disk private.

To keep a folder or disk on your own computer private, do
not share the folder. To keep a folder that you own on another
computer private, use these settings. You have full access but
no one else can open, use, or even see its contents.

See See Make
Folders Files Changes

Owner IZI E E
User /Group | O O
Everyone D D D

Allow access by one other person or group.

This set of privileges allows only you—the owner of the folder
or disk—and the registered user or group that you have
named to gain access to a shared folder or disk.

See See Make
Folders Files Changes
owner 4 (] X

User /Group E & IZI
Everyone D D D

= Keep a folder private but allow others to place files or
folders in it.

People on the network can deposit files or folders into a
folder but cannot see, remove, or change its contents. (This
configuration is sometimes called a drop box.)

See See Make
Folders Files Changes

Owner E E E
User /Group D D @
Everyone D D &

= Set up a folder as a bulletin board.

People can open and read the files in a folder but cannot
change them.

See See Make
Folders Files Changes

Owner X E E
User /Group [} X O
Everyone IZ IZI D
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Working with privileges that others have set

When you are using the By Icon or By Small Icon view, the
appearance of shared folders changes to indicate the kinds of
access you have to that folder.

Icon Meaning

A darkened tab indicates that you are the owner of the folder
and you can set its access privileges. Shared folders on your
own computer have this darkened tab. Folders that you own on
other computers also have the darkened tab.

o A plain tab indicates that you can open and use the folder.
Folders on your own computer have a plain tab when they have
not been shared. Folders on other computers that have this
icon indicate that you do have some privileges to the folders,
although you are not their owner.

A folder with a strap around it indicates that you do not have
any access privileges to this folder. This icon does not appear
ON your Own Computer.

4  Astrapped folder with an arrow indicates that you can put files
or folders into this folder, but you cannot open it or use any
files or folders within it. This icon does not appear on your own
computer.
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Checking your access privileges

When you open a folder on another computer on the network,
icons are displayed under the title bar of the folder window that
indicate the privileges that you do ot have to the folder.

I

= (5]

& X

<[

You can't
make changes.

You can't
see folders.

You can’t
see files.

Linking programs over the network

Some of the programs available for your Macintosh can exchange
information directly with other programs. For example, one
program might be able to instruct another program to perform a
specific action, such as adding a row to a spreadsheet or changing
the font size of a paragraph.

Programs implement program linking in various ways and not all

programs have this capability. See the documentation that came
with your programs for more information.



Linking to a program on another computer 2. If your network has zones, select the zone of the
Macintosh you want to connect to in the lower-left

You can only link to programs that have been shared by the corner of the dialog box.

owners of the computers on which the programs reside.
3. Select the Macintosh you want to connect to in the

1. Within your program, choose the menu command that upper-left section of the dialog box.

allows you to link programs.
4. Select the program you want to link to.

The menu location and command name differ from program
to program. A dialog box opens that you use to find the 5. Click OK.

=
3 3 > z <>}
program on the network that you want to link to. In most cases, a dialog box appears, where you identify =
) ' f < S W Ser, =
Cortputersavailibie for yourself as a guest or a registered user. &
program linking o
o]
Choose a program to link to: %
Nl - Macintoshes Programs Connect to shared disk “Artiste” as:
Artiste G| [[capworks it
Diane's Macintosh The Bottom Line Programs O Guest
IMonterey wordRighter _J available for @® Registered User
Niles Davis's Macintosh lin‘king ?n Name:  [Jonathon Jones =
Ventura B selected
1B Password:
AppleTalk Zones computer
Engineering i
Marketing EIEES
Production =
Publications
Research ‘ Cancel

continues p
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6. Click Guest or Registered User.

If you are a guest or if you are not certain that you are
registered, click Guest and go on to step 9. If you are a
registered user, click Registered User.

If the Guest option is dimmed, guests are not permitted
access to this computer.

7. If you are a registered user, make sure that the name
shown in the box labeled Name is the exact name that
is registered.

If the name is not your user name, type your user name
exactly as it is registered.

8. Type your password, exactly as it is registered
(including capital and lowercase letters).

9. Click OK.

The two programs are now linked.
Disconnecting a program link

To disconnect a link you established to a program on another
computer, quit the program from which you created the link.
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Allowing other people to link to your programs

You can allow people on the network to link their programs to
programs on your computer.

How program linking works

You can allow other users to link to programs on your computer
by taking a few discrete steps.

First, you turn on program linking.

Second, you make a specific program available for linking by
sharing it.

Third, you either allow guest access to the shared program or

name the specific people whom you want to be able to link
programs to the shared program.

When you've completed these three steps, other people can link
their programs with programs on your computer.



Turning program linking on

When you turn program linking on, you let others on the network
connect to your computer for the purpose of linking programs.
Before you turn program linking on, make sure that AppleTalk is
active (in the Chooser) and that you have named your Macintosh
(see “Naming Your Macintosh and Its Owner” earlier in this
chapter).

1. Choose Control Panels from the Apple menu and
double-click the Sharing Setup icon to open it.

Sharing Setup S
Network Identity

Owner Name :

Owner Password: —

Macintosh Name : |Jom\hon Jones's Macintosh

Ej File Sharing

_..Stat

| Fille sharing is off. Click Start to allow other users |
{ to access shared folders. i

@ Program Linking

Status

i Program linking is off. Click Start to allow other ]
Start | i
i users to link to your shared programs. i

Click here to turn on program linking.

2. In the section labeled Program Linking, click the Start
button.

Program linking starts up. When program linking is
established, the button changes to Stop (click the Stop button
when you want to turn program linking off).

3. Close the Sharing Setup control panel.

Once program linking is turned on, you must identify specific
programs for linking before network users can link to them.

Selecting a program for linking

HONTITITH

A network user cannot link to your program unless you have
specifically shared it first.

1. Select a program on your computer that features
program linking by clicking the program’s icon.

Check the documentation that came with the program to
make sure that it has this capability. If the program is open,
you have to quit from it before you can share it.

continues P
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2. Choose Sharing from the File menu. Allowing guests to link to your programs

The Sharing dialog box appears. You can let everyone on the network link programs to your
shared programs.
[J== WordRighter =
— 1. Choose Control Panels from the Apple menu and
&> WordRighter - . .
Rt o o double-click the Users & Groups icon to open it.
hars onttnn ot With an X in this box, thi§ .
................ Yor®hter || 1 program is available for linking to
ket others on the network.
D'Allow remote program linking H

Users & Groups

3. Click the box labeled “Allow remote program linking”
to place an X in it (if there isn’t one in it already).

2. Double-click the <Guest> icon.

If the checkbox is dimmed, the program you have selected

does not allow program linking, so you cannot share it. S

File Sharing

[X] Allow guests to conneot

@ Program Linking

Allow guests to link to programs
on this Macintosh

4. Close the window.

After the window closes, programs on other computers can
link to your program as long as your computer is turned on,
program linking is turned on, and the program is running.

|\Vith an X in this box, guests can link to
programs on your Macintosh.
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3. Click the box labeled “Allow guest to link to programs
on this Macintosh” to place an X in it (if there isn’t one
in it already).

4. Close the dialog box.

Guest users can now link programs to any of the programs on
your computer that you have shared.

Naming specific users to link to your programs

You can identify the registered users and groups you want to
allow to link to your programs. (See “Naming the People Who'll
Have Access to Shared Files” earlier in this chapter for information
about naming registered users and groups.)

1. Choose Control Panels from the Apple menu and
double-click the Users & Groups icon to open it.

=

Uszers & Groups

2. Open the icon of a user whom you want to link
programs with.

O

Niles DavisEicF—= i
< The user’s name

User Password:

File Sharing

E Allow user to connect
@ Allow user to change password

[0

:

Groups:

&

&l
FONTYTITY

Program Linking . . . .
@ With an X in this box, this

All to Tink t: SO C s -
m,m‘ll'is" i user can link programs
with your programs.

3. Click the box labeled “Allow user to link to programs
on this Macintosh” to place an X in it (if there isn’t one
in it already).

4. Close the window and click Save in the dialog box that
appears.

5. To give more registered users access to your programs,
repeat steps 2 through 4.
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Using communications products
with System 7

Using the Communications Toolbox

If you have already installed the Communications Toolbox with
Macintosh system software version 6.0 or later, read the following
guidelines to use the Communications Toolbox with Macintosh
system software version 7.0. Consult the manual that came with
the program that uses the Communications Toolbox for detailed
information about how to use it.

= Do not install the Communications Toolbox. The
Communications Toolbox has been integrated into system
software version 7.0.

= With versions of system software prior to System 7,
communications tools were placed in a Communications
folder in your System Folder. To use communications tools
with System 7, drag them to the Extensions folder in your
System Folder.

= Wherever a program or its documentation refers to the
“Communications Folder,” substitute “Extensions Folder.”
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Using Data Access Language

If you used Data Access Language (DAL) with Macintosh system
software version 6.0 or later, follow the steps below to use it with
Macintosh system software version 7.0. For detailed information
about using your DAL application program, consult the manual
that came with it.

To use programs that search for the “hosts.CL1” file, do the
following:

1. Make a copy of the DAL Preferences file that is in the
Preferences folder in the System Folder.

2. Rename the duplicate file: Hosts.CL1.

3. Move the renamed file outside the Preferences folder
but inside the System Folder.

4. Use your program as you normally do. Whenever you
make changes to one of these files, you must update
the duplicate file.



Chapter 14

Expanding Your
Macintosh System

In this chapter

= Connecting hard disks and other SCSI devices
Installing a device driver
Setting the SCSIID number
Attaching a SCSI device

= Connecting a printer

= Connecting a modem

= Connecting an external floppy disk drive

= Connecting a trackball or other ADB device
= Connecting headphones or speakers

= Connecting a microphone

= Connecting additional monitors

= Installing expansion cards
NuBus™ power requirements
= Expanding memory

Connecting hard disks
and other SCSI devices

Every Macintosh computer has a socket, or port, for connecting
devices that use the Small Computer System Interface (SCSI,
pronounced “skuh-zee”). The SCSI port permits high-speed
communication between the computer and the device. The SCSI
icon appears above the port on the computer’s back panel.

131211109 8 7 6 543 21

0000000000000)) (g
000000000000 SCSlport

252423222120 1918 17 16 15 14

@— SCSIicon

_\ Important: Follow the instructions in this section and the
instructions that came with your hard disk or other SCSI
device when connecting it to your Macintosh.
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SCSI devices commonly used with the Macintosh include hard
disks, CD-ROM drives, scanners, printers, and tape backup drives.

By connecting SCSI devices to one another (in a “daisy chain™),
you can have up to seven such devices, including an internal hard
disk, connected to your Macintosh. Each device must have its
own, unique ID number.

Setting up a SCSI device to use with your Macintosh involves
= installing any necessary device drivers
= setting the device’s SCSI ID number

= physically attaching the device to your Macintosh

Installing a device driver
To install a device driver:
= Drag the device driver icon to the System Folder on

your startup disk.

Any device drivers needed for a SCSI device are usually on a
floppy disk that comes with the device. (If no device drivers come
with the device, then it doesn’t need any.) You may have to restart
your Macintosh to activate the device driver, which the computer
needs to communicate with—or “drive”—the device.
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Setting the SCSI ID number

See the instructions that came with your SCSI device for
information on setting its SCSI ID number.

A Warning: Each SCSI device connected to your Macintosh
must have its own, unique ID number between 1 and 6 so
that your computer can distinguish it from other attached
SCSI devices. Using two or more devices with the same 1D
number can cause them to malfunction. You could lose data
asaresult. A

Give greater ID numbers to the devices you use more often. Your
Macintosh uses the numbers to set priorities when it
communicates with its SCSI devices (the greater a device’s ID
number, the higher its priority).

If you have an Apple SCSI device, set the SCSI ID number as
follows:

1. Make sure the device is switched off.

2. Choose a number between 1 and 6 that hasn’t been
assigned to any other SCSI device connected to your
Macintosh.

Each device in a chain of SCSI devices connected to your
computer must have its own ID number that distinguishes it
from other devices in the chain. The ID number must be
between 1 and 6 (if you have an internal hard disk, its ID
number is preset to 0, and your Macintosh itself has the ID
number 7).



3. Insert a straightened paper clip into the small hole
directly below the ID number indicator (usually on the
back panel of the SCSI device). The small hole gives
you access to the ID number switch.

ID number indicator

B

7

ID number switch

4. Push the ID number switch repeatedly until the
number you want appears in the ID number indicator.

Attaching a SCSI device

To connect a SCSI device to your Macintosh:

1. Turn off your Macintosh.

2. Make sure the SCSI device is switched off.

A Warning: Do not connect or disconnect any device while the

device or your Macintosh is turned on. Doing so could
damage the device, your computer, or both. a

3. Make sure the device has its own, unique ID number
between 1 and 6.

4. Use a SCSI cable to connect the device either to the
SCSI port or to the last SCSI device already in the
chain.

If the device is the first one in the SCSI chain (or the only one
you're connecting), use a SCSI system cable to connect it to
the SCSI port.

If the device is not the first one in the chain, use a SCSI
peripheral interface cable to connect it to the last SCSI device
already in the chain.

_\ Important: The total length of a SCSI chain should not
exceed 6 meters (20 feet). A

5. Make sure that the first device and the last device in
the SCSI chain each have a terminator and that no
other external SCSI device has one.

To ensure accurate transmission of information, a terminator
must be at each end of a SCSI chain.

continues »
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An internal hard disk, which is always the first device in the
chain, has a built-in terminator. The Macintosh Classic,
Macintosh LC, and Macintosh IIfx have built-in terminators
(whether or not they have internal hard disks).

= Ifyou have an internal hard disk, or if your Macintosh has a
built-in terminator, you only have to make sure that the last
device in the chain has a terminator and that no other
external SCSI device has a terminator.

= Ifyou do not have an internal hard disk or a Macintosh
with a built-in terminator and are connecting your
Macintosh to two or more external SCSI devices, you need
terminators in the first device and the last device, and none
in between.

= Ifyou're connecting your Macintosh to a single SCSI device
(whether or not you have an internal hard disk), make sure
the device has a terminator.

If you have a Macintosh IIfx, use the black cable terminator that
came with your computer. Do not use any other terminators with
or instead of the black cable terminator. Also, you or your
authorized service provider should disconnect or remove any
other terminators built into your SCSI devices. Using terminators
other than or in addition to the black cable terminator may cause
your SCSI devices to malfunction, and you may lose data as a
result.
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A SCSI device may have a built-in terminator. If a device that’s at
the end of the SCSI chain does not have a built-in terminator, you
need to attach an external cable terminator to it.

To find out if your SCSI device has a built-in terminator, go to the
instructions that came with the device. (External SCSI devices
from Apple Computer do not have built-in terminators.) Have
your authorized Apple service provider remove any extra built-in
terminators. You can attach or remove cable terminators yourself.

_\ Important: Always turn on any external SCSI devices
connected to your Macintosh before turning on the computer
itself. Otherwise, your computer cannot recognize the SCSI
devices. >

Check the setup book that came with your Macintosh for any
additional information on connecting SCSI devices.



Connecting a printer

Every Macintosh has a printer port, which you use to connect a
printer to your computer.

ooo Printer port
oo o
oo

:}——— Printer porticon
T

The printer port accepts either a direct cable connection (to
printers such as the ImageWriter II) or a network cable connection
(to printers such as the LaserWriter IINT). Certain printers (such
as the Personal LaserWriter SC) are connected through the SCSI
port as a SCSI device.

Follow the instructions that came with your printer when
connecting it to your Macintosh.

A printer can also be connected to the modem port. You use the
Chooser program to indicate the port you used to connect your
printer. (See Chapter 12, “Printing,” for more information.)

Connecting 2 modem

Every Macintosh has a modem port, which you use to connect an
external modem to your computer. (A modem is a device that
allows your computer to communicate with other computers over
standard telephone lines).

% Modem port

M&\d()dcm port icon

Follow the instructions that came with your modem when
connecting it to your Macintosh.

HONTYTITY

You can connect a modem to the printer port (if you're not using
it for a printer), but your Macintosh gives the modem port priority
over the printer port when it checks for data transfer activity. This
priority better ensures that any communications link your
computer establishes through the modem remains intact.
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Connecting an external floppy disk drive

Some Macintosh computers have a disk drive port, which you use
to connect an external floppy disk drive.

©) \\°0.0000000 9/f ([G)—Disk drive port
000000000

(U) +— Disk drive port icon

Follow the instructions that came with your external floppy disk
drive when connecting it to your Macintosh.

If your Macintosh does not have a disk drive port, you can buy an
external floppy disk drive that attaches to the SCSI port.
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Connecting a trackball or
other ADB device

Every Macintosh computer has at least one Apple Desktop Bus
(ADB) port, which you use to connect the mouse, the keyboard,
and other input devices such as a trackball, a bar-code reader;, or a
graphics tablet.

By connecting ADB devices to one another (in a “daisy chain”),
you can have up to three such devices connected to a single ADB
port. The exact number depends on how much power the devices
require.

2\ Important: The total power used by all Apple Desktop Bus
devices connected to your Macintosh must not exceed
500 milliamperes (mA). Information about the power
requirements of your mouse and keyboard are in the setup
book that came with your Macintosh. See the instructions that
came with any other ADB device if you need information on
its power requirements. -



Connecting headphones or speakers

Every Macintosh computer has a sound output port, which you
use to connect speakers, an amplifier, headphones, or other audio
output devices to your computer. The sound output port accepts
a standard stereo miniplug, like that used to attach headphones to
a portable stereo audio cassette player.

Sound output port

ﬂ >>>— Sound output icon

Connecting a microphone

Certain Macintosh models (such as the Macintosh LC) have a
sound input port, which you use to connect a microphone or
other sound source to your computer. The sound input port

accepts a standard miniplug.

Sound input port
@— Sound input icon

See the setup book that came with your Macintosh for additional
information on the sound input port.

HONTITITYH

See Chapter 11, “Adapting Your Macintosh to Your Own Use,” for
information about recording sound on your Macintosh.
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Connecting additional monitors

Most Macintosh computers accept video cards that let you
connect additional monitors. Your first monitor may be built-in (as
in the Macintosh Classic), connected to a built-in video port (as in
the Macintosh Ilci), or connected to a video card installed in a
NuBus slot (as in the Macintosh IIfx). See the setup book that
came with your computer for information on installing video
cards.

When you set up additional monitors:

= Make sure that the ventilation openings on the computer and
the monitor are clear and unobstructed.

= Some large monitors cannot safely be placed on top of the

Macintosh. Check the instructions that came with the monitor

for setup information.

» If there is interference on your screens or on a television or
radio near your Macintosh, move the affected equipment
farther apart.

See Chapter 11, “Adapting Your Macintosh to Your Own Use,” for
information on configuring multiple monitors in the Monitors
control panel.
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Installing expansion cards

All Macintosh computers except the Macintosh Classic accept
printed circuit boards (called cards) for video and graphics
applications, networking and communications, additional
processing power, and other purposes. The cards fit into
connectors, called expansion slots, inside the computer.

2\ Important: See your setup book for information on installing
expansion cards. Some cards may need to be installed by an
authorized Apple service provider.

Like all electronic components, expansion cards generate heat. If
you install several cards in your Macintosh, leave as much room as
possible between cards and between cards and other internal
components.

Macintosh expansion slots come in two types:
m  NuBus slots, which accept NuBus expansion cards

s Processor-direct (or memory cache) slots



All Macintosh I models have at least one NuBus slot. (An optional
slot adapter is required in the Macintosh IIsi.) In the models that
have a processor-direct or memory cache slot (such as the
Macintosh LC and the Macintosh Ilci), only one such slot is
available.

A Warning: Install an expansion card only in the slot designed
to accept it. Failure to do so could damage the card and your
computer. NuBus cards fit in any NuBus slot, but a processor-
direct or memory-cache card is often designed only for a
specific Macintosh model. a

NuBus power requirements

The combined power consumption of all installed NuBus cards
must not exceed the limits specified for your Macintosh model. If
you have two or three NuBus cards installed or are concerned
about the amount of power consumed by a particular card, make
sure that your NuBus cards’ power consumption is within
specified limits.

1. Find out the power consumption (in amperes) of each
NuBus card you have installed by checking its
technical specifications.

NuBus cards draw power from three types of current:

s +5volt
s +12volt
s —12volt

2. Calculate the total power consumption in each type of

current of all installed NuBus cards.

3. Find out the maximum power consumption for all

NuBus cards specified for your Macintosh by checking
the setup book that came with your computer.

A Warning: Do not exceed the maximum power consumption

for all NuBus cards specified for your computer. Doing so
could damage your cards, your Macintosh, or both. A
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Expanding memory

The random-access memory (RAM) in your Macintosh can be
expanded by adding Single In-Line Memory modules (or SIMMs)
to those already installed or exchanging installed modules for
ones that have greater storage capacity. (Some Macintosh models
also accept memory expansion through the installation of a
memory card.)

Make sure that SIMMs you purchase for memory expansion are
the correct ones for your Macintosh. See the setup book that
came with your computer for more information.

A Warning: Memory expansion on the main circuit board
should be installed only by an authorized Apple service
provider or other qualified technician. Modification of the
circuit board by anyone except a qualified technician voids
your warranty and could damage your computer. A
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Chapter 15

Care and Maintenance

In this chapter

= Handling system components
Monitor
Keyboard
Floppy disks and drives
Power supply

= Cleaning system components
Cleaning the mouse

= Maintaining the proper operating environment
= Changing the clock battery

= Service and support

Handling system components

Follow these guidelines when setting up and using your
Macintosh computer and its components:

Handle all components with care.
Place components on a sturdy, flat surface.

Carefully follow all setup instructions.

Always hold a cable by its connector (the plug, not the cord)

when connecting or disconnecting it.

Never force a connector into a port. If connector and port do

not join with reasonable ease, they probably do not match.

Make sure that the connector matches the port and that you

have positioned the connector correctly in relation to the
port.

Turn off your Macintosh and all its components before

connecting or disconnecting any cables to add or remove any

component. Failure to do so could seriously damage your
equipment.
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m Take care not to spill any food or liquid on the computer,
keyboard, mouse, or other components. If you do, turn your
Macintosh off immediately and unplug it before cleaning up
the spill. Depending on what you spilled and how much of it
got into your equipment, you may have to bring your
equipment to an authorized Apple service provider.

A Warning: Plug the power cords for the Macintosh and its
components only into three-prong, grounded outlets. The
computer’s grounding-type plug is a safety feature. Do not
defeat the purpose of this plug. Disconnect the power plug if
it becomes frayed or otherwise damaged. A

Monitor

Follow these procedures whether your Macintosh has a built-in or
a separate monitor:

= Turn down the screen brightness control if you leave the
Macintosh turned on for extended periods. If the brightness is
not turned down, the image on the screen could “burn in”
and damage the screen.

You can also use a “screen saver” program, which dims or
varies the image on the screen when the Macintosh has been
idle for a specified period of time. These programs are
available from independent suppliers and user groups.
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Make sure that the ventilation openings on the computer and
the monitor are clear and unobstructed.

Some large monitors cannot safely be placed on top of the
Macintosh. Check the instructions that came with the monitor
for setup information.

If there is interference on the monitor’s screen or on a
television or radio near your Macintosh, move the affected
equipment farther away.

Keyboard

Take care not to spill any liquid on the keyboard. If you do, turn
off your Macintosh immediately.

s Ifyou spill liquid that is thin and clear, unplug the keyboard,

turn it upside down to let the liquid drain out, and let it dry
for 24 hours at room temperature. If, after you take these
steps, the keyboard doesn’t work, take it to your authorized
Apple service provider for repair.

If you spill liquid that is greasy, sweet, or sticky, unplug the
keyboard and take it to your authorized Apple service
provider for repair.



Floppy disks and drives Power supply

The power supply in your Macintosh is a high-voltage component
Store disks at and should not be opened for any reason, even when the

{g:fgéﬁ[;'{)f,; Do not use computer is off. If the power supply needs service, contact your
C an eraser . O el .
and 125°F. ofi 4 disk iabsel. Keep disks dry. authorized Apple dealer or service provider.
125°F (52°C ) S— . ,
” : by Cleaning system components
; =
‘ To clean the outside of your Macintosh and its components: E
; " =
I:“ »  Use adamp, soft, lint-free cloth to clean the computer’s b
] exterior. Avoid getting moisture in any openings. o
& sl getung yop | 8 Z
B0 -l = Don’t use aerosol sprays, solvents, or abrasives.
T~ Pl
m o clean the screen, put household glass cleaner on a soft
cloth and wipe the screen. Don’t spray the cleaner directly on
E“ the screen, because the liquid might drip into the monitor or
E computer.
Do not touch the Keep disks away Avoid exposing
exposed part of the  from magnets. disks to extremely
disk behind the hot temperatures.

metal shutter.
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Cleaning the mouse 3. Turn the mouse right side up with one hand and catch

_ the ring and the ball with your other hand.
The mouse contains a small ball that must roll smoothly for the

mouse to work properly. You can keep this ball free of dirt and
grease by using the mouse on a clean, lint-free surface and
cleaning it occasionally.

You need a few cotton swabs, alcohol, and a clean, soft, lint-free
cloth.

1. Turn off your Macintosh.
4. Clean the three small rollers inside the mouse with a

2. Turn the mouse upside down and remove the plastic stiofswalmoistened with aleghol.

ring on the bottom that holds the ball.

o , Rotate the rollers to clean all around them.
The plastic ring comes in two types. You remove one by

turning it counterclockwise; you remove the other by pulling
the ring downward until it pops out.

N\
AN

\
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5. Wipe the mouse ball with a clean, soft, dry, and lint-
free cloth.

Don't use any liquid to clean the ball.

6. Gently blow into the mouse case to remove any dust
that has collected there.

7. Put the ball and the ring back in place.

Maintaining the proper operating
environment

In general, any conditions in which you are reasonably
comfortable should be fine for your Macintosh.

s See the setup book that came with your computer to find out
the range of temperature and humidity that your Macintosh is
designed to operate within.

= Protect the Macintosh and its componenis from direct
sunlight and rain or other moisture.

m  Keep all ventilation openings clear and unobstructed. Without
proper air circulation, components can overheat, causing
damage or unreliable operation.

Changing the clock battery

Every Macintosh computer has a clock that runs continuously.
When the computer is turned off, a battery keeps the clock
running.

If your clock begins to keep time inaccurately, have your
authorized Apple service provider replace the battery.
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Service and support

To help you get the best performance from your system, Apple
Computer has established authorized Apple dealers who offer full
support. If you need answers to technical questions or
information about product updates, your authorized Apple dealer
can help you. Apple’s technical support organization backs each
dealer and international technical support group via an AppleLink
network, a state-of-the-art on-line electronic information service,
to ensure prompt, reliable assistance.

Your dealer has the latest information on new hardware and
software products as well as product updates. If you wish to
upgrade your system, your dealer can help you select compatible
components.

If your product requires service, your local authorized Apple
dealer is trained and ready to support you. Apple provides factory-
quality parts and the latest available diagnostic equipment to the
more than three thousand authorized Apple service centers
throughout the world. Apple guarantees parts and warranty labor.
(Regulations in each country determine the length of warranty.
Some restrictions may apply, depending on the country of original
purchase.)

o
o
SN
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If for some reason you cannot return to the authorized dealer
from whom you purchased your system, go to the nearest service
location. For the location nearest you, in the United States or
Canada, call or write to one of the following:

Apple Computer, Inc.
Customer Relations
20525 Mariani Avenue

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario, L3R 5G2

Cupertino, CA 95014-6299 Canada
USA. 800-268-7796 or
800-538-9696 800-268-7637

For locations in other countries, either call the Apple
headquarters in your country or write to the United States
address given above.

Apple also offers service plans designed to meet your needs. One
of these is the AppleCare Service Agreement (available in the
United States, Canada, and Australia only), which extends full
warranty coverage up to three years. Your AppleCare contract will
be honored at any participating authorized Apple dealer within
the country of purchase—an added benefit if you relocate. Local
service means time saved in getting your Apple system back to
work.

You can purchase AppleCare at any time, but it’s a good idea to
purchase it with your system, or at least before your warranty has
expired, to avoid an inspection at your own expense.



Chapter 16

Tips and Troubleshooting

In this chapter

Getting the best-looking fonts
Taking a “snapshot” of the screen

When you run into trouble
Take your time
Start over
Rebuild your desktop regularly
Solutions to common problems

Getting the best-looking fonts

To have fonts look their best on the screen, install bitmapped
fonts in the sizes you use most often. And for the closest match
between displayed fonts and printed fonts, install the
corresponding bitmapped fonts when you install PostScript
outline fonts.

Your Macintosh looks for either outline fonts or bitmapped fonts
to use depending on

= whether the font is displayed on the screen or printed on a
printer, and

= whether (if the font is printed) the printer is equipped to
handle PostScript (a programming language that describes the
characters, symbols, and images appearing on each page of a
document)
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When you print a document on a PostScript printer (such as the
LaserWriter IINT), the system software looks for the fonts you use
in the following places, in order:

L.

N

0.

PostScript outline fonts in the printer’s permanent memory
(ROM)

PostScript outline fonts in the printer’s temporary memory
(RAM)

PostScript outline fonts in any hard disk connected to the
printer

PostScript outline fonts in your System Folder
Truelype outline fonts in your System Folder
bitmapped fonts in your System Folder in the correct size

bitmapped fonts in your System Folder in a different size that
can be reduced or magnified to roughly approximate the
correct size
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When you print a document on a printer that does not recognize
PostScript (such as the Personal LaserWriter SC), and when the
Macintosh displays fonts on the screen, the system software looks
for the fonts as follows:

1. bitmapped fonts in your System Folder in the correct size
2. Truélype outline fonts in your System Folder

3. bitmapped fonts in your System Folder in a different size that
can be reduced or magnified to roughly approximate the
correct size

Taking a “snapshot” of the screen

You can capture the image on the screen by pressing 88-Shift-3.
The image is saved as a graphics file, which can be opened in
many programs that handle graphics (including the TeachText
program that’s supplied with the system software).

The graphics files are named “Picture 1,” “Picture 2,” and so on.
The number of screen images you can take is limited only by
available disk space.

When you run into trouble

For specific troubleshooting information related to a particular
procedure, go to the chapter that describes the procedure.



Take your time

When you see an error message, you don’t have to take action
immediately. The message stays on the screen until you click the
OK button or turn off the Macintosh.

To help diagnose and correct the problem, gather as much
information about the situation as you can before starting over:

= Make a note of exactly what you were doing when the
problem occurred. Write down the message on the screen and
its ID number (if any) as well as the programs you were using
and the names of any items you know have been added to the
System Folder since the system software was installed. (This
information will help a service person diagnose the problem
should you need to take the computer to your authorized
Apple dealer for repair.)

= Check the screen for any clues. Is a menu selected? What
programs and document icons are open? Note anything else
that seems relevant.

= Ifyou were typing text and were not able to save it before the
problem occurred, you can write down the parts of the text
still visible on the screen so that some of your work will be
easy to replace.

= Ask other Macintosh users about the problem you're having;
they may have a solution for it.

Start over

Often you can eliminate a problem simply by clearing the
computer’s memory and starting over.

If you can, save any open documents before restarting the
Macintosh. If your system is “frozen” and does not respond to any
input, or if you have a “bomb” message on the screen, saving may
not be possible. You can try pressing 3-Option-Esc to quit the
program in use when the problem occurred; if this works, you can
then save the documents open in other programs before
restarting.

To restart your Macintosh, try the following steps:

1. Ifyou can, choose Restart from the Special menu or
from the dialog box that’s on screen.

2. If you can’t choose Restart, hold down the 3 and
Control keys while you press the Power On key.

3. If nothing happens, look for the reset and interrupt
switches on the front or side of your Macintosh and
press the reset switch (the one marked with a
triangle).

Not all Macintosh models have reset and interrupt switches,
which are usually installed as a unit when the computer is first
set up.

Pressing the reset switch is like turning the power switch off
and on. (The interrupt switch is intended for use by
programmers who have debugging software installed.)

continues P
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4. If pressing the reset switch does nothing or if your
Macintosh does not have a reset switch, turn off your
computer using the power switch, wait at least 10
seconds, then turn it on again.

5. If the power switch doesn’t turn off the computer,
unplug your Macintosh.

If you suspect that the problem is with a peripheral device, such
as a printer or external hard disk, turn it off for 10 seconds or
more, then turn it on again and restart the Macintosh.

Rebuild your desktop regularly

A process known as “rebuilding the desktop™ helps your
Macintosh keep track of data on your startup disks.

m To rebuild the desktop of a startup disk, hold down the
Option and & keys while starting up your computer. Keep
holding down the keys until you see a message asking
whether you want to rebuild the desktop. Click OK.

= Rebuild the desktop of your startup disks once a month or so.
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Solutions to common problems

The computer is turned on but the screen is dark

The Macintosh or the monitor is not getting power, or the screen
is adjusted too dark.

Check that the power cord is plugged in and firmly connected
to the computer and that the electrical outlet has power.

If you have a separate monitor, check that the monitor is
turned on.

Check the screen’s brightness control and turn it up if
necessary.

If you use a screen saver program, press a key or move the
mouse to turn off the screen saver.



When you start up, an icon appears in the middle
of the screen and the desktop doesn’t appear

The system software is not installed on your hard disk or your
hard disk is not working properly.

When you turn on the Macintosh, one of these icons appears in
the middle of the screen:

m The “happy Macintosh” icon indicates that your Macintosh
has found a startup disk (which has the system software
installed in the System Folder) and is starting up.

K

—

m  The disk icon with a blinking question mark indicates that
your Macintosh cannot find a startup disk. If you inserted a
floppy disk, or if you have a hard disk installed, your
Macintosh doesn’t recognize that disk as a startup disk.

Use the system software disk labeled Disk Tools to start up
your Macintosh. (See “Starting Up With a Floppy Disk” in
Chapter 8, “Setting Up Your Macintosh System,” and “Testing
and Repairing Disks” in Chapter 9, “Hard Disks and Floppy
Disks,” for instructions on starting up with a floppy disk and
repairing damaged disks.)

The disk icon with an X appears when your Macintosh ejects a
floppy disk that is not a startup disk.

The “sad Macintosh” icon appears when your Macintosh
cannot start up because of a problem with the system
software or possibly the computer hardware.

o
-
—

Eject any floppy disks by turning off the computer and then
holding down the mouse button while you turn the computer
on again. Try starting up with a different startup disk. If the
“sad Macintosh™ icon appears again, see your service provider.
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The pointer doesn’t move when you move the mouse

The mouse is not connected properly or its signals are not
reaching the computer.

m Turn off the computer using the power switch, then check
that the mouse cable is connected properly.

<

m Clean the mouse. (See Chapter 15, “Care and Maintenance.”)

= Restart the Macintosh with a different startup disk. If the
pointer still doesn’t move, consult your service provider.
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Typing on the keyboard produces nothing on the screen

The insertion point hasn’'t been set, no text is selected, the
keyboard is not connected properly, or its signals are not reaching
the computer.

Make sure the program you want to type in is the active
program.

Place the pointer in the active window and click to set an
insertion point or drag to select text (if applicable).

Turn off the computer, then check that the keyboard cable is
connected properly at both ends.

If the connections are secure and typing still yields no results,
shut down and turn off the Macintosh, then unplug the
keyboard cable. Connect the cable to the other Apple Desktop
Bus port on the computer and the other ADB port on the
keyboard. (You may have to unplug the mouse to do this.) If
typing still shows nothing on the screen, the problem is most
likely in the keyboard itself.

Restart the Macintosh with a different startup disk. If typing
still doesn’t produce text on the screen, see your service
provider.



A dialog box with a bomb appears

Your system has a software problem.

Write down what you were doing when the message
appeared, and write down the number on the message, if
there is one.

Restart your Macintosh (see “Start Over” earlier in this
chapter).

Check the startup disk and program you were using when the
message appeared. Make sure that all programs, desk
accessories, and system extensions you're using are
compatible with the system software. Reinstalling the system
software may correct the problem.

Sometimes incompatible system extensions or control panels
can cause system software problems. Restart while holding
down the Shift key; this disables all system extensions. If
startup is normal with this method, then remove all
extensions and put them back into the System Folder one at a
time, starting up after you add each extension. This procedure
should identify any incompatible extensions.

The pointer “freezes” on the screen

Your system has a software problem.

Press 88-Option-Esc to close the program in use when the
problem occurred. If this works, you can then save the
documents open in other programs before restarting.

Restart your Macintosh (see “Start Over” earlier in this
chapter).

Check the startup disk and program you were using when the
message appeared. Make sure that all programs, desk
accessories, and system extensions you're using are
compatible with the system software. Reinstalling the system
software may correct the problem.
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Your program quits unexpectedly

The program needs more memory than your Macintosh has
available, or the program requires a floating-point unit (FPU) and
your Macintosh doesn’t have one.

= Quit from the programs that you have open and then open
the program you want to use, or restart your Macintosh.

»  Check the documentation that came with the program to find
out if the program requires a Macintosh with an FPU, and
check the setup book that came with your Macintosh to find
out if your computer is equipped with an FPU, or if an FPU
can be installed. Consult your authorized service provider for
information about installing an FPU in your computer.

| S
o
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Working on the

Macintosh Desktop

In this chapter

Using the mouse
Working with icons
Working with windows
Working with menus

Keyboard shortcuts in the Finder
and in directory dialog boxes

Working with disks

Working with programs

Using the mouse

Point

= Point to an object on screen by moving the mouse so
that the pointer is over that object.

When the pointer is an arrow, the tip of the arrow must be
over the object.

Click

= Click an object on screen by pressing and quickly
releasing the mouse button while the pointer is over
that object.

Clicking an object selects it.
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Drag

m Drag an object on screen by pointing to that object and
holding down the mouse button while you move the
mouse.

Dragging an object from one disk to another copies it,
dragging an object from one place to another on a single disk
moves it within that disk without making a copy, and dragging
an object to the Wastebasket throws it away.

Press

u Press by holding down the mouse button without
moving the mouse.

Pressing a menu name opens the menu.
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Double-click

s Double-click an object on screen by pointing to the
object and clicking twice in rapid succession, without
moving the mouse.

Double-clicking is a common shortcut for opening an icon or
the selected item in a directory dialog box.

Shift-click

= Hold down the Shift key while clicking.

Shift-clicking is a way to select more than one icon or item
in a list.



Working with icons

Icons on the Macintosh desktop represent disks (floppy disks and
hard disks) and files (programs and documents). When you open
an icon, its window appears, showing you what's “inside” the disk

or file.

Selecting icons

To do this Take these steps
Select an icon Click the icon.

Deselect an icon

Select multiple icons

Deselect an icon in a
group of selected icons

Select multiple icons
that are near each other

Select contiguous icons
in a list

Select text in an icon’s
name

Click anywhere except the selected icon.

While holding down the Shift key, click
each icon.

While holding down the Shift key, click
the icon.

1. Place the pointer at one corner of the
group of icons.

2. Drag diagonally to select the icons, then
release the mouse button.

1. Place the pointer to the left of the top icon
or the bottom icon.

2. Drag up or down the list, releasing the mouse
button when the pointer is left of the last icon.

1. Click the icon’s name to select it.

2. Place the pointer at one end of the text
to be selected.

3. Drag to select the text, then release the mouse
button.

Opening an icon

You open an icon by selecting it and choosing Open from the File
menu or using the keyboard shortcut 8- O or 8-Down Arrow. Or
you can double-click the icon.

Moving, copying, and renaming an icon

To do this Take these steps

Move an icon Drag the icon to where you want it.

Copy an icon onto Drag the icon to the icon of the other disk (or to
another disk an icon or window that belongs to that disk).

Copy an icon on the
same disk

Rename an icon

1. Click the icon to select it.

2. Choose Duplicate from the File menu, or
press §-D.

3. If you wish, rename the icon and drag it to a
new location.

You can also make a copy by holding down the

Option key while you drag the file’s icon to

where you want the copy.

1. Select the icon’s name by clicking the name
(not the icon).
2. Type a new name and press the Return key.
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Storing icons in a folder

Drag the icons to the folder until both the icons and the folder are
selected, and then release the mouse button.

Removing an icon

You remove an icon from the desktop or any Finder window by
dragging it to the Wastebasket. To erase the contents of the icon
from your disk, you choose the Empty Wastebasket command
from the Special menu.

The Wastebasket displays a warning before its contents are
discarded. You can’t throw away a locked file or an item that’s
currently in use.
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Working with windows

A window appears when you open an icon to show you what'’s
“inside” the icon.

Making a window the active window

You make a window active by clicking inside it. You may have to
move or resize other windows if the one you want to make active
is covered by other windows. You can also make a window active
by clicking its icon (even though it’s dimmed) and choosing Open
from the File menu, or by double-clicking the dimmed icon.



Moving a window and changing its size Scrolling through the contents of a window
To do this Take these steps

Trees S ]S

12 items 11.5 MB in disk 7.5 MB available
Move a window = Drag the window’s title bar (at the — | Scroll box (shows relative
=! = R 7 :
T top of the window) to the new System Folder \ AppTications location in window)
location.

For Channing  Notes-Kate

Resize a window Drag the size box (in the .
rom Andy

lower-right corner). Sarans report

Reports/Lisa

TeachText

Or click the zoom box (in the For Fimi
upper-right corner). Il - 5o

-~
o
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| Scroll arrow (used | Every window has two scroll bars, one for vertical

to view the content  scrolling and one for horizontal scrolling. (A gray

Close a window Click the close box (in the

beyond the scroll bar indicates more content beyond window’s
upper-left corner). window’s borders)  borders; a clear bar indicates all content is visible.)
Or choose Close from the File
menu. J ;
Or press %V, m  Click the up, down, left, or right scroll arrow.
m  Click the vertical or horizontal scroll bar (when it’s
gray).
= Drag the vertical or horizontal scroll box along its
scroll bar.
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Opening higher-level folder windows

You can open a higher-level folder window (whose contents
include the active window) from a pop-up menu in the active
window’s title.

1. Hold down the 3 key as you press the active window’s
title.

A pop-up menu of the higher-level folders (and disk) appears.

2. Drag to choose a higher-level folder (or the disk), and
then release the mouse button.

The folder (or disk) window you chose appears as the active
window.

Open pop-up menu with the
name of the active window
at the top (“Old reports”)

3 01d reports
Name 3 JH status

Do +.do Walthrop

D) Etizabeth 4/1

D Jeremy's Stdtus 6/20

: E|— Active window showing the
| Kind contents of the folder
ModemLink doc|t]  named “Old reports”
3K MemoVriter do
12K ModemLink doc fi

This folder contains the folder “Old reports.”

If you hold down the Option key as well as the 8 key, the old
window closes when the new window appears.
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Using the outline form in list views

Any list view you choose from the View menu (that is, any view
except the icon and small icon views) shows the contents of the
active window in outline form. You can see the contents of a
folder without opening the folder in its own window.

Open folder (with contents
indented below)

=———— JH data/2
Name Size Kind
= 01 Art ideas — folder ||
D ristview 7K document
< T:crem shots - folder
g D) screent 14K document Open folder inside
D Caspar maps == folder &
D credit union sccount 17K document another folder
D|read Me 1K TeachText dod (Wi[h contents
D Cfscreens 3K alias .
GTeachText 43K application pr 3 lnden[ed bClOW)
@ &
A downward-pointing triangle indicates that the folder’s

contents are displayed; a right-pointing triangle
indicates that the folder’s contents are not displayed.

Click the triangle next to a folder name to display or hide the
folder’s contents in the active window.

If you double-click a folder, it opens in its own window, and its
outline view closes.

< Shortcuts: When a folder is selected in an outline view,
pressing &-Right Arrow displays the list of its contents and
88-Left Arrow hides the list of its contents. <



Working with menus Pop-up menus often appear in dialog boxes that you use to set
options or preferences. You can recognize a pop-up menu by a
Macintosh menus come in two types: pull-down menus and small solid triangle, pointing down, next to its name. The name
pop-up menus. The menus in the menu bar are pull-down menus. shows the current option or preference.

The Help menu, which

Pop-up menu (closed
Menu bar (you you use to display 5 ( )
pull down menus ettt information about items RN
from here) on the screen .

op v} Clicking the triangle
5] = Walthrop displays the menu (but

does not allow you to
-E ject & g
choose a menu item).

2 App. programs
O fArtideas

o art-10/4

O Carinfo

[ Caspar maps
D credit union accounp | e
O Envelopes
O Glossary

0O JH as writer

& File Uiew [Label _special | @ @ 3+ The Application
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1 poste programs that
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Cancel

Clicking the menu title or the icon displays
the menu and selects the title (allowing you
to choose a menu item by dragging to it).

Dimmed command Menu commands affect
(not available) whatever you've selected—
in this case, “Hard disk #2.”
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Choosing an item from a menu : 3. Drag sideways to the submenu, drag down to the
submenu item you want to choose so that it’s

To choose a command from a menu, point to the menu name, highlighted, and then release the mouse button
; :

press to “pull down” or “pop up” the menu, drag to the item you
want to choose so that it’s highlighted, and then release the
mouse button.

.
Justify Bold
Spacing

Choosing an item from a submenu fialic

Underline

Some menu items are submenus. A submenu name has a small /%Jmm@nmﬁ ouiline
solid triangle next to it, pointing to the right. The submenu opens 1 Shadom

when the submenu name is highlighted.
To choose an item in a submenu:

1. Point to the menu name and press to pull down or pop
up the menu.

2. Drag to the menu item so that the submenu appears.

Justify ! > aal

Bold
Spacing ) f?a/fr
Underline
\/%Jmmmﬂmﬂ Outling
12 Shacdom

240  Summary: Working on the Macintosh Desktop



Keyboard shortcuts in the Finder and
in directory dialog boxes

Key Action

Up, Down, Left, Selects the next item in the direction of the

or Right Arrow key arrow

Tab key Selects the next item alphabetically (exceptina
directory dialog box and the Chooser)

Character Selects the first item whose name begins with

key (a, b, c...) that character (or the character following
closest to it in the alphabet)

—Down Arrow Opens the selected icon

38-Option—-Down Arrow

3#—Up Arrow

38-Option—Up Arrow

Return or Enter

Opens the selected icon and closes the current
folder

Opens the folder that contains the current folder

Opens the folder that contains the current
folder and closes the current folder

In the Finder: Selects the selected icon’s name
for editing or saves the edited name

In a dialog box: the same as clicking the button
with the bold outline around it

Working with disks

See Chapter 9, “Hard Disks and Floppy Disks,” for more
information about using disks.

Inserting a floppy disk

1. Hold the disk between thumb and forefinger, with the
label facing upward and the metal shutter pointing
away from you.

2. Gently push the disk into the floppy disk drive, label
side up and metal shutter first, until the disk drive
pulls the disk in the rest of the way.

Copying the contents of a disk
1. Click the disk icon to select it.

2. Drag the disk icon to the icon that represents the disk
where you want the copy made until both disk icons
are selected.

3. Release the mouse button.

Respond to any messages that appear by clicking the
appropriate buttons.
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Removing a floppy disk from the disk drive
1. Click the disk icon to select it.
2. Choose Put Away from the File menu.

3. When the floppy disk drive ejects the disk, remove it
from the disk drive.

You can also drag the disk icon to the Wastebasket. This action
ejects the disk; it does not erase the disk.

Locking and unlocking a floppy disk

1. Hold the disk between thumb and forefinger, with the
label facing upward and the metal shutter pointing
away from you (as if you were going to insert the disk
into a drive).

2. Find the square hole in the lower-left corner of the
floppy disk.

3. Lock the disk by sliding the tab on the back side of the
disk so that the square hole is open.

Unlock the disk by sliding the tab back so that the
square hole is blocked.
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Working with programs

For specific information about a particular program, go to the
manuals that came with the program.

Saving your work

s Choose Save from the File menu, or hold down the
3 key as you press the S key.

Switching programs

= Click anywhere in a window to make it the active
window and its program the active program.

You can also choose the program from the Application menu.

Closing a document

m Click the close box of the document window near the
left end of the title bar, or choose Close from the File
menu.

Respond to any messages that appear by clicking the
appropriate buttons.



Quitting a program

Choose Quit from the File menu, or hold down the
8 key as you press the Q key.

Respond to any messages that appear by clicking the
appropriate buttons.

Backing up your files

1.

Click to select the icon of the document or program
you want to back up.

Drag the icon to the disk icon where you want to store
the backup copy until both icons are selected, then
release the mouse button.

Respond to any messages that appear by clicking the
appropriate buttons.

Making a copy of a file

1

Click to select the file icon.

2. Choose Duplicate from the File menu.

Saving another version of a document

1.

Open the document.

2. Make the changes you want in the new version.
3. Choose Save As from the File menu.

4.

5. Click Save.

Type the name of the new version.
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Appendix A

Keyboards and
Character Sets

This appendix shows the layout of the Macintosh Classic and
Macintosh LC standard keyboard, the Apple Keyboard, and the
Apple Extended Keyboard 1.

“Iyping Non-English Characters and Special Symbols™ is at
the end of this appendix.

Macintosh Classic and Macintosh LC
standard keyboard

For instructions on adjusting the height of this keyboard, go to
Chapter 8, “Setting Up Your Macintosh System.”
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Tab key: Moves the insertion point
horizontally to the next stopping
place (such as a tab stop or data
field in a dialog box or program).

Caps Lock key: A locking Shift key
for letters only (numbers and
symbols aren’t affected).

Shift key: Produces uppercase letters
(or the upper character on the key).

Control key: Like the 36 key,
works in combination with other
keys to provide shortcuts

or modify other actions.

Option key: Produces an optional
set of special characters when
pressed in combination

with other keys; also

modifies other actions.

| ] ]

ctrl

s s

38(Command) key: Works with
other keys as an alternative to
choosing a menu command or
(in some programs) canceling

an operation in progress,

such as printing,



Power On key: On

Numeric keys: These keys

Macintosh I models, Return key: Moves the insertion produce numbers and

pressing this key Delete key: Deletes any material point to the beginning of the next mathematical symbols;

turns on the computer. currently selected, or whatever line. In a dialog box, pressing some programs allow you to

On the Macintosh Classic, character is to the left of the Return is the same as clicking use these keys as function

this key has no function. insertion point. the outlined button. keys to initiate an action.
B

i

/\ j
4 & # ( , = +
6 1117 1 19 (e |- ’ = ||« = = /I J|x
{ /
T WY e 1 e Ll L 1 e 711 1 |-
I . " | |
o Il L e e JIE IR ] e fls L )l
| < > 7 2
‘ esc ié ’ l-—a ) 0 | ~
I ,
Escape key: The function |Arrow keys: Move Clear key: Deletes the Enter key: In a dialog
of this key depends on the insertion point, as current selection, just as box, pressing Enter is the same
the program you're using. an alternative to using the Delete key does. In as clicking the outlined button (or
the mouse. In some some programs, Clear pressing Return); some programs
programs, the arrow has other functions. require that you use Enter (not
keys have other functions. Return) to confirm information

you have provided.
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Apple Keyboard

This keyboard has no height adjustment.

Escape key: The function of this key
depends on the program you're using.
Tab key: Moves the insertion point Lesc
horizontally to the next stopping g
place (such as a tab stop or field e
in a dialog box or program). s
Control key: Like the X key, works
in combination with other keys to provide i
shortcuts or modify other actions.
Shift key: Produces uppercase letters &2
(or the upper character on the key). (
Caps Lock key: A locking Shift (ﬂz iﬁ
key for letters only (numbers —

and symbols aren’t affected). 74
Option key: Produces X (Comma

special characters when anothe!
pressed in combination choosi
with other keys; also (in so
modifies other actions. a

246 Appendix A: Keyboards and Character Sets



Return key: Moves the Numeric keys: These keys prod

Power On key: On Delete key: Deletes any material insertion point to the beginning numbers and mathematical
Macintosh II models, currently selected, or whatever of the next line. In a dialog box, symbols; some programs allow
pressing this key character is to the left of the pressing Return is the same as you to use these keys as functio
turns on the computer. insertion point. clicking the outlined button. keys to initiate an action.
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es with Arrow keys: Move the insertion’ Clear key: Deletes the Enter key: In a dialog box, pre

iive to point, as an alternative to using current selection, just as Enter is the same as clicking tl
and or the mouse. In some programs, the Delete key does. In button (or pressing Return); s
wceling the arrow keys have some programs, Clear has programs require that you use
0gress, other functions. other functions. (not Return) to confirm inforr
inting. you have provided.

Appendix A: Keyboards and Character Sets 247



Apple EXtended Keyboal‘d H Function keys: Some programs allow you to use

function keys to give commands. You can assign
A reversible plastic template that comes with this keyboard fits commands or action sequences to function

over the row of function keys. You can label the function keys by
writing on the template (in pencil, not pen or marker).

For instructions on adjusting the height of this keyboard, go to
Chapter 8, “Setting Up Your Macintosh System.”

Escape key: The function of this key
depends on the program you're using.

Tab key: Moves the insertion point
horizontally to the next stopping
place (such as a tab stop or field

in a dialog box or program).

Caps Lock key: A locking Shift key
for letters only (numbers and
symbols aren’t affected).

Shift key: Produces uppercase letters
(or the upper character on the key).

Control key: Like the 38 key, works
in combination with other keys to provide
shortcuts or modify other actions.

Option key: Produces special
characters when pressed in
combination with other keys;
also modifies other actions.
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keys with special utility programs.
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38 (Command) key: Combines
with another key as an alternative
for choosing a menu command or

(in some programs) canceling
an operation in progress,
such as printing,



Delete key: Deletes any material ~ Special keys: The function Numeric keys: Power On key: One some

currently selected, or whatever  of these keys depends on the These keys produce models of the Macintosh,
character is to the left of the  operating system and program numbers and you press this key to
insertion point. you're using.  mathematical symbols. turn on your system.
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Return key: Moves the insertion Arrow keys: Move the Clear key: Enter key: In a dialog box,
point to the beginning of the next insertion point, as an Deletes the pressing enter is the same as
line. In a dialog box, pressing alternative to using current selection, clicking the outlined button
Return is the same as clicking the the mouse. In some just as the Delete (or pressing Return); some
outlines button. programs, the arrow key does. In some programs require that you use
keys have other programs, Clear has  Enter (not Return) to confirm
functions. other functions. information you have provided.
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Typing non-English characters
and special symbols

You can type a variety of non-English characters (with diacritical
marks) and special symbols by pressing the modifier keys (such as
Shift, Option, and Control) in combination with certain letter and
number keys.

The Key Caps program, which is installed with the system
software, shows you the characters produced when you type
certain keys and key combinations in the fonts you have (choose
Key Caps from the Apple menu, then choose the font from the
Key Caps menu).

Characters appear here when you press keys
on the keyboard or click them in the window.

eleltfufulilololC]1]
ARRANDANNARN
TelaleTolblnal.T.17]

Characters available in the
Monaco font (on the Apple
Extended Keyboard 1I)
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The highlighted key represents the
key held down on the keyboard—
in this case, the Option key.

Special characters available
in the Monaco font when
the Option key is pressed.




To type a character with a diacritical mark (such as an acute accent
or an umlaut), you press the Option key with a specific letter key,
then you type the character.

Diacritical mark Key combination

Grave accent () Option-", then type the character
Acute accent (") Option-e, then type the character
Circumflex (™) Option-i, then type the character

Tilde (~) Option-n, then type the character
Umlaut () Option-u, then type the character

The letter ¢ with a cedilla (¢) Option-c

If the character appears affer the diacritical mark (rather than
with it), then the marked character is not available in the font
you're using.

Appendix A: Keyboards and Character Sets 251

=~
<2
o]
<o}
=~
<o}
Z
(@)
<]




Appendix B

Exchanging Disks and Files
With MS-DOS and Apple II
Computers

Apple File Exchange is a file format conversion program that is
supplied on the system software floppy disks. The program and
three special translator files are stored in the Apple File Exchange
Folder.

You can use the program to initialize a disk in MS-DOS or ProDOS
(Apple IT) format and convert files to and from MS-DOS or
ProDOS. (Apple File Exchange cannot open converted files; you
need to use an application program that recognizes the converted
files to open them.)

2

#pple File Exchange

3}
N
o

Initializing a disk in MS-DOS
or ProDOS format

1. Locate the Apple File Exchange icon and open it.
Apple File Exchange is supplied on the system software disks.

The program’s window opens. The contents of the active
window are listed on the left side and an empty box appears
on the right side.

2. Place a blank disk in your floppy disk drive.
A dialog box appears, reporting that the program can’t read
the disk and asking if you want to initialize it. This dialog box

shows the names of formats available in Apple File Exchange,
including Macintosh, MS-DOS, and ProDos.

(You can initialize a disk that is not blank by inserting it,
clicking the Drive button until its name appears in the
window, and choosing Erase Disk from the File menu.)

3. Click MS-DOS or ProDOS.



4. If necessary, click the capacity (in K) of the disk you

inserted.

If you want to initialize a high-density disk in MS-DOS format,
1440K is the only option and is already selected. If you
inserted a double-sided disk, click 720K.

read this disk. Do you wish to

[0 Apple File Exchange cannot
||
initialize it?

({' 440K Macintosh
DO
Prohis

(rnitialize ]| Eject

J

5. Click the Initialize button.

Disk capacity is the
same for Macintosh and
MS-DOS

high-density disks.

When initialization is completed, a dialog box appears, asking

you to name the disk.

6.

Type a name for the disk, then click OK.

MS-DOS file names can have up to eight characters, followed
by an optional period and up to three characters.

The dialog box closes, and the name of the disk you initialized
appears, above an empty window. This disk’s icon doesn’t
appear on your Macintosh screen (because the Macintosh
cannot recognize a disk in MS-DOS or ProDOS format).

Choose Quit from the File menu when you are finished
using Apple File Exchange.

Apple File Exchange cannot initialize a high-density disk in 720K
format, nor can it read a double-sided disk that has been
initialized in the high-density (1.4 MB) format.

9.
o

5.25-inch disks: Some Macintosh models can use an external
5.25-inch floppy disk drive that can read files from MS-DOS
disks. An internal adapter or expansion card is required to
connect a 5.25-inch disk drive to the Macintosh. Apple File
Exchange can translate files from these disks and store files on
them.
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Converting files to and from MS-DOS
or ProDOS format

Apple File Exchange provides two methods of file conversion—
text and binary. You use text translation for text files, and binary
translation for other files.

In addition, Apple File Exchange can use special translator files
designed to convert files into formats that specific programs can
use. One of these special translator files is provided with Apple
File Exchange: DCA-RFT/MacWrite, which converts documents
between MacWrite® format for the Macintosh and Document
Content Architecture/Revisable Form Text format (used by many
word-processing programs) for MS-DOS.

File selected Menus of
for translation B
translator
files
Directory
=02 MSDOS. jjh title or disk
D BUDGET.90 name
1|0 Disk Images D BUDGET.91
|© Labels D BUDGET.OUW
27K
bytes
selected
: = : Disk name
= Hummer' Msnns.jjn'
5094K bytes available 1324K bytes available
dpen_ ) (_Drive ) (open ) i(__Drive
(New Foider)  ( tject ) (New rolder) (__Eject
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Follow these steps to translate a file:
1. Locate the Apple File Exchange icon and open it.
Apple File Exchange is supplied on the system software disks.

The program’s window opens. The contents of the active
window are listed on the left side and an empty box appears
on the right side.

2. Insert the floppy disk that contains the files you want
to translate.

3. Use the Open, Drive, and Eject buttons to display the
files you want to translate and the disk or folder where
you want to store the translated files.

4. Click the names of the files or folders you want to

translate.

To select multiple files or folders, hold down the Shift key and
click each name. You may have to scroll to locate the names of
some files or folders.

The appropriate translation menus (one for translating from
Macintosh format and another for translating to Macintosh
format) appear on the menu bar when you select either
MS-DOS or ProDOS files.



5. Open the translation menu you want by pressing its

name.

. Make sure that the translators for the types of files
you've selected have checkmarks; if not, choose them
so that checkmarks appear next to them.

An active translator has a checkmark. The default translator
has a diamond (indicating that it’s always active). Choosing an
active translator makes it inactive.

. Compare the size of the files or folders selected for
translation with the space available on the destination
disk.

The total space required appears between the lists; the space
available on the destination disk appears below its name.

If the size of the selected items is greater than the space
available on the destination disk, deselect some of the items
(by Shift-clicking them), remove some files on the destination
disk (using the Remove button), or change to another
destination disk (using the Eject button).

8. Click the Translate button.

If Apple File Exchange finds two or more active translators—
other than Text or Default—capable of translating a selected
file, it presents a dialog box asking you to select the translator
you want.

If the names of files or folders on the destination disk are the
same as those of files or folders being translated, Apple File
Exchange presents a dialog box asking you to rename the file
being translated.

Ifa translator requires you to select options before a file is
translated, it presents a dialog box in which you select the
options.

. Respond to any dialog boxes presented by selecting a

translator, renaming the file, or selecting options.

The selected files or folders are translated. Messages report
the status of copying.

If Macintosh files are being translated into MS-DOS files, the
names of translated files may be shortened to conform to the
naming conventions of MS-DOS.

continues P
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10. When all translations are finished, choose Quit from
the File menu.

<« Converting MS-DOS files on a file server: Some file servers
can store information created by both Macintosh computers
and MS-DOS computers. For example, the AppleShare PC
program allows MS-DOS computers to store and translate files
on an AppleShare file server. Consult your authorized Apple
dealer or representative for more information about using a
file server and MS-DOS files. «

Other file-conversion options

Apple File Exchange’s File menu provides several other options to
assist you with file conversions.
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The program keeps a log of all files translated,
showing the date, time, and type of conversion.

Show User Log
finse

Sape Hepr Lag He...
fipay Hsar Log

The active translators and
the options for each
translator can be saved in
a special file with the

“Save settings as”
command. You can then
use these options any time

Restore settings from...
Save settings as...

by choosing the “Restore
settings from” command
and opening the file.

Page Setup...
Print Hsey Loy,

You can rename destination

feaanme Besiinaiion Vies.
vShow Only Eligible Files 3E-
Erase Disk...

| (translated) files.

| The names of files that can’t
be converted by the active
translators are dimmed

Quit

30

when this item is checked.

You can reinitialize a disk in any

available format with this command.

More information about Apple File Exchange options

To see explanations of the translators Apple File Exchange uses,
choose About the Apple File Exchange from the Apple menu.
Select a translator in the list that appears, then click the About
button for information about that item. (Click Done to return to
the program’s window.)



Appendix C

Where to Get More
Information About
Your Macintosh

As you increase your knowledge of computers and develop new
uses for your Macintosh, you may want to know what other
Macintosh users in your area are doing with their computers, or
you may want to learn more about programming, hardware
design, or other technical topics.

The information in this appendix provides a starting point for you
to expand your Macintosh knowledge and contacts.

Macintosh user groups

Whatever your level of computer experience, you can get lots of
support by joining a Macintosh user group. Macintosh user
groups are composed of people who work with Macintosh

computers and who enjoy sharing what they know with others.

Activities may include demonstrations of new products, question-

and-answer sessions, and classes on using popular programs or
learning to write your own programs. Many user groups have

special beginners” meetings.

Ask your authorized Apple dealer for the name of the Macintosh

user group nearest you, or call 800-538-9696. For names of user

groups outside the United States, or if you're interested in starting

your own user group, contact

Berkeley Macintosh User’s Group or Boston Computer Society

1442-A Walnut Street, #62
Berkeley, CA 94709

U.SA.

415-549-BMUG (415-549-2684)

One Center Plaza
Boston, MA 02108
USA.
617-367-8080
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Technical information

Anvariety of technical documentation s available for the
Macintosh. Apple Computer releases technical information
through three primary outlets: the Apple Technical Library and

the Apple Communications Library, both published by Addison-

Wesley Publishing Company, and the APDA developers’ source.

Apple Technical Library

The Apple Technical Library includes comprehensive technical
documentation for all Macintosh computer models and the
multivolume guide to the Macintosh operating system for all
models, Inside Macintosh.

Other books in the Apple Technical Library cover designing
expansion cards and programming device drivers for the
Macintosh, writing application programs for the Macintosh, and
designing the user interface for Macintosh programs.

You'll find the Apple Technical Library in most well-stocked
bookstores.
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Apple Communications Library

The Apple Communications Library offers complete technical
information about Macintosh communications products and the
Macintosh in a network environment. The library includes an
introductory volume, Understanding Computer Networks, and
the comprehensive guide to the AppleTalk network system, Inside
Applelalk.

The books in the Apple Communications Library are available at
bookstores.



APDA

APDA offers convenient worldwide access to over 300
development tools, resources, training products, and information
for anyone interested in developing applications on Apple
platforms. Customers receive the quarterly APDA Tools Catalog
featuring all of our most popular and most current versions of
Apple and third-party development tools. Ordering is easy; there
are no membership fees and application forms are not required
for most of our products. APDA offers convenient payment and
shipping options, including site licensing.

To order product or get additional information, contact:

APDA

Apple Computer, Inc.

20525 Mariani Avenue, M/S 33-G
Cupertino, CA 95014-6299
USA.

800-282-2732 (United States)
800-637-0029 (Canada)
408-562-3910 (International)
Fax: 408-562-3971

Telex: 171576

AppleLink: APDA

Assistance for hardware and software developers

If you plan to develop hardware or software products for sale
through retail channels, you can get valuable support from Apple
Developer Programs. Write to

Apple Developer Programs
Apple Computer, Inc.
Mailstop 51-W

20525 Mariani Avenue
Cupertino, CA 95014-6299

Appendix C: Where to Get More Information About Your Macintosh 259

-~
<o]
Fry
<2]
=
<2l
2,
(@)
<]







Glossary

A active window  The window that’s on top of all others on the

" : o Macintosh desktop. The active
access privileges The ability to see folders, see files, or make E=nee's sk  window has solid lines

changes to a shared disk or folder. Access privileges are S items 36 MB in disk running across its title bar and
granted by the owner of the shared item and are used to it “belongs” to the active
determine what other network users can do with the disk or

. program.
folder and its contents.
active program - The program you're currently using. You can
!1ave sev§ral programs open at a time, but onl).f one of them ADB Sece Apple Desktop Bus.
is the active program. Open programs appear in the
Application menu at the right end of the menu bar, with a Alarm Clock A desk accessory program (an Apple menu item)
checkmark next to the name of the active program. The that works like a digital alarm clock.
menu icon changes to indicate which program is the active _ )
program. alert box A box that appears on the screen to give a warning or

other message, sometimes accompanied by an alert sound.
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This process will erase all
information on this disk.




alias A file that stands for and points to a file, folder, or disk that
you use as if it were the original. When you
open an alias, you're actually opening its
original.

TeachText alias

Apple Desktop Bus (ADB) Input circuitry built into most
c5 Apple computers. You use ADB ports (marked
Cﬂ@ with the ADB icon) to attach the keyboard, the
mouse, and other devices, such as graphics tablets
and bar-code readers. See also bus.

Apple menu The menu at the left end of the menu bar, indicated
by the Apple symbol. You
choose items from this

About This Macintosh... menu to get information
(& Alarm Clock about programs” memory
Calculator

= Chooser

use and open items
placed in the Apple Menu
Items folder (in the
System Folder).

ApplcSh;u‘C file server A Macintosh computer running
AppleShare File Server software that allows network users to
store, retrieve, and share files and application programs on
that computer.
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AppleTalk network A combination of devices, cables, and
software that operate according to the protocols (rules)
developed by Apple Computer. A communications
environment in which many different kinds of computers,
peripherals, and software can work together. Uses LocalTalk,
EtherTalk, or TokenTalk network connection types.

Application menu  The menu at the right end of the menu bar
(its icon changes to indicate which
@ program is the active program). You
Hiae Einder choose items from this menu to hide

Hide Others . .

Shaw A3 windows belonging to open but

inactive programs and to make an

open program the active program.

See also active program.

v [E Finder
48 TeachText

application program A program that you use to do your work
on the computer, such as word processing, database
management, graphics, or telecommunication.

B

back panel The back of the computer, where you find the power
switch and ports for attaching external devices.

back up To make a copy of a disk or of a file on a disk. Backing
up your files and disks ensures that you won't lose
information if the original is lost or damaged.



balloons Small boxes containing text identifying objects on the
screen and explaining their
71 @ ;

N use. You can hide or show
balloons by choosing the
appropriate command
from the Help menu.

] Help menu

Use this menu to get
i1 information that helps
] you use your computer.

bit Binary digit. The smallest unit of information that a computer
can hold. The value of a bit (either 1 or 0) represents a
two-way choice (on or off, true or false, black or white).

bitmap A set of bits that represents a graphic image.

bitmapped character A character in a font that’s rendered as a
bitmap and drawn as a pixel pattern on the screen. See also
font, pixel.

bitmapped font A font in a single point size made up of
bitmapped characters (also called fixed-size font). Some
fonts stored in the Macintosh System file are bitmapped
fonts. Compare outline font, TrueType font.

buffer A “holding area” in memory where information can be
stored by one program or device and then read by another.
For example, some printers have built-in memory to store
text that comes from the computer faster than it can be
printed. This memory, which frees the computer for other
work while the printer is printing, is called a print buffer.

bus Circuits inside the computer that transmit information from
one part of a computer system to another. For example, the
Apple Desktop Bus transmits information about mouse
movement or keyboard input. In a network, a bus is a line of
cable with connectors that link devices together.

button  An image, sometimes resembling a pushbutton, that you

click to designate, confirm, or

cancel an action. Compare
mouse button.
(options )] [ Help ]

byte A unit of information consisting of a fixed number of bits.
One byte usually consists of a series of eight bits. See also
kilobyte, megabyte.

C
cache See memory cache, disk cache.

Cancel button A button that appears in most dialog boxes.
Clicking it cancels any command or options you might have
chosen and closes the dialog box.

central processing unit (CPU) The “brain” of the computer;
the microprocessor that performs the actual computations.
See also processor, coprocessor.

character Any symbol that has a widely understood meaning and
thus can convey information (letters, numerals, punctuation
marks, and other symbols).

Glossary 263

(=)
=
o
)
@
>
=
<




checkbox A small box associated with an option in a dialog box
or window. You click the checkbox to turn the option on or
off. An option is “on” when there’s an X in the checkbox.

chip See integrated circuit.

choose o give a command by dragging through a menu and
releasing the mouse button when the command is
highlighted.

Chooser A program that lets you designate devices, such as
printers and shared disks on a network, for your Macintosh
to use.

Clear A command in the Edit menu that removes selected
material without placing it on the Clipboard. You can use
the Undo command immediately after using Clear if you
change your mind. Compare Cut.

click o position the pointer on an object on the screen, and
then to press and quickly release the mouse button.

Clipboard  An area in the computer’s memory that functions as a
holding place for what you last cut or copied. Information
on the Clipboard can be pasted into documents.

close box The small box on the left end of the title bar of
an active window. Clicking it closes the
window.

JIII}

T8dtems
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color wheel Available on computers with color capability, the

color wheel dialog box lets you adjust hue, saturation, and
brightness of the highlight color and other color choices. It
is also used to adjust shades of gray.

command  An instruction that causes the computer to perform

some action.

configuration (1) The way you have your computer set up.
(2) The combined hardware components—computer,
monitors, keyboard, and peripheral devices—that make up a
computer system. (3) The software settings that allow
various hardware components of a computer system to
communicate with each other.

control panels  Programs that let you change various Macintosh
features, such as sound, mouse movement, and keyboard
options. Control panels are located inside the System
Folder.

coprocessor An auxiliary processor designed to relieve the
demand on the main processor by performing a few specific
tasks. Generally, coprocessors handle tasks that would be
performed much more slowly by the main processor, such
as mathematical calculations.

Copy A command in the Edit menu that copies selected material
and places it on the Clipboard, without removing the
material from the original document. See also Clipboard.



copy-protect To make a disk difficult if not impossible to copy.
Software publishers sometimes copy-protect their disks to
prevent them from being illegally duplicated. See also lock.

CPU See central processing unit.
current application See active program.

current startup disk The disk that contains the System Folder
the computer is currently using. The startup disk icon
appears near the upper-right corner of the desktop.

cursor  See pointer.

Cut A command in the Edit menu that removes selected material
and places it on the Clipboard; from there you can paste it
elsewhere. Compare Clear. See also Clipboard.

cut and paste To move text, graphics, or other material from
one place in a document to another place in the same or a
different document.

D

default A value, action, or setting that a computer system
assumes, unless you give it a different instruction. (Also
called preset.)

deselect To change a selected item, such as an icon, so that it is
no longer selected. In the Finder, you deselect highlighted
icons by pressing the Shift key and clicking the icon you
want to deselect, or by selecting something else.

desk accessories  Small application programs that you can add

-

L 3
About This Macintosh...

& Alarm Clock
Calculator

S Chooser
Control Panels
Key Caps

Note Pad

desktop Your working environment

to your system. Desk
accessories (DAs) are
often installed in the
Apple menu. Those
provided with the
Macintosh include the
Alarm Clock, the
Calculator, the Chooser,
control panels, Key Caps,
and the Scrapbook.

on the computer (the menu

bar and the background area on the screen), on which you

work with icons and windows.

& Ffile Edit Uiew Label Special 4] 1 Menu bar
Macintosh HD } S
3 items 3.9 MB in disk 24.1 MB available R 2 M C’::h}m
" {al System Folder B — e xia
3.9 MB in disk 34.1 MB available < S— Debl\[()p
' P
= Hard Disk Too:
Apple Menu Items Extensions Control Panels Finder
B 4 1]

destination The disk or folder that receives a copied or

translated file, as in destination

disk.
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dialog box A box that contains a message, often requesting
more information from you or allowing you to select
options.

dimmed Gray or filled in with a pattern of dots, indicating that
an icon is already open or a menu, menu item, or other
option is not available.

HREE Dimmed command

Dimmed folder icon

Dimmed program icon

directory Alist of the contents of a folder or a disk.

directory dialog box A dialog box that lets you see the contents
of disks and folders so that you can save a document in a
particular folder or disk, or open a document that’s in a
particular folder or disk. A directory dialog box appears
when you choose Save or Open from a program’s File
menu.

disk A flat, circular object with a magnetic surface that
computers use to store files (programs and documents).
The files are stored as magnetic signals, similar to the way
sounds are recorded on tape. See also floppy disk, hard
disk.
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disk cache A portion of the computer’s random-access memory
(RAM) that is set aside for programs to store frequently used
instructions. You use the Memory control panel to adjust
the size of the disk cache. Compare memory cache.

disk capacity The maximum amount of data a disk can hold,
usually measured in megabytes (MB) or kilobytes (K).

disk drive The device that holds a disk, retrieves information
from it, and stores information on it.

document Whatever you create with an application program.
See also file.

double-click To position the pointer on an object, such as an
icon, and then to press and release the mouse button twice
in quick succession without moving the mouse.

drag To position the pointer on an object, press and hold the
mouse button, move the mouse, and release the mouse
button.

driver A program that the computer uses to direct the operation
of a peripheral device, such as a printer or scanner. (Also
called a resource.)

drop folder A shared folder with access privileges that don’t
allow network users to open it but do allow network users
to place files or folders into it.



E

Easy Access A control panel that you use to adjust the keyboard
so that you can control the pointer from the numeric
keypad, type keyboard shortcuts without having to press the
keys at the same time, and type very slowly. You also can
make these keyboard adjustments without opening the
control panel.

Edit menu A menu that is available in most programs and lists
editing commands—such as Cut, Copy, and Paste.

eject Toremove a disk from a disk drive.

error message A message displayed on the screen that tells you
of an error or problem in a program or in your
communication with the computer system.

Ethernet A high-speed, widely used network type.

EtherTalk A type of network connection (provided by EtherTalk
software installed in your Macintosh) that allows you to use
AppleTalk network services on an Ethernet network.

Everyone A category of users for whom you can set access
privileges to shared folders and disks. The category refers to
anyone who connects to a computer as a guest or registered
user.

expansion card A removable circuit board that plugs into one of
the expansion slots in some models of Macintosh
computers. Expansion cards enable the computer to use a
special device or to perform an additional function.

expansion slot A long, rectangular socket on the main circuit
board of some Macintosh models into which you can install
an expansion card that gives the computer additional
capabilities.

extension See system extension.

B

file Anynamed, ordered collection of information stored on a
disk. Application programs and documents are examples of
files. You create a file when you type text or draw graphics,
give the material a name, and save it on a disk.

File menu A menu that lists commands that affect whole
documents and other files—commands such as Save, Print,
and Quit.

file server A computer with special software that allows network
users to store and retrieve files on the hard disks or other
storage devices attached to it.

file sharing The capability of sharing files among computers on a
network.

Finder Part of the system software, the Finder is the program
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that creates the Macintosh desktop and keeps track of your
files.

floppy disk A disk made of flexible plastic that stores computer
data. The 3.5-inch disks used in Macintosh floppy disk drives
are floppy disks housed in rigid plastic shells for support
and protection. Floppy disks come in three types: high-
density (1.4 MB capacity), double-sided (800K), and single-
sided (400K).

folder A container for documents, programs, and other folders
on the desktop or in directory windows.

font A collection of letters, numbers, and symbols in a distinctive
typographic design. See also
bitmapped font, outline
font, TrueType font.

This is New York font.

This is Geneva font.

format See initialize.

guest A person that connects to another computer on a network
without having to give a name or password.

guest access A type of access to a computer that permits any
network user to connect to the computer for the purpose of

file sharing or program linking. Each Macintosh owner can
control whether guest access is allowed on that computer.

group A set of registered users on a network for whom you set
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access privileges as a unit. Groups are a convenient way for
a person who is sharing files to control access privileges for
a number of users at once.

H

hard disk A disk made of metal and permanently sealed in a disk
drive or cartridge. A hard disk can hold much more
information than a floppy disk, and a hard disk spins much
faster.

highlighted Visually distinct, usually because the colors are
reversed.

L]

I-beam A type of pointer shaped like the capital letter I, used
for entering and editing text. See also
insertion point.

stationzgl

— I-beam

icon A small pictorial representation of a file, disk, menu, option,
or other object or feature.

Document ‘Wastebasket Floppy Disk




initialize To prepare a disk to receive information by organizing
its surface into tracks and sectors; also known as format. If
you initialize a disk with information on it, the information
is erased.

input Information transferred into a computer from some
external source, such as the keyboard, the mouse, a disk
drive, or a modem. Compare output.

insertion point The place in a document where text you type
will be added; you set it by clicking at the spot
where you want to make the insertion. The
insertion point is marked with a blinking
vertical bar.

statiorh
Insertion point

Installer A program that you use to install or update your system
software or to add resources such as networking software.

integrated circuit (IC) An electronic circuit entirely contained
in a single picce of semiconducting material, usually silicon.
Often referred to as a chip.

interface The way a computer communicates with external
devices, such as a printer (through its printer port, or
printer interface), or with you (through its user interface or
human interface).

K
K See kilobyte.

keyboard equivalent See keyboard shortcut.

keyboard shortcut A combination of key presses that you can
use to give a command or set an option. Keyboard shortcuts
always involve the use of at least one modifier key, such as
the 88 key or the Option key.

Key Caps A desk accessory that shows you the characters
available for each font in your system.

kilobyte 1024 bytes. See also byte, megabyte.

L

label A word or short phrase that you can assign to an icon by
using the Label menu. (You can also assign the color that’s
associated with a label if your Macintosh displays color.) You
can change labels and their associated colors in the Labels
control panel.

LocalTalk A built-in network connection that allows a Macintosh
computer to participate on an Applélalk network.

LocalTalk cable system A system of cables, cable extenders, and
connector boxes that connect computers and network
devices to an AppleTalk network system.
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lock To prevent files or disks from being changed or deleted
(but they can still be opened or copied).

M

main logic board A circuit board that holds RAM, ROM, the
microprocessor, custom integrated circuits, and other
components that make the computer work.

main memory See random-access memory.

megabyte (MB) 1024 kilobytes, or 1,048,576 bytes. See also
byte, kilobyte.

member A registered user on a network who belongs to a
group.

memory A hardware component of a computer system that can
store information for later retrieval. See also main
memory, random-access memory, read-only memory.

memory cache Memory that is set aside to increase the
efficiency and operating speed of the computer. Compare
disk cache.

menu A list of items from which you can choose. Menus
commonly appear when you press menu names in the
menu bar or in a dialog box. You choose a command by
dragging through the menu and releasing the mouse button
when the command you want is highlighted. See also
pop-up menu.
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menu bar The white strip across the top of your screen that
contains the names of the menus available to you.

(& File Edit Uiew Label Special

menu name A word, phrase, or icon in the menu bar or in a
dialog box that gives you access to the menu. Pressing the
menu name opens the menu.

modem Short for modulator/demodulator: A device that links
your computer to other computers and information services
over telephone lines.

modem port A socket on the computer’s back panel marked by
a telephone icon, used to connect a modem to your
Macintosh.

monitor See video monitor.
mouse A device that controls the pointer on the screen.

mouse button The mechanical button on top of the mouse. In
general, pressing the mouse button initiates some action on
whatever is under the pointer on the screen, and releasing
the button confirms the action.

Mouse Keys An Easy Access feature that lets you use keys on the
numeric keypad to control the pointer.

MS-DOS Microsoft Disk Operating System, a commonly used
computer operating system.



N

network A collection of devices such as computers and printers
that are connected together. A network is a tool for
communication that allows users to store and retrieve
information, share printers, and exchange information.

network administrator A person responsible for setting up,
maintaining, or troubleshooting your network.

network service A capability such as file service or print service
provided by special software on the network.

network user A person whose computer is connected to a
network.

Note Pad A desk accessory that lets you enter and edit small
amounts of text.

NuBus An address bus and data bus used in the Macintosh II
family and some other Macintosh computers. NuBus lets
you add a variety of components to the computer system,
through expansion cards installed in NuBus expansion slots
inside the computer. See expansion slot.

numeric keypad A calculator-style keypad, to the right of the
alphabet keyboard, that you can use to type numbers. Some
application programs designate the keys on the numeric
keypad as function keys.

0

open To make available. You open files in order to work with
them. Opening an icon usually causes a window to appear,
revealing the document or application program the icon
represents or showing you the contents of a folder or disk.

operating system A program that organizes the internal
activities of the computer and its peripheral devices. An
operating system performs basic tasks such as moving data
to and from devices and managing information in memory.

outline font A font that describes each character mathematically
as a set of formulas. The mathematical description adjusts
itself to render the character in different sizes. See also
TrueType font, bitmapped font, font.

output Information transferred from the computer’s
microprocessor to some external device, such as the screen,
a disk, a printer, or a modem. Compare input.

owner The owner of a Macintosh is named in the Sharing Setup
control panel. On a network, the owner of a shared folder
or disk is named in the Sharing dialog box, identifying the
person who can set or change the access privileges assigned
to the shared item.

owner name The name of the owner of a shared folder or disk
that appears in the Sharing dialog box. The owner can be
the Macintosh owner, a registered user, or a registered
group. The owner can set or change the access privileges of
the shared item.
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P,Q

password A unique word or set of characters that must be
entered before a network user can gain access to a
computer that he or she is registered on.

Paste A command in the Edit menu that places the contents of
the Clipboard—whatever was last cut or copied—at the
location of the insertion point. See also Clipboard.

peripheral device A piece of hardware —such as a monitor, disk
drive, printer, or modem—used with a computer and under
the computer’s control.

PICT A file format used by a number of graphics and page layout
programs.

pixel Picture element. The smallest dot that the computer and
monitor can display, or the representation on the screen of
the value of a bit. Also, a location in video memory that
corresponds to a pixel on the screen. See also bit.

pointer An arrow or other symbol on the screen that moves as
you move the mouse.

pop-up menu A menu (usually in a dialog box) in which the
selected option is shown next to a
solid triangle and inside a box with a
shadow around it. The rest of the
menu “pops up” when you press the
box. Compare pull-down menu.
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port A socket on the back panel of the computer where you can
plug in a cable to connect the computer to another device.

printer port A socket on the computer’s back panel marked
with a printer icon, used to connect a printer or an
AppleTalk network connector to the computer.

privilege  See access privileges.

processor The computer hardware component that performs
the computations directed by software commands. In
microcomputers such as the Macintosh, the processor is a
single integrated circuit called a microprocessor. See also
central processing unit.

program A set of instructions describing actions for a computer
to perform to accomplish a task, conforming to the rules
and conventions of a particular programming language.
Computer programs are collectively referred to as software.
See also application program.

program linking The ability of an application program to
exchange information directly with another program over a
network. To use program linking, both programs must have
the capability.

pull-down menu A menu (usually in the menu bar) whose
name or icon is shown. You “pull down” the menu by
pressing the name or icon. Compare pop-up menu.



R

RAM See random-access memory.

random-access memory (RAM) The part of a computer’s
memory available for programs and documents, also known
as main memory. The contents of RAM are lost when the
computer is turned off. Compare read-only memory.

Read Me document A document that is included on some
application program and system software disks to provide
you with late-breaking information about the product.

read-only memory (ROM) Memory whose contents the
computer can read, but not change. Information is placed
into read-only memory only once, during manufacturing.
The contents of ROM are not erased when the computer’s
power is turned off. Compare random-access memory.

registered group A group of registered users that is listed on a
computer on a network.

registered user A network user whose name and password are
listed on a computer on the network. Usually, registered
users have greater access privileges to shared folders and
disks than do guest users.

resource A file that is contained in the System Folder and that
the computer uses for its operations. System files and
device drivers are examples of resources.

RGB monitor A type of color monitor that receives separate
signals for each primary color (red, green, and blue) and
uses these signals to display color images.

ROM  See read-only memory.

S

save To store information by transferring it from main memory

(RAM) to a disk. Work that is not saved disappears when you

turn off the computer or if the power is interrupted.

scanning order The order in which the Macintosh searches the
disk drives for a startup disk. See also startup disk.

Scrapbook A desk accessory in which you can save frequently
used pictures or passages of text. The Scrapbook can store
multiple images. You can cut or copy images from the
Scrapbook and paste them into documents created with
most application programs. Compare Clipboard.

scroll To move a document or directory in its window so that a
different part of it is visible. You scroll using the scroll
arrows, scroll bars, or scroll box.

SCSI' See Small Computer System Interface.
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SCSI cable terminator A device used in a SCSI chain to
maintain the integrity of the signals going through the
chain. With some devices, such as the Apple internal hard
disk, the terminator is built in.

SCSI chain A group of SCSI devices linked to one another
through SCSI peripheral cables and linked to the SCSI port
on the computer through a SCSI system cable.

SCSI port  The socket on the back panel of the computer to
which you connect SCSI devices.

select To designate which object will receive the next action you
take. Selecting is usually done by clicking or dragging.

selection The selected object or objects. A selected object is
usually highlighted.

serial ports  The connectors for peripheral devices that receive
data in a serial format (that is, one bit at a time). The printer
and modem ports on the Macintosh are serial ports.

shared disk A hard disk, CD-ROM disc, or other medium whose
contents can be retrieved over the network. A disk can be
shared by a file server or a Macintosh computer that has file
sharing turned on.

shared folder A folder that is available to some or all network
users over the network.
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Shift-click o click the mouse button while holding down the
Shift key, used to extend or shorten a selection and to select
more than one item.

Shift-drag To drag while holding down the Shift key, used to
select two or more groups of objects by holding down the
Shift key while you drag diagonally to enclose each group of
objects in a rectangle.

SIMM  Single In-line Memory Module, a circuit board that
contains eight RAM chips. SIMMs are connected to SIMM
sockets on the computer’s main circuit board. See also
random-access memory.

size box Abox on the bottom-right corner of the active
window. Dragging the size box resizes the
window.

Slow Keys An Easy Access feature that lets you set a delay before
each keystroke is accepted by the computer.

Small Computer System Interface (SCSI) A specification of
mechanical, electrical, and functional standards for
connecting peripheral devices such as hard disks, printers,
and optical disks to small computers.

sound output port A socket on the back panel of the Macintosh
marked with a speaker icon, used to connect headphones
or speakers to your Macintosh.



- source  The disk or folder that holds the original of a file to be
copied or translated, as in source disk.

startup disk - A disk with all the necessary program files—such as
the Finder and System files contained in the System
Folder—to set the computer into operation.

startup drive The disk drive from which you start up your
computer system. The disk in this drive must contain a
System Folder.

stationery A document that serves as a template. When you
open a stationery document, a copy of the document is
created and opened. The original remains unchanged.

Sticky Keys - An Easy Access feature that lets you type
combination keystrokes without actually pressing the keys
simultaneously.

system extension A program that expands the capabilities of
system software (for example, device drivers). System
extensions are stored in the Extensions folder in the System
Folder.

System file The file that Macintosh computers use to start up
and to provide systemwide information,
including fonts, sounds, and keyboard layouts.

s The System file must be in the System Folder.

System Folder A folder containing the programs that Macintosh
computers use to start up and operate. A
disk that contains a System Folder is a
Sustem Folder startup disk.

system software - Software components that support application
programs by managing system resources (such as memory)
and input and output devices. Also known as the operating
system.

¥

TeachText A program provided with the Macintosh system
software that functions as a limited word-processing
program, used primarily to open Read Me documents.

terminator See SCSI cable terminator.

3.5-nch disk A flexible, plastic disk measuring 3.5 inches in
diameter encased in a rigid plastic shell. These disks come
in three types: high-density (1.4 MB capacity on the
Macintosh), double-sided (800K), and single-sided (400K).
See also floppy disk.
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title bar  The bar at the top of a window that shows the name of
the window. When the window is active, the title bar is
highlighted with horizontal lines.

o] |- Title bar
206K available

Duane

(E5)

To Do

!

Token Ring - A widely used network type originally developed by
International Business Machines Corporation.

TokenTalk A type of network connection that allows you to use
AppleTalk services on a Token Ring network.

Truelype font A type of outline font supplied with the
Macintosh system software. See also outline font.
Compare bitmapped font.

U

unlock To allow a locked disk or document to be changed,
deleted, or renamed. See also lock.

user group A computer club where computer users exchange
tips and information.
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User/Group A category of users for whom you can set access
privileges to shared folders and disks. Can be any user or
group that is registered on the computer containing the
shared folder or disk.

user interface See interface.

user name  The name chosen by a Macintosh owner or network
administrator to identify a user. After this identification is
complete, the user is a registered user and can connect to
that computer as such.

\Y

version A number indicating a program’s chronological position
relative to previous and subsequent releases of the program.

video monitor A display device that can receive video signals by
direct connection. Also known as a monitor:

virtual memory Hard disk space set aside and used as an
extension of the computer’s main memory.

virus A program designed with malicious intent to damage files.
Virus programs can be spread though networks and
bulletin board services as well as on disks. Virus-detection
and -elimination programs are available through dealers
and user groups.



volume  Space on a hard disk or a file server that’s defined and
named as a place to store files. A hard disk is usually a single
volume, but it can be partitioned into several volumes.

w.X Y
Wastebasket An icon on the desktop that you use to discard
programs, documents, and folders.

‘Wastebasket

window A rectangular area that displays information on the
desktop. You create and view documents through windows,
and you view the contents of disks in windows.

Z

zone Zones are set up by a network administrator and are used
to group the devices on the network for easier access.

zoom box A small box in the top-right corner of the title bar of
the active window. Clicking the zoom box
EE|  resizes the window so that you can see all
1B avalble ) ofits contents (if possible); clicking it

1> ' g ) ;
’: again returns the window to its previous
size.
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A

About This Macintosh (Apple
menu) 148
accent marks, typing 250-251
accessing. See also opening
files on other computers
175-180
Macintosh while away from it
195-196
access privileges (networks)
180181, 197-207
checking 202
setting 199-201
strategies for 200
activating. See also disabling;
opening
Alarm Clock 127-128
AppleTalk 56, 155, 172
CloseView 146
file sharing 183—184
Finder 43—44
Help Balloons 78
Mouse Keys 130
program linking 205
Slow Keys 132
software programs 40, 94,
242
Sticky Keys 131

activating (continued)
32-bit addressing 152
virtual memory 151
Wastebasket icon 1415
windows 14-15, 4345, 236
active desk accessory 94
active software program 242
identifying 4345, 94
multiple 4345, 94
opening documents in 44,
48, 68
quick reference for 242
switching between 43—45, 94
active window, closing 1415,
31, 4345, 236
adapting Macintosh to your own
use 121-152
ADB devices 214
ADB port 214
adding
alert sounds 134
device drivers to System
Folder 210
files to folders 69
folders to folders 110
fonts to System Folder 164
items to Apple Menu 113,
122

adjusting
blinking of menu items 137
disk cache 149
keyboard 87, 129-130, 132
mouse operations 128-129
speaker volume 132-133
virtual memory 150-151
Alarm Clock, setting 127-128
alert sounds
customizing 132—135
disabling 133
installing 133
recording and removing 134
Sticky Keys and 131
aliases 70—72, 112—113. See also
documents; files;
folders
connecting to shared disks
with 179
creating 112
definition of 71
getting information about
(Get Info) 113
locating original of 113
locking 104
opening 112
opening at startup 122
purpose of 112
trouble with 112

APDA 259
Apple Canada 224
AppleCare Service Agreement
224. See also
maintenance
Apple Communications Library
258
Apple Computer, Inc., Customer
Relations 224
Apple Desktop Bus devices
connecting 214
power requirements of 214
Apple Desktop Bus port 214
Apple Extended Keyboard 11 87,
248-249
Apple File Exchange 252-256.
See also networks
converting files to and from
MS-DOS or ProDOS
with 254-256
initializing MS-DOS or
ProDOS disks with
252-253
Apple HD SC Setup program
icon for 98, 108
initializing hard disks with 98
testing hard disks with 108

Index 279




Apple Keyboard 87, 246247
Apple menu
About This Macintosh 148
Alarm Clock 127-128
Chooser 54-56, 153—156,
172
Control Panels 101, 124145,
149-154, 174
installing items in 113, 122
Key Caps 250-251
removing items from 113,
122-123
Apple Menu Items folder 113,
122
Apple Programmers and
Developers Association
259
AppleShare 176. See also
AppleTalk; networks
AppleTalk 171. See also
AppleShare; networks
activating 56, 155, 172
choosing printer for
155-157
inactive 55, 156
zones 55-56, 155, 177
Apple Technical Library 258
Apple II computers, exchanging
disks and files with
252-256
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Application menu 40, 44, 94-95,
239
Finder command 44
Hide Others command 95
icon for 40, 94
Show All command 94
application programs. See
software programs
arranging icons on desktop 109
arranging your office 86
arrow keys 23, 241, 245, 247,
249
arrows, scroll arrows 1617, 20,
237
attaching. See connecting
audio ports 134, 215
A/UX 89,98

B

background printing 156,
160162

backing up files 5859, 243. See
also copying

backspacing with Delete key 41

backup disks 92

Balloon Help 78-79

battery, clock 223

beeps. See alerts

bitmapped fonts 162—163,
225-226

|

blinking insertion point,
changing 137
blinking menu items, adjusting
137
blinking question mark disk icon
229
bomb error message 227, 231
borders, window, changing
colors of 142
brightness
of color wheel 141
of screen 143, 220, 228
Brightness control panel 145
Brightness icon 145
bulletin boards. See also
networks
folders as 201
viruses and 93
bus. See Apple Desktop Bus
By Label command (View
menu) 140

ke

cables
handling 219
LocalTalk-compatible 171
SCSI peripheral interface
cable 211
SCSI system cable 211

cable terminators, built-in 212
cache. See disk cache; memory
calendar, setting 125-126
canceling
initialization 100
printing 161162
Caps Lock key 244, 246, 248
cards
expansion cards 216-218
memory expansion cards
218
NuBus expansion cards
216-217
video cards 216
CDEVs 122. See also Control
Panels
CD-ROM discs, sharing over
networks 175,
184-185
chains. See daisy chains
changing
alert sounds 132-135
Apple menu 122
blinking rates 137
clock battery 223
colors
in color wheel 141
in Label menu 124-125
in Monitors control panel
142-143



changing (continued)
desktop pattern 135-136
documents 48-53
icon names 64-65
icons, appearance of
139-140
keyboard layout 130
keyboard operation
129-130, 132
keyboard shortcuts with
Sticky Keys 131
Label menu items 124-125
memory used by software
95-96
mouse operations 128—131
paper size 156
passwords 181, 196—197
screen brightness 145
speaker volume 132—133
system startup 122
window color 140, 142
window displays 138
character keys 131, 241
characters, non-English and
special symbols
250-251
character sets 244-251. See also
fonts; keyboards

Chooser (Apple menu) 54-56,
153156
activating AppleTalk with 172
connecting to shared disks
with 176
choosing printer with
153-156
networks and 155-157
choosing
items from menus 240
items from submenus 240
printers 5456, 153—157
cleaning system components
221-223
Clean Up command (Special
menu) 12,109
Clear command (Edit menu) 53
clearing memory 227
Clear key 245, 247, 249
clicking. See also choosing;
mouse; opening;
pointer; selecting
clicking with mouse 9,
233-234
clicking with numeric keypad
130-131
double-clicking 48, 53, 234
changing speed of 129
with keypad 131
Shift-clicking 51

Clipboard 52
clock
battery, changing 223
setting 125-126
close box for windows 21-22,
31, 237
Close command (File menu)
242
CloseView 146147
Close Window command (File
menu) 22,31
closing. See also quitting
documents 45
Wastebasket 22, 35
windows 21-22, 31, 237
Color control panel 140, 142
color documents, printing 159
colors, changing
desktop pattern 136
highlight 140-141
icons 140
in color wheel 124—125, 141
in Labels control panel (Label
menu) 124125
windows 140, 142
Command key 23, 244, 246, 248.
See also keyboard
shortcuts

commands. See also menus or
specific command
choosing from menus 12
dimmed 239
help for 78-79
shortcuts for. See keyboard
shortcuts
communication. See networks
communications products,
System 7 and 208
Communications Toolbox 208
components. See also peripheral
devices or specific
component
connecting 209-217
handling 219-221
computers. See specific
computer or lopic
computer viruses 93
configuring
Macintosh for networks
172-175
multiple monitors 143—144
connecting 209-216
ADB devices 214
external floppy disk drive
214
hard disks 209-212
headphones 215
LocalTalk cables 171
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connecting (continued)
microphone 215
modem 213
monitors 216
printers 213
safety tips for 219
SCSI devices 209-212
speakers 215
to network 171-172
to shared disks 176-178
trackballs 214
connectors, handling 219
contrast control 145
Control key 244, 246, 248
Control Panels (Apple menu)
101
Brightness control panel 145
Color control panel 140, 142
File Sharing Monitor control
panel 194
General Controls 125-126,
135,137
Keyboard control panel
129-130
Labels control panel
124-125
Memory control panel
149-152
Monitors control panel
142-144
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Control Panels (continued)

Mouse control panel
128-129

Network control panel
173-174

Sharing Setup control panel
174, 183, 205

Sound control panel
132-135

Startup Disk control panel
101

Users & Groups control
panel 185-187, 191,
195, 206

Views control panel 138

controlling pointer from

keyboard 130-131

converting

documents to stationery pads
118

DOS and ProDOS disks and
files 254-256

copying

disk contents 104, 241
documents
to backup disk 58-59,
101, 243
to or from shared disks
180
with Duplicate command
64, 243
with Save As command
6667, 243
with shortcut 243

copying (continued)
graphics 139
icons 58, 235
from one disk to another
58, 234
on same disk 235
onto another disk 235
software onto hard disk
29-31, 36-37
copyright laws 185
correcting mistakes. See editing
creating
aliases 70-72, 112
documents 41
folders 69, 110
on shared disks 180182
stationery templates 72—75,
118-119
current startup disk. See startup
disk
cursor. See pointer
customizing 121-152
alert sounds 132-135
Apple menu 122-123
blinking rates 137
colors or grays 124-125,
142-143
desktop pattern 135-136
highlight colors 140-141
icon appearance 139—140

customizing (continued)
keyboard 129-132
keyboard shortcuts 131
Label menu 124-125
menu items, blinking of 137
mouse operations 128-129
screen 145-147
System Folder 122-123
system software 90, 122—123
system startup 122
window display 138
Cut command (Edit menu) 52.
See also deleting;
editing; erasing; Paste
command
cutting text 52

D

daisy chains 211-212, 214

damaged disks 104

darkened icons. See highlighted
icons

Data Access Language (DAL)
208

date, setting 125-126

default network zones 174

Delete key 41, 49, 53, 245, 247,
249



deleting. See also Clear
command; Cut
command; editing;
erasing; removing;
Wastebasket
files from System Folder 123
fonts from System Folder
123, 164
items from Apple menu 123
items from disks
(Wastebasket) 34-35
System Folders, extra 37
text 52-53
deselecting icons 235-236
designating startup disk
101-102
desktop. See also files; Finder;
folders or specific
desktop element
activating windows on 236
arranging icons on 109
changing how icons are
displayed on (View
menu) 120, 238
changing icon names on
0465
changing window display on
138
cleaning up 12
copying icons on 235
creating folders on 69, 110

desktop (continued)

description of 5, 18

disks and 241-242

displaying window contents
on (View menu) 120,
238

dragging icons on 233

failure to appear 229

folders and 19, 6869, 110,
230, 238

hiding and showing windows
on 94

icons and 18, 233-236

introduction to 7-24

key commands and 23, 241

menus and 19, 239-240

moving icons on 235

moving items to 114

moving windows on 21-22,
237

naming folders on 110

naming icons on 64—65

opening higher-level folder
windows on 238

opening icons on 13,
234-235

pattern, changing 135136

printing files from 159

printing window contents
from 160

quick reference for 233-243

desktop (continued)
rebuilding 228
removing hard disk icon from
105
removing icons from 34-35,
236
renaming icons on 100, 235
selecting icons on 233, 235
shortcuts for 241
software and 242-243
Wastebasket and 19, 3435,
234,236
windows and 14-22,
236238
developers, assistance for 259
device drivers
installing 122, 154159, 210
networking 123
printer 154-155, 157-159

removing from System Folder

123
scanner 122

device numbers. See SCSI ID
numbers

devices. See peripheral devices
or specific device

diacritical marks, typing
250-251

dialog boxes 241, 111. See also
menus

dimmed commands 239

directory dialog boxes. See also
menus
purpose of 111
shortcuts for 241
disabling
Alarm Clock 128
alert sound 133
CloseView 146
Empty Wastebasket warning
148
file sharing 193
Mouse Keys 130
Slow Keys 132
Sticky Keys 131
disconnecting
from shared disks 178
network users 194
discs. See CD-ROM discs
disk cache, adjusting 149. See
also memory
disk drive port 214
disk drives. See also floppy disks
drives; hard disks
accessing with Drive button
9
care and maintenance of 221
connecting 214
diskettes. See floppy disks
Disk First Aid program 107
disk icons 18,229
blinking question mark on
disk 229
X on disk 229
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disks 26-37, 97—108. See also

CD-ROM discs; floppy
disks; hard disks;
icons; initializing;
startup disk

backup disks 92

care and maintenance of
106, 221

copying 241

damaged 93, 104

directories of 111

Disk Tools 92,98, 107

ejecting 32,59, 105, 242

exchanging with MS-DOS and
Apple I computers
252-256

5.25-inch (MS-DOS) 252

handling 221

initializing 97—-100

in MS-DOS or ProDOS format
252-253

inserting into drive 29, 241

introduction to 26-37

locking/unlocking 102—104,
242

opening. See icons, opening

Printing disk 157

privacy and 201

protecting information on
102

quick reference for 241-242

reference for 97-108
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disks (continued)
saving files on. See saving
shared 18, 175185
startup disk, purpose of 5
switching between 99
testing and repairing
106-108
Disk Tools disk 92,98, 107
displaying
folder contents 238
fonts 166
menus 239
documents. See also files; icons;
software programs;
text
adding to folders 69
alias 70-72, 104, 112-113
backing up 104, 243
changing 48-53
closing 45, 242
copying with Duplicate
command 64
creating 41
creating templates for
118-119
empty 41
erasing with Wastebasket
34-35
getting information about
(Get Info) 74,
119-120
locked, searching for 117
locking 103, 119

documents (continued)
naming 41-42, 63
opening
atstartup 122
by double-clicking 48, 234
with Open command
13-14, 16
organizing 61-75, 109120
printing 5657, 152-168
purpose of 19
saving
aliases of 70-72
as stationery pads 73, 118
different versions of
6667
on different disk 58-59
trouble with 104
with Duplicate command
04
with Save As command
06667, 243
with Save command
41-42, 51,242
searching for 114-117
sharing over networks
182-187
stationery pad 7275,
118-119
unlocking 117
“untitled” 41

DOS. See MS-DOS
double-clicking 48, 53, 234. See
also clicking; mouse
changing speed of 129
with numeric keypad 131
double-sided floppy disks
(800K). See also disks;
floppy disks
description of 26-27
initializing 99—100
downloading fonts 165. See also
fonts
dragging
icons 10-11, 234
from Wastebasket 35
on a single disk 234
to another disk 104, 234
to desktop 114
to Wastebasket 234
to System Folder
122-123
with keypad 130-131
over text 49
size box 15
window title bar 21-22
Drive button, switching disks
with 99
drivers. See device drivers
Duplicate command (File menu)
04, 243
duplicating documents 64—67,
243, See also copying



E

Easy Install option (Installer) 89
editing
desktop pattern 135-136
text 41, 48-49, 52-53
Edit menu
Clear command 53
Cut command 52
Paste command 52
800K floppy disks. See double-
sided floppy disks;
floppy disks
Eject Disk command (Special
menu) 105
ejecting disks
shortcut for 105
with Eject Disk command
105
with Put Away command 32,
59, 105, 242
with Wastebasket 105
electrical grounding 220
electronic bulletin boards 93,
201. See also networks
empty documents 41

Empty Wastebasket command
(Special Menu) 35
disabling 148
Erase Disk command (Special
menu) 101
erasing
floppy disks
during initialization
28-29, 97,100
with Erase Disk command
101
with Wastebasket 3435,
236
text
with Clear command 53
with Clear key 245, 247,
249
with Cut command 52
with Delete key 53, 245,
247,249
error messages 227, 231. See
also troubleshooting
Escape key 245-246, 248
EtherTalk networks 172—173.
See also networks
exchanging disk and files with
MS-DOS and Apple II
computers 252-256

expanding
Macintosh system 209-218
memory 218
expansion cards 216-218
expansion slots 216-217
Extended Keyboard 11 248-249
external devices. See also
peripheral devices or
specific device
connecting 209-212
turning off 6
turning on 4
external floppy disk drives. See
also disk drives; floppy
disk drives
connecting 214
ejecting disks from 105
external hard disks. See also
disks; hard disks
connecting 209-212
ensuring recognition of 102
SCSIID number for 106
turning off 6
turning on 4, 102
eyestrain, avoiding 86

F

fatigue, avoiding 86
File menu

Close command 242

Close Window command 22,
31

Duplicate command 64

Find Again command
115-116

Find command 114-117

Get Info command 74, 95,
103, 113, 119-120

Make Alias command 70, 112

New Folder command 69,
110

New User command 186

Open command 13-14, 16,
31

Page Setup command
156-157

Print command 56-57

Print Window command 160

Put Away command 32, 35,
59, 105, 114, 178

Save As command 6667,
118

Save command 4142, 51

Sharing command 199
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files. See also directories;

documents; folders;
icons; software
programs; system
software; text

accessing on other
computers 175-180

adding

to folders 6972
to system software 90

aliases for 7072, 104,
112-113

arranging on desktop 109

backing up 58-59, 104, 243

closing 45

converting to and from MS-
DOS or ProDOS
254-256

copying 58-59, 64, 235

creating 41

damage from viruses 93

directories of 111

erasing with Wastebasket
34-35, 236

exchanging with MS-DOS and
Apple Il computers
252-256

finding 114-117

folders and. See folders
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files (continued)
getting information about
(Get Info) 74,
119-120
graphics 226
installing in Apple menu 113,
122
locked 117
locking 103, 119
moving
on desktop 235
to desktop 114
MS-DOS 252-256
naming 41-42, 63—65
networks and 169-208
opening
atstartup 122
by double-clicking 48, 234
with Open command
13-14, 16
organizing 61-75, 109-120
PostScript 168
printing 56-57, 152—168
ProDOS 252-256
protecting 102
removing
from disk 34-35, 236
from System Folder 123
renaming on desktop 64—65

files (continued)
saving. See saving documents
searching for 114-117
sharing over networks
180-197
storing in more than one
folder 7072
unlocking 117
“untitled” 41
viewing on networks 198
file servers. See also networks
aliases and 112
converting MS-DOS files on
256
definition of 175
system software and 89
viruses and 93
file sharing 175, 182—189. See
also networks
activating 183—184
disabling 193
monitoring activity of
194-195
File Sharing Monitor control
panel 194
filing system. See desktops files;
Finder; folders
Find Again command (File
menu) 115-116
shortcut for 115

Find command (File menu)
114-117
shortcut for 114
uses for 117
Finder. See also desktop
activating 43—44
icon for 43, 94
printing documents from
159
printing window contents
from 160
purpose of 43—44
shortcuts for 241
Finder command (Application
menu) 44
finding files or folders
with aliases 112—113
with Find command
114-117
5.25-inch disks (MS-DOS) 252
fixed-size fonts 162—163
floppy disk drives. See also disk
drives; floppy disks
care and maintenance of 221
connecting 214
ejecting disks from 32, 59,
105, 242
external 105,214
inserting disk into 26, 241
SuperDrive 20, 32
floppy disk icon 18, 30



floppy disks 97-108. See also
disks; floppy disk
drives; hard disks
as startup disks 88, 92
capacities of 27
care and maintenance of 34,
221
compared with hard disks 30
copying contents of 29-31,
104, 241
damaged 104
description of 27, 30
double-sided (800K) 26-27
ejecting
shortcut for 105
with Eject Disk command
105
with Put Away command
32,59, 105
with Wastebasket 105
erasing
during initialization
28-29, 100
with Erase Disk command
101
with Wastebasket 3435
5.25-inch (DOS) 252
full 104
handling 221
high-density (1.4 MB) 26-27,
33

floppy disks (continued)
initializing 28-29, 99—100
in MS-DOS or ProDOS
format 252-253
inserting into drive 26, 241
labeling 26
locking/unlocking 33,
102-104, 242
naming 100
older Macintosh computers
and 27
1.4 MB 26-27,33
quick reference for 241-242
reference for 97-108
removing from drive 242
renaming on desktop 100
saving files on. See saving
testing and repairing
106-108
types of 26-27
untitled 100
folders. See also files; icons:
software; System
Folder
access privileges and
180-181, 199201
adding files to 69, 70-72
aliases and 70-72, 112
Apple Menu Items folder
113, 122

folders (continued)
as bulletin boards 201
creating
on desktop 69, 110
on shared disks 180-182
directories of 111
dragging icons to 236
erasing with Wastebasket
34-35
finding with Find command
115-117
higher-level, opening 238
locking 104
naming 69, 110
nesting 110
networks and 180182,
199-201
opening 13, 238
organizing icons in 68—69
outline views of 238
owned 180-182, 192, 197
privacy and 201
purpose of 19, 110
searching for 114-117
shared 184-185
Startup Items folder 122
storing files in more than one
70-72
“untitled” 69
viewing contents of 238
viewing on networks 198

fonts 162-168
adding to System Folder 164
appearance of 225-226
bitmapped 162-163,
225-226
definition of 162
displaying 166
downloading 165
installing 164
outline 162—163, 165,
225-226
PostScript 165
printing 225-226
list of 166
samples of 166
removing from System Folder
123, 164
software programs and 166
transferring to LaserWriter
165-166
TrueType 163,226
forms. See stationery pads
“frowning” Macintosh icon 229
frozen system 227
full disks 104
function keys 23, 248
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G

General Controls (Apple Menu)
changing blinking of
insertion point with
137
changing desktop pattern
with 135-136
changing menu item blink
rate with 137
setting time and date with
125-126
Get Info command (File menu)
74,95, 103, 113,
119-120
aliases and 113
reference for 119-120
shortcut for 119-120
graphics
copying 139
pasting 140
graphics files 226
graphics programs 139
gray-scale printing 159
gray shades, customizing
142-143
grounded outlets 220
Group icon 188
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guest network users

access privileges for 186,
197-198

connecting to shared disks
177

denying access to 191-192

linking to programs 206207

sharing owned folders with
180

H

halftone printing 159
handling system components
219-221
“happy Macintosh” icon 5, 229
hard disk drives. See hard disks
hard disk icon 18, 30
removing from desktop 105
hard disks 97-108. See also
disks; floppy disks
as startup disks 88, 101-102
A/UX and 89-98
compared with floppy disks
30
description of 30

| hard disks (continued)

external 30
connecting 209-212
Macintosh recognition of
102
SCSIID number for 106
turning off 6
turning on 4
hard disk space as memory
150-151
initializing 98-99, 167

installing software on 29-31,

36-37,92
internal, built-in terminator
for 212
naming 99
precautions for 106
reference for 97-108
SCSIID numbers of 98-99
sharing over networks 175,
184—185
testing 108
volume names of 98
hardware developers, assistance
for 259
hardware, setting up 85-87

HD SC Setup. See Apple HD SC
Setup program
headphones, connecting 215
Help icon 78
Help menu 239
Hide Balloons command 79
Show Balloons command
78-79
Help System 7879, 239
Hide Balloons command (Help
menu) 79
Hide Others command
(Application menu) 95
high-density disks (1.4 MB). See
also floppy disks
description of 26-27
initializing 28-29, 99-100
locking/unlocking 33
highlight colors, changing
140-141
highlighted icons 9, 13, 31
highlighted text 49



L]

I-beam pointer 48
IBM-compatible disks and files.
See MS-DOS
icons 235-236. See also
desktop; disks; files;
folders
ADB port 214
adding to folders 69
Alarm Clock 127
alias 70
Apple HD SC Setup 98, 108
AppleShare 176
Application menu 40, 94
arranging on desktop 109
assigning colors to 140
Brightness 145
Calendar 126
changing appearance of
139-140
changing name of 64—65
clicking 9, 233234
CloseView 146
copying 58, 235
deselecting 235-236
device driver 210
dimmed 94
disk 18
disk drive port 214

icons (continued)
double-clicking 48, 234
dragging 10-11, 234
from Wastebasket 35
on a single disk 234
to another disk 104, 234
to desktop 114
to System Folder
122-123
to Wastebasket 234
with keypad 130-131
Finder 43, 94
floppy disk 18,30
folders and 68-69, 185, 236
getting information about
(Get Info) 74, 95, 103,
113, 119-120
Group 188
“happy Macintosh” 5, 229
hard disk 1-5, 18, 30
Help 78
highlighted 9, 13, 31
Keyboard 129
labeling 140
Labels 124
Memory 149-150
modem port 213
Monitors 142—143
naming 6465
Network 173
New Group 187
opening 13, 48, 234-235

icons (continued)
organizing 68-69
pointing to 8
pressing 9
printer 54, 154
Printer port 213
purpose of 18, 235
question mark (?) disk 5, 88,
229
quick reference for 235-236
removing 236
renaming 100, 235
“sad Macintosh” 229
SCSI 209
selecting 235-236
by clicking mouse 9,
233-234
by clicking with keypad
130-131
more than one by Shift-
clicking 234
shared folders 185
Sharing Setup 174, 183
Sound 132
sound input 134, 215
sound output 215
Stationery pad 118
types of 18
Views 138
Wastebasket 14—15, 19, 22,
34-35
X disk 229

ID numbers. See SCSI ID
numbers
images. See also icons
inverted 147
reduced 156
snapshots of 226
ImageWriter printers. See also
printers; printing
connecting 213
Page Setup dialog box for
156
Select light on 160161
initializing disks 97-100
floppy disks 2829, 99-100,
252-253
hard disks 98-99, 167
MS-DOS or ProDOS disks
252-253
INITs 122
inserting
floppy disk into drive 26, 241
text 49
insertion point. See also pointer
changing blink rate of 137
definition of 48
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Installer 88-91
Customize option 90
Easy Install option 89
Minimal software option 91
networks and 89
updating printer drivers on
networked computers
with 157-159
installing
alert sounds 133
CloseView 146
drivers 122, 154-159, 210
expansion cards 216-217
files in System Folder
122-123
fonts 164
items in Apple menu 113,
122
printer drivers
in System Folder 154-155
on networked computers
157-159
software on hard disk 29-31,
36-37,92
system software 88-91
customized system 90
small system 91
standard system 89
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interference, radio and TV xiii,
216, 220

internal floppy disk drive. See
floppy disk drives;
SuperDrive

internal hard disks. See disks;
hard disks

international keyboards 130

interrupt and reset switches 227

inverting images on screen 147

K

Keyboard control panel
129-130
keyboard files, removing from
System Folder 123
Keyboard icon 129
keyboards. See also keyboard
shortcuts; keys
adjusting
for slow typing 132
position of 8687
Apple Extended Keyboard 11
248-249
Apple Keyboard 246-247
care and maintenance of 220

keyboards (continued)
character sets and 244-251
customizing 129-130, 132
description of 244-251
international use of 130
layout, changing 130
Macintosh Classic 244-245
non-English characters and
250
special characters and 250
spills on 220
trouble with 230
keyboard shortcuts
CloseView and 147
customizing with Sticky Keys
131
ejecting floppy disks 105
Find Again command (88-G)
115
Find command (&-F) 114
Finder and directory dialog
boxes 241
Get Info command (38-1) 119
Print (38-P) 159
purpose of 51
Quit command (8-Q) 57
Save (#-S) 51, 242
Key Caps (Apple menu)
250-251
keyboard commands 23

keypad, numeric

controlling pointer with
130-131

description of 245, 247, 249

keys. See also keyboards;

keyboard shortcuts;
keypad

arrow keys 23, 241, 245, 247,
249

Caps Lock 244, 246, 248

character keys 131, 241

Clear 245, 247, 249

Command 23, 244, 246, 248

Control 244, 246, 248

Delete 40, 49, 53, 245, 247,
249

Enter 245, 247,249

Escape 245-240, 248

function keys 23, 248

layout of, changing 130

modifier keys 23, 131,
250-251

numeric keys 245, 247, 249

Option 109, 244, 246, 248

Power On 4, 245, 247, 249

repetition rate of 129

Return 245, 247, 249

Shift 23, 51, 244, 246, 248

Tab 241, 244, 246, 248



labeling. See also naming

floppy disks 26
icons 140

Label menu, changing items in

124-125

Labels icon 124
LaserWriter Font Utility 165-168

downloading fonts with
165-166

finding out about fonts with
166

initializing hard disks with
167

restarting LaserWriter with
168

transferring PostScript files
with 168

turning sample page on or off
with 167

LaserWriter printers. See also
printers; printing
background printing with
161-162
connecting 213
LaserWriter Font Utility and
167-168
LaserWriter IINT 213
Personal LaserWriter SC 55,
154,213
Print dialog box for 159
restarting 168
transferring fonts to 165-166
transferring PostScript files to
168
linking programs over networks
202-207
LocalTalk networks 171. See
also networks
locating files or folders 114-117
locked files, searching for 117
locking
files 103, 119
floppy disks 33, 242
folders 104
mouse button with keypad
131

Macintosh. See also specific

model or topic

adapting to your own use
121-152

basic skills for 1-81

care and maintenance of
219-223

connecting components to.
See connecting

expanding 209-218

naming for network use
174-175

networks and 169—208

obtaining additional
information about 257

operating environment for
223

reference for 83-259

restarting 227

setting up 85-96

starting 4-5

“talking” to 12

trouble with. See
troubleshooting

turning on and off 3-6

viruses and 93

Macintosh Classic
monitors and 216
turning on/off 4, 6
Macintosh desktop. See desktop
Macintosh LC
expansion slotin 217
sound input and 134
turning on/off 4, 6
Macintosh II
NuBus slots and 217
turning on/off 6
Macintosh Ilci
expansion slot in 217
monitors and 216
Macintosh IIfx
cable terminator for 212
monitors and 216
Macintosh IIsi, slot adapter for
217
Macintosh user groups 257
magnifying screen images
146-147
maintenance 219-223
cleaning components
221-223
floppy disks 34
keyboard 220
monitor 220
spills, dealing with 220
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Make Alias command (File
menu) 70, 112
Make Changes access privilege
198
managing memory 148-151
manual paper feed 162
memory 148—152
checking use of 148149
clearing 227
disk cache 149
expanding 218
hard disk space as 150-151
managing 148-151
memory cache expansion
slots 216-217
Memory control panel
149-152
memory expansion cards
218
networks and 149
RAM 148-151
software programs and
95-96
32-bit addressing 152
video and 143
virtual memory 149-151
Memory icon 149-150
memos. See stationery
documents
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menu bar, appearance of 5
menus 18-19, 239240

changing blinking rate of
items in 137

choosing items from 12, 240

dimmed icons in 94

displaying 239

opening 234

pop-up 111, 239-240

pull-down 239-240

purpose of 18-19

quick reference for 239-240

monitors (continued)
connecting 216
icons for 143
ID numbers for 144
interference on 216
large 216, 220
position of 86
trouble with 230-231
turning on/off 4, 6
Monitors control panel 142—144
Monitors icon 142—143
mouse

mouse (continued)

dragging objects with 10-11,
234

holding 10

pointing at objects with 8,
233

pressing objects with 9, 234

quick reference for 233—234

Shift-clicking (selecting)
objects with 51, 34,
234

techniques for 8-11,

submenus 240
titles 239
viewing options in (pressing)
9
working with 239-240
microphones 134, 215
modem port 53, 154, 213
modem port icon 213
modems, connecting 213
modifier keys 23, 131, 250-251.
See also keys
monitors. See also screen
additional 143—144, 216
care and maintenance of 220
configuring multiple
143144

button
changing double-click
speed of 129
locking and releasing with
keypad 131
cleaning 222-223
clicking (selecting) objects
with 9, 233-234
controlling with keypad
130-131
customizing operation of
128-129
double-clicking (opening)
objects with 48, 53,
234

233-234
trouble moving pointer with
230
Mouse control panel 128-129
Mouse Keys, controlling pointer
with 130-131
moving
icons (dragging) 10-11, 233
items to desktop 114
text 51-53
windows 21-22, 237
MS-DOS 252-256
converting files to and from
254-256
initializing disks for 252—253
multiple monitors, configuring
143—144



N

naming
documents 41-42, 63
floppy disks 100
folders 69, 110
groups of network users
187-188
hard disks 99
icons 235
Macintosh and owner for
network use 174-175
registered network users 186
users to link programs 207
network administrator 171, 174,
176
Network control panel (Apple
menu) 173-174
network drivers, removing from
System Folder 123
Network icon 173
networks 169-208
accessing Macintosh while
away from it 195-196
access privileges and
180-182, 197-207
AppleTalk 55-56, 155-157,
171-172, 177
capabilities of 170-171

networks (continued)

choosing printer for
155-157

configuring Macintosh for
172-175

connecting to 171-172

copyright laws and 185

disconnecting users on 194

EtherTalk 172-173

groups of users on 187-192

guest users on 177, 180, 186,
191-192, 197-198,
206208

Installer and 89

installing printer drivers on
157-159

LocalTalk 171

memory and 149

naming Macintosh and its
owner 174-175

passwords and 175, 177,
180181, 196-197

printers and 55-56

privacy and 185, 201

registered groups on 182,
197-199

registered users on 177, 180,
182, 185-186, 191,
197-199

restricting access to 191

networks (continued)
selecting network connection
173
setting up Macintosh for
171-175
shared disks and 18,
175-182
sharing files and folders on
180187
software programs and
202-207
TokenTalk 172-173
viruses and 93
zones 55-56, 173-174
default 174
selecting 56, 155,
173-174,177
New Folder command (File
menu) 69, 110
New Group icon 187
New User command (File menu)
186
non-English characters 250-251
NuBus expansion cards and slots
216-217
numeric keypad, controlling
pointer with 130-131
numeric keys 245, 247, 249

O

office, arranging 86
on/off switch 4, 6
1.4 MB floppy disks. See floppy
disks; high-density
disks
Open command (File menu)
13-14, 16, 31
opening
aliases 112
documents 48, 68
files
at startup 122
by double-clicking 48, 234
with Open command
13-14, 16, 68
folders 13, 238
icons 48, 234-235
menus 234
software programs 40, 94,
242
stationery pads 118
System Folder 16
Wastebasket 35
open software programs. See
active software
program
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operating environment for
Macintosh 223
operating systems. See also
system software
A/UX 89,98
MS-DOS 252-256
ProDOS 252-256
System 6 91, 163, 208
System 7 91, 148, 208
Option key 109, 244, 246, 248
organizing files 109-120
organizing your work 61-75
outline fonts 162—163, 165,
225-226
outline views of folders 238
owned folders 180-182, 197
transferring ownership of

182,192

l)

Page Setup (File menu)
156-157

paper. See also printing
feed, manual 162
sizes, changing 156
supply, monitoring 162
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passwords. See also networks
changing 196-197
setting 187
typing 174-175, 180
unaccepted 177
Paste command (Edit menu) 52
pasting
graphics 140
text 52
pattern of desktop, changing
135-136
peripheral devices. See also
specific device
connecting 209-217
handling 219-221
peripheral interface cable. See
SCSI peripheral
interface cable
Personal LaserWriter SC 55, 154,
213
phono jack adapters 134
pictures. See graphics
pointer
arrow 8
controlling from keyboard
130-131
controlling with mouse
8-11, 233
I-beam 48
trouble moving 230-231

pointing at objects with mouse
8,233
pop-up menus 111, 239-240.
See also menus
ports
ADB port 214
definition of 209
disk drive port 213
modem port 55, 154, 213
printer port 55, 154, 171, 213
SCSI port 209, 211
sound input port 134, 215
sound output port 215
video port 216
PostScript 165
files, transferring to
LaserWriter 168
fonts 225-226
printers 226
power
requirements
of ADB devices 214
of NuBus expansion cards
207
trouble with 228
turning on/off 4-6
Power On key 4, 245, 247, 249
power supply 221
power switch 4, 6, 228

preparing disks for use. See
initializing
pressing objects with mouse 9,
234
Print command (File menu)
56-57, 159
shortcut for 159
printed circuit boards. See cards
printer drivers. See also system
software
installing in System Folder
154-155
installing on networked
computers 157-159
printer fonts. See fonts
printer port 55, 154, 171, 213
Printer port icon 213
printers. See also printing or
specific printer
choosing 54-56, 153—156
connecting 213
drivers for 154155,
157-159
icons for 54, 154
ImageWriter 156, 159-162,
213
LaserWriter 55, 154,
167-168, 213
networks and 55-56
PostScript 226
telling computer which to
use 54-56, 153-156
trouble with 160—161



Printer Update document
(Printing disk) 157
printing 5657, 152—168. See
also printers
background 156, 160—162
canceling 161-162
color or gray-scale
documents 159
fonts 162—168, 225-226
from Finder 159
learning about 56-57
manual paper feed 162
monitoring status of 162
options for 156-157,
159-160
reduced images 156
reference for 152-168
sample pages 167
setting print time 161-162
several documents 161
while using computer for
other work 156,
160-162
window contents 160
Printing disk 157
PrintMonitor 156, 161-162
Print Window command (File
menu) 160

problems. See troubleshooting
processor-direct expansion slots
216-217
ProDOS 252-256
converting files to and from
254-256
initializing disks for 252-253
programs. See software
programs
protecting disks. See locking
pull-down menus 239-240. See
also menus
Put Away command (File menu)
disconnecting from shared
disks with 178
ejecting disk with 32, 59, 105
moving items to desktop
with 114
restoring Wastebasket items
with 35

Q

question mark (?) disk icon 5,
88

Quit command (File menu) 57,
243

quitting software programs 57,
243

R

radio interference xiii, 216, 220
RAM (random-access memory).
See also memory
checking use of 148-149
expanding 218
managing 148-151
rearranging icons on desktop
109
recording sounds 134
recovering items from
Wiastebasket 35
reduced images, printing 156
registered network groups. See
also networks
access privileges for 197-201
giving folder ownership to
182
registered network users. See
also networks
access privileges for 197-201
connecting to a shared disk
177, 180"
giving folder ownership to
182
naming 185-186
removing membership of
191-192
reinstalling system software
88-91

releasing mouse button with
keypad 131
removing. See also deleting;
erasing
alert sounds 134
disk from drive 32,59, 103,
242
files from System Folder 123
fonts from System Folder
164
icons from desktop 236
items from Apple menu 113,
122-123
System Folders, extra 37
users from a network
191-192
renaming icons 64—65, 235
repairing disks 106—108
reset and interrupt switches 227
resizing windows 43, 237
Restart command (Special
menu) 227
restarting
LaserWriter 168
Macintosh 227
restricted network access
180181, 191
Return key 245, 247, 249
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g

“sad Macintosh” icon 229
sample pages, printing 167
Save As command (File menu)
66—67, 118, 243
compared with Save
command 67
Save command (File menu)
41-42, 51,242
compared with Save As
command 67
shortcut for 51, 242
saving documents
as aliases 70—72
as stationery pads 73, 118
different versions of 6667
on different disk 58—59
trouble with 104

with Duplicate command 64

with Save As command

00—67, 243

with Save command 41-42,

51, 242
scalable fonts 162—163
scanners, drivers for 122
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screen. See also monitors

brightness control 145, 220,
228

burn in, avoiding 220

capturing “snapshot” of 226

changing colors and gray
shades on 140-143

cleaning 221

contrast control 145

damage to 145

dark 228

interference on 216, 220

inverting images on 147

magnified images on
146-147

trouble with 228, 230-231

screen saver programs 145, 220,

228

SCSI hard disk, testing 108
SCSlicon 209
SCSIID number indicator 211
SCSIID numbers
hard disks 98-99, 106
monitors 144
setting 211-212
SCSIID number switch 211
SCSI peripheral interface cable
211
SCSI port 209, 211
SCSI terminators 212
searching for files and folders
114-117
See Files access privilege 198
See Folders access privilege 198
selecting
disks or folders to share

Select light (ImageWriter
printer) 160-161
service agreement 224
setting
Alarm Clock 127-128
alert sounds 132—135
network access privileges
199-201
network passwords 187
print time 161-162
SCSI'ID numbers 211-212
time and date 125-126
setting up 85-96
for networks 171-175
hardware 85-87
system software 88-92
shared disks 18, 175—185. See
also networks

scroll arrows 16-17, 20, 237

scroll bars 1617, 20, 237

scroll box 20, 237

SCSI cables 211

SCSI chains 210-211

SCSI devices 209-212
built-in terminators for 212
chains of 210
connecting 209-212
turning on 212
types of 210

184-185
icons
by clicking mouse 9,
233-234
by clicking with keypad
130-131
by Shift-clicking 234
multiple items 51, 234
programs for linking 205
text
by double-clicking 53
by dragging and
highlighting 49-50
by Shift-clicking 51

access privileges and
180181, 199201

connecting to 176180

at startup 179—180

with aliases 179
copying files to or from 180
creating folders on 180—182
disconnecting from 178
limited access to 176
privacy and 185, 201

sharing files and folders on

180-182



shared files 182—197. See also
networks
shared folders 184-185. See
also networks
Sharing command (File menu)
199
Sharing Setup control panel
183, 205
Sharing Setup icon 174, 183
Shift-clicking
to select multiple items 234
to select text 51
Shift key 23, 51, 244, 246, 248
Show All command (Application
menu) 94
Show Balloons command (Help
menu) 78-79
Shut Down command (Special
menu)
disconnecting from shared
disks with 178
shutting down Macintosh
with 6
silent alerts 133
SIMMs (Single In-Line Memory
modules) 218
size box for windows 15, 17, 43,
237
slots. See expansion slots

Slow Keys 132
Small Computer System
Interface. See SCSI
small system software, installing
91
smiling Macintosh icon 5, 229
software developers, assistance
for 259
software programs. See also
documents; files;
menus; system
software
activating 94, 242
active 4345, 48, 68, 94, 242
aliases for 112
backing up 92
documents and. See
documents
folders and 110
fonts and 166
graphics programs 139
installing
in Apple menu 122
on hard disk 29-31, 36-37,
92
locking 103
memory usage, changing
95-96
networks and 202-207

software programs (continued)
opening 40, 94, 242
purpose of 19
quick reference for 242-243
quitting 57, 243
saving documents in. See
documents, saving
screen saver 145, 220, 228
setting up 25-37
switching 43—45, 94, 242
trouble with 231-232
types of 44
upgrading 92
virus-detection/elimination
93
working with several at once
9%
Sound control panel 132—135
Sound icon 132
sound input devices 134
sound input port 134, 215
sound output port 215
sounds
customizing 132—135
recording 134
removing from System Folder
123
speakers, connecting 215
speaker volume, changing
132-133

Special menu
Clean Up command 12, 109
Eject Disk command 105
Empty Wastebasket
command 35, 148
Erase Disk command 101
Restart command 227
Shut Down command 6, 178
special symbols 250-251
spills, dealing with 220
starting up Macintosh 4-5
startup. See startup disk; system
startup
Startup Disk control panel 101
startup disk. See also disks;
System Folder; system
software; system
startup
bypassing internal hard disk
as 102
floppy disks as 92
hard disks as 101-102
purpose of 5, 30
rebuilding desktop of 228
removing extra System Folder
from 37
search sequence for 102
setting up 88-92
System Folder and 37
virtual memory and 151
viruses and 93
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Startup Items folder 122
stationery pads 72-75, 118
creating 72-75
icon for 118
opening 118
saving 73, 118
Sticky Keys 131
straightening up files 109
submenus 240
SuperDrive 26, 32. See also
disks; floppy disk
drives
support and service 224
switches. See on/off switch; reset
and interrupt switches;
SCSIID switch
System 6 91, 163, 208
System 7 91-92, 148, 208
system cable. See SCSI system
cable
system extensions 122
System file, installing alert
sounds in 133
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System Folder. See also startup

disk; system software

adding alert sounds to 133

adding fonts to 164

Apple Menu Items folder 113

customizing 122—123

danger of using more than
one 91

dragging items to 122-123

fonts and 162168

installing device drivers in
154-155, 210

installing files in 122—123

installing printer drivers in
154155

on software program disks
92

opening 16

purpose of 30, 88

removing extra 37

removing files from 123

removing fonts from 164

setting up 88-92

Startup Items folder 122

system software. See also
software; startup disk;
System Folder
customizing 122-123
fonts and 162-168
installing, reinstalling,
updating 88-92
customized system 90
small system 91
standard system 89
networks and 89
purpose of 44
trouble with 229
virtual memory and 151
system startup. See also startup
disks
connecting to shared disks
during 179-180
customizing files for 122
floppy disks and 92
trouble with 229

T

Tab key 241, 244, 246, 248
“talking” to Macintosh 12
technical information, obtaining
258
television interference xiii
templates (stationery pads)
72-75,118-119
terminators. See cable
terminators
testing and repairing disks
106-108
text. See also documents
accent marks and special
characters 250-251
cutting 52
dragging over 49
editing 41, 48—49, 52-53
erasing
with Clear command 53
with Clear key 245, 247,
249
with Cut command 52
with Delete key 53, 245,
247,249
highlighted 49
[-beam pointer and 48



text (continued)
inserting 49
moving 51-53
pasting 52
selecting 49-51
by double-clicking 53
by dragging and
highlighting 49-50
by Shift-clicking 51
typing 41
32-bit addressing 132. See also
memory
3.5-inch disks. See floppy disks
time
setting Alarm Clock 127-128
setting system clock
125-126
tips and troubleshooting
225-232
title bar for windows 21-22
TokenTalk networks 172—173.
See also networks
tracking speed (mouse),
changing 129
transferring
fonts to LaserWriter 165-166
PostScript files to LaserWriter
168
translating MS-DOS and ProDOS
files 254-256

troubleshooting 225-232
aliases 112
Apple menu items 113
dark screen 228
desktop fails to appear 229
disks 106-108
error messages, responding
to 227
expansion cards 217
frozen system 227
monitors 228
network passwords 177
pointer does not move
230- 231
printing 160-161
saving files on floppy disk
104
software program quits
unexpectedly 232
system software 229
system startup 229
typing produces nothing on
screen 230
Tru€Type fonts 163, 226. See
also fonts
turning Alarm Clock on/off
127-128
turning AppleTalk on 172

turning CloseView on/off 146
turning external devices on/off
4,6
turning external hard disks on
102
turning file sharing off 193
turning file sharing on 183—184
turning Macintosh on/off 4-6
turning monitor on/off 4, 6
turning SCSI devices on 212
turning Slow Keys on/off 132
turning Sticky Keys on/off 131
turning 32-bit addressing on
152
turning virtual memory on 151
TV interference 216, 220
two-sided disks. See double-
sided floppy disks
typefaces. See fonts
typing. See also keyboards; keys;
text
non-English characters and
special symbols
250-251
practice for 41
slow, adjusting keyboard for
132
trouble with 230

U

unlocking
files 117
floppy disks 33, 242
untitled
disks 100
folders 69
windows 4041
updating system software 88-92
user groups for Macintosh 257.
See also registered
network user groups
Users & Groups control panel
(Apple menu)
accessing your remote
computer with 195
linked programs and
206-207
naming users with 185-188
restricting access with 191
setting passwords with 187
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v

variable-size fonts 162—163

video, built-in 143

video cards 143,216

View menu 120, 140, 238

Views control panel 138

Views icon 138

virtual memory 149—151. See
also memory

viruses 93

volume, changing 132-133

volume names of hard disks 98

W

Wastebasket 34-35

activating 14-15

closing 22, 35

deleting items with 34-33,
230

disconnecting from shared
disks with 178

dragging icons to 234

ejecting floppy disks with
105

emptying 35; warning, 148

opening 35

purpose of 19

recovering items from 335
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windows

activating 14-15, 4345, 236

border color, changing 142

closing 21-22, 31, 237

color, changing 140, 142

customizing display of 138

displaying contents of (View
menu) 120

hiding and showing 94

highlight color, changing 142

moving 21-22, 237

printing contents of 160

purpose of 18-19

quick reference for 236-238

scroll bars 237

scrolling 16-17, 20, 237

size, changing 1517, 43, 237

title bar 21-22, 237

untitled 40—41

viewing contents of 14-20

viewing in outline form 238

zoom box and 15-16, 237

work groups, viruses and 93
work space. See desktop

XY
X disk icon 229

Z
zones, AppleTalk 55-56

zoom box 15-16, 237. See also
windows















The Apple Publishing System
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